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Introduction
Before installing the UCMDB Browser, ensure that your system meets the following requirements:
l

UCMDB version. any UCMDB 9.0x or 10.0x.

l

UCMDB Browser Server. Java JDK 6 (64 bit) must be installed on the server where you install
the UCMDB Browser (the Apache Tomcat version gets its Java from the JAVA_HOME
environment variable).

The UCMDB Browser installation currently comes in three formats:
l

Web Application Package. A zip file called ucmdb-browser-install.zip that consists of the
UCMDB Browser .war file and a /conf folder with the UCMDB Browser configuration files. Use
this format if:
n

You already have an Apache Tomcat Server installed, or you want to install the Tomcat
server on your own.

n

You want to install the UCMDB Browser on the same machine that runs the UCMDB server.
Note: If you are planning to install the UCMDB Browser with a Tomcat server, it is not
recommended to do this on the same machine that runs the UCMDB Server. For details
about installing both applications on the same machine, see "Install the UCMDB
Browser on the Same Machine that Runs the UCMDB Server" on page 9.

l

Pre-configured Apache Tomcat Server package for Windows. A zip file called ucmdbbrowser-tomcat-windows.zip that consists of a pre-configured Apache Tomcat server for
Windows with the UCMDB Browser .war file. The UCMDB configuration files reside under the
/conf folder.
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l

Pre-configured Apache Tomcat Server package for Linux. An archive file called ucmdbbrowser-tomcat.tar.gz that consists of a pre-configured Apache Tomcat server for Linux with
the UCMDB Browser .war file. The UCMDB configuration files reside under the /conf folder.

Install the UCMDB Browser on an Existing Tomcat
Note: The installation directory must not contain spaces, and can use only English letters (az), digits (0-9), the hyphen sign ('-'), and the underscore sign (_).
1. Download and install Apache Tomcat version 7.0x.
2. Unzip the file ucmdb-browser-install.zip to an accessible location.
3. Go to the folder where you extracted the contents and in the ucmdb_browser_config.xml file
(located at <UCMDB_Browser_installation_folder>\conf), configure the connection to
UCMDB as follows:
n

protocol. CMDB Server protocol

n

host_name. CMDB Server name

n

host_port. CMDB Server port

n

context_name. CMDB Server context name
Note: If the root context has a default value “/” this setting can be omitted. This setting
is relevant for UCMDB 9.03 and later versions.

4. Update the context.xml file in the Tomcat conf folder to include the configuration files in the
class path. It can be found under <Tomcat installation path>\conf\context.xml.
Add under <context> tag:
<Environment name="ucmdb_browser_home" value="<folder path of the UCMDB_
Browser_installation_folder>" type="java.lang.String" override="false"/>
For example:
<Environment name="ucmdb_browser_home" value="C:\ucmdb-browser-install\"
type="java.lang.String" override="false"/>
Note: The conf folder should not be part of the path setting for value, as shown in the
example above.
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5. Place the .war file under the webapps folder of Tomcat (located at <Tomcat installation
path>\webapps).
6. Start the Tomcat server.
7. Go to http://<server name>:<tomcat port>/ucmdb-browser.

Install the UCMDB Browser on the Same Machine
that Runs the UCMDB Server
Note:
l

When installing the UCMDB Browser according to the following instructions, because the
Browser runs on the jetty of the UCMDB server, you can only use the http protocol (the
SSL and AJP protocols are not available).

l

The installation directory must not contain spaces, and can use only English letters (a-z),
digits (0-9), the hyphen sign ('-'), and the underscore sign (_).

l

The UCMDB Browser should not be installed on the same machine that runs the UCMDB
server if you want the UCMDB Browser to work with multiple UCMDB Servers (as
described in "Configure Multiple UCMDB Servers" on page 25). Rather, you should install
the UCMDB Browser on a separate machine.

For UCMDB 9.05 and earlier versions:
1. Unzip the file ucmdb-browser-install-for-ucmdb-archive.zip to an accessible location and
copy the UCMDB Browser configuration folder (the folder containing the configuration files of
the UCMDB Browser) to the UCMDB server installation root folder. For example,
C:\hp\UCMDB\UCMDBServer\ucmdb-browser.
2. Go to the folder where you copied the UCMDB Browser configuration and in the ucmdb_
browser_config.xml file, configure the connection to the UCMDB server as follows:
n

protocol. CMDB Server protocol

n

host_name. CMDB Server name

n

host_port. CMDB Server port

n

context_name. CMDB Server context name
Note: If the root context has a default value “/” this setting could be omitted. This
setting is relevant for UCMDB 9.03 and later versions.
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3. Copy ucmdb-browser.war to the UCMDB server in the folder %UCMDB-Server%deployapi/ and rename the ucmdb-browser.war to ucmdb-api-ucmdb-browser.war.
Note: If the server is running, use a cut-and-paste operation to put the new WAR file in
place, rather than copy-and-paste. Using cut-and-paste copies the file instantly and
causes the server to deploy the full application (instead of possibly deploying an
incomplete WAR file).

Note: %UCMDB-Server% is the UCMDB server root folder. For example:
C:\hp\UCMDB\UCMDBServer.
4. Add the following line to the %UCMDB-Server%\bin\wrapper.conf file:
wrapper.java.additional.201=-Ducmdb_browser_home=ucmdb-browser-conf-folder-p
ath

where ucmdb-browser-conf-folder-path is path to the UCMDB Browser configuration folder
(conf).
For example:
wrapper.java.additional.201=-Ducmdb_browser_home=
"C:\hp\UCMDB\UCMDBServer\ucmdb-browser"

Note: When specifying the path in the wrapper.conf, do not specify the /conf folder.
5. Restart the UCMDB server.
6. After restart, open the UCMDB Browser with the following URL:
http://server-name:8080/ucmdb-api/ucmdb-browser

For UCMDB 10.00 and later versions:
1. Unzip the file ucmdb-browser-install-for-ucmdb-archive.zip to an accessible location.
2. Copy the file ucmdb-browser.war to the UCMDB server in the folder %UCMDBServer%deploy/.
Note: If the server is running, use a cut-and-paste operation to put the new WAR file in
place, rather than copy-and-paste. Using cut-and-paste copies the file instantly and
causes the server to deploy the full application (instead of possibly deploying an
incomplete WAR file).
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Note: %UCMDB-Server% is the UCMDB server root folder. For example:
C:\hp\UCMDB\UCMDBServer.
3. Restart the UCMDB server.
4. After restart, open the UCMDB Browser with the following URL:
http://server-name:8080/ucmdb-browser

Install the UCMDB Browser with Preconfigured
Apache Tomcat Server on Windows
Note:
l

The installation directory must not contain spaces, and can use only English letters (a-z),
digits (0-9), the hyphen sign ('-'), and the underscore sign (_).

l

To run Tomcat as a service, Java JDK 6 for Win 64 bit should be installed (not JRE). The
Apache Tomcat version gets its Java from the JAVA_HOME environment variable.

l

The pre-configured Apache Tomcat Server has pre-defined user credentials to access the
Tomcat Manager Application. The user credentials are: admin/admin. It is strongly
recommended to change these credentials after installation to prevent unauthorized access
to the Tomcat Manager Application.
To change these credentials go to the Tomcat conf folder, and change the credentials in the
file tomcat-users.xml. For more details, see the Tomcat online documentation at:
http://tomcat.apache.org/tomcat-7.0-doc/manager-howto.html

To install the UCMDB Browser:
1. Unzip the file ucmdb-browser-tomcat-windows.zip to an accessible location.
2. Go to the folder where you extracted the contents and in the ucmdb_browser_config.xml file
(located at <UCMDB_Browser_installation_folder>\conf) configure the connection to the
UCMDB server as follows:
n

protocol. CMDB Server protocol

n

host_name. CMDB Server name

n

host_port. CMDB Server port

3. Install the Tomcat server as a service using <UCMDB_Browser_installation_
folder>/install_ucmdb_browser_service.bat.
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4. Start the Tomcat server using <UCMDB_Browser_installation_folder>/start_ucmdb_
browser_service.bat.
5. Go to http://<server name>:8088/ucmdb-browser.
Note: After restarting your computer, the Tomcat server starts automatically. To stop the
Tomcat server, run: <UCMDB_Browser_installation_folder>/stop_ucmdb_browser_
service.bat. To uninstall the Tomcat server, run: <UCMDB_Browser_installation_
folder>/uninstall_ucmdb_browser_service.bat.

Install the UCMDB Browser with Preconfigured
Apache Tomcat Server on Linux
Note:
l

The installation directory must not contain spaces, and can use only English letters (a-z),
digits (0-9), the hyphen sign ('-'), and the underscore sign (_).

l

Java JDK 6 (64 bit) must be installed on the server where you install the UCMDB Browser
(the Apache Tomcat version gets its Java from the JAVA_HOME environment variable).

l

The pre-configured Apache Tomcat Server has pre-defined user credentials to access the
Tomcat Manager Application. The user credentials are: admin/admin. It is strongly
recommended to change these credentials after installation to prevent unauthorized access
to the Tomcat Manager Application.
To change these credentials go to the Tomcat conf folder, and change the credentials in the
file tomcat-users.xml. For more details, see the Tomcat online documentation at:
http://tomcat.apache.org/tomcat-7.0-doc/manager-howto.html

To install the UCMDB Browser:
1. Extract the contents of the archive file ucmdb-browser-tomcat.tar.gz into the folder ucmdbbrowser on your home directory.
2. Go to the ucmdb_browser_config.xml file in the folder ./ucmdb-tomcat/conf and configure
the connection to UCMDB as follows:
n

protocol. CMDB Server protocol

n

host_name. CMDB Server name

n

host_port. CMDB Server port

3. Ensure that all shell scripts (./ucmdb-browser/bin/*.sh files) have ‘execute’ permission. You
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can use the command ls –l ./ucmdb-browser/bin/ to do this.
If the shell scripts do not have 'execute' permissions, add them by invoking chmod a+x
./ucmdb-browser/bin/*.sh.
4. Start the Tomcat server with the pre-installed UCMDB Browser by invoking ./ucmdbbrowser/bin/startup.sh.
Note:
l

To stop the Tomcat server, use the command ./ucmdb-browser/bin/shutdown.sh.

l

When the UCMDB Browser is embedded on the UCMDB Server and installed on Linux,
ensure that the /etc/hosts file is updated with: 127.0.0.1 localhost.

Install the UCMDB Browser on the JBoss 7
Application Server
To install the UCMDB Browser on the JBoss 7 application server:
1. Extract the contents ucmdb-browser-install.zip to an accessible location on a local drive.
Note: The installation directory must not contain spaces, and can use only English letters
(a-z), digits (0-9), the hyphen sign ('-'), and the underscore sign (_).
2. Go to the folder where you extracted the contents, and deploy the ucmdb-browser.war file on
JBoss 7.
3. Go to the folder where you extracted the contents and in the ucmdb_browser_config.xml file
(located at <UCMDB_Browser_installation_folder>/conf) configure the connection to the
UCMDB server as follows:
n

protocol. CMDB Server protocol

n

host_name. CMDB Server name

n

host_port. CMDB Server port

4. Add system-properties in the server element in $JBOSS_
HOME\standalone\configuration\standalone.xml as follows:
<server ...>
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<extensions>...</extensions>
<system-properties>
<property name="ucmdb_browser_home" value="<UCMDB_Browser_insta
llation_folder>"/>
</system-properties>
<management>...</management>
...
</server>

where "<UCMDB_Browser_installation_folder>" is the root folder to which you extracted
the contents of the installation zip file in step 1.
5. Restart the JBoss 7 application server.
6. Optional: If you receive a timeout error message after performing the previous step, add the
attribute deployment-timeout="1200" to the deployment-scanner element in $JBOSS_
HOME\standalone\configuration\standalone.xml. For example:
<deployment-scanner path="deployments" relative-to="jboss.server.base.dir" s
can-interval="5000" deployment-timeout="1200"/>

It is possible to add a timeout value of even more than 1200 if needed.
7. If you performed the previous step, restart the JBoss 7 application server.

Connect the UCMDB Browser to an RTSM Instance
The UCMDB Browser can connect to an RTSM by applying the RTSM port and an integration user.
The RTSM port is usually deployed on 21212. You should also modify the UCMDB user integration
credentials that the UCMDB Browser uses to connect. Create an integration user in the RTSM
JMX or use an existing one and modify it according to the instructions in "Change the UCMDB
Integration User Credentials" on page 19.
If the BSM is configured to authenticate users on LDAP, the RTSM should be configured with the
same LDAP settings as the BSM.
To copy BSM LDAP settings to the RTSM:
1. In BSM, go to Admin > Platform > Users and Permissions > Authentication
Management.
2. Open another tab with the RTSM JMX console (http://<server-name>:21212/jmx-console) and
find the method LDAP Settings > configureLDAP.
Note: For <server-name>, enter the RTSM server name. 21212 is the default RTSM port.
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3. Copy all LDAP settings from the BSM to the RTSM. The following table shows the
correspondence between setting names in the BSM and RTSM:
RTSM JMX Setting
BSM Setting name

Name

Description

LDAP server URL

ldapURL

LDAP connection string

Users filter

userFilter

Users filter

Distinguished Name (DN)
Resolution

isEnableSearchForDN

Distinguished Name (DN)
Resolution

Distinguished Name of SearchEntitled User

searchUser

LDAP Search User

Password of Search-Entitled User

searchUserPassword

LDAP Search User
Password

Groups base DN

groupBase

Group Base

Groups search filter

groupBaseFilter

Group Base Filter

Root groups base DN

rootGroup

Root Group

Root groups filter

rootGroupFilter

Root Group Filter

Group class object

groupClass

Group class object

Groups member attribute

groupMemberAttribute

Groups member attribute

Users object class

userClass

Users object class

UUID attribute

userUID

UUID attribute

4. From the same method RTSM JMX > LDAP Settings, invoke allowLDAPAuthentication
with the parameter “true”.
Note: Copying LDAP settings from the BSM to the RTSM does not influence RTSM
integrations since they do not work with LDAP.
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Initial Setup for Working with the UCMDB Browser
Note: These setup steps must be performed for UCMDB 10.10 and later versions.
In order to enable a user to use the UCMDB Browser, you must do the following in UCMDB:
l

Enable access to the UCMDB Browser
In the Roles Manager, assign UCMDB Browser access permission to the relevant role.
For details, see "Grant Access to the UCMDB Browser" on the next page

l

Specify which widgets will be displayed for a role in the UCMDB Browser
a. Go to Security > Roles Manager.
b. Click the Resources tab and select UCMDB Browser Widgets.
c. Select the widgets for which you want to grant View permission in the UCMDB Browser and
click

.

d. When you are finished, click Save

.

Note: The list of available UCMDB Browser widgets will be visible in UCMDB only after
launching the UCMDB Browser for the first time.
For details, see "Roles Manager Page" in the HP Universal CMDB Administration Guide.
l

Authorize access to CIs
In the Roles Manager, specify the specific access levels to CIs that you want to assign to the
role.
For details, see "Authorize Access to CIs" on page 37
Note: Browser CI access control is not supported for in multi-tenant installations. To enable
CIs to be viewed in multi-tenant installations, select the View CIs action on the General
Actions tab in the Roles Manager.
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Grant Access to the UCMDB Browser
Starting with UCMDB version 10.10, for a user to access the UCMDB Browser, you must assign
access permission to the relevant role.
1. In UCMDB, go to Security > Roles Manager.
2. Select the role to which you want to add the permission.
3. Click the General Actions tab.
4. In the System Access Actions section, select Access to UCMDB Browser in the Available
Actions list and add it to the Selected Actions list.
5. Click Save

.

Create a UCMDB Integration User
You can create a dedicated user for integrations between other products and UCMDB. This user
enables a product that uses the client SDK to be authenticated in the server SDK and execute the
APIs. Applications written with this API set must log on with integration user credentials.
Caution: It is also possible to connect with a regular UCMDB user (for instance, admin).
However, this option is not recommended. To connect with a UCMDB user, you must grant the
user API authentication permission.
To create an integration user:
1. Launch the Web browser and enter the server address, as follows:
http://localhost:8080/jmx-console
You may have to log in with a user name and password.
2. Under UCMDB, click service=UCMDB Authorization Services.
3. Locate the createUser operation. This method accepts the following parameters:
n

customerId. The customer ID.

n

username. The integration user's name.

n

userDisplayName. The integration user's display name.

n

userLoginName. The integration user's login name.

n

password. The integration user's password.
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4. Click Invoke.
5. Locate the setRolesForUser method and enter the following parameters:
n

userName. The integration user's name.

n

roles. SuperAdmin.

Click Invoke.
6. Either create more users, or close the JMX console.
Note: The integration user is per customer. To create a stronger integration user for crosscustomer usage, use a systemUser with the isSuperIntegrationUser flag set to true. The
system user should have the same user name and password as the integration user.

Change the UCMDB Integration User Credentials
The UCMDB Browser connects to the UCMDB server through the API using the UCMDB UI
integration user credentials. If you changed the UCMDB integration user credentials from the initial
default settings, perform the following steps:
1. Create a credentials.txt tile and put it in the same directory as the ucmdb_browser_
config.xml file.
2. In the file credentials.txt, enter the following content:
n

user=<user-name>

n

password=<user-password>

Where user-name is the integration user's user name and user-password is the integration
user's password.
3. Restart the Tomcat server.
Caution: For multiple UCMDB configurations (as described in "Configure Multiple
UCMDB Servers" on page 25, the same integration user should be defined on all UCMDB
servers.

Note: After restarting the Tomcat server and then logging in to the UCMDB Browser, a
new encrypted file credentials.bin is created and the file credentials.txt is removed.
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Configure the UCMDB Server URL
If UCMDB is deployed in a distributed configuration (in the case of Business Service Management
users, when the Gateway and Data Processing servers are not on the same machine), the UCMDB
server URL should be defined to allow correct access by direct links.
To configure the UCMDB server URL, add the following to the ucmdb_browser_config.xml
file:
<ucmdb_ui_url>http://[ucmdb-ui-server-name]:[ucmdb-ui-port]/ucmdb-ui/</ucmdb_ui_
url>

where [ucmdb-ui-server-name] is the UCMDB server name and [ucmdb-ui-port] is the
UCMDB-UI server port.

Configure LW-SSO
1. Configure all external applications that integrate with the UCMDB Browser with LW-SSO
settings, as described in the section about LW-SSO authentication in the HP Universal CMDB
Deployment Guide (for UCMDB 9.05 and earlier versions) or in Hardening the HP Universal
CMDB and Configuration Manager (for UCMDB 10.0 and later versions).
Note: If you access the UCMDB Browser by IP address (not by FQDN), you should add
the UCMDB Browser IP address to the UCMDB’s trusted hosts. You can do this from the
JMX console. Under LW-SSO Configuration Management, locate the addTrustedIPs
method and invoke it using the UCMDB Browser IP address value.
2. Open the ucmdb_browser_lwsso_config.xml file in the /conf folder in an XML editor and
make the following changes:
n

For the domain tag, enter the domain name of the UCMDB Browser (for example, net or
domain-name.com).

n

For the value of initString, enter the exact value of initString that is defined for the
UCMDB server and is retrieved when performing the procedure described in the section
Retrieving Current LW-SSO Configuration in Distributed Environment in the HP Universal
CMDB Deployment Guide (for UCMDB 9.05 and earlier versions) or in the HP Universal
CMDB and Configuration Manager Hardening Guide (for UCMDB 10.0 and later versions).

Note:
l In the case of an embedded UCMDB Browser, configure LW-SSO by going to
Administration > Infrastructure Settings Manager > General Settings and configure
settings that start with LW-SSO.
l

The UCMDB server name in the ucmdb_browser_config.xml file (under the <host_
name> tag) should be the full DNS name (for example ucmdb-server.com).
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l

When working with LW-SSO, the URL of the UCMDB Browser should also contain the
domain name (for example http://UCMDB-SERVER.com:8088/ucmdb-browser/).

Configure SSL
To install and configure SSL support on Tomcat:
1. Create a keystore file to store the server's private key and self-signed certificate by executing
one of the following commands:
n

For Windows: %JAVA_HOME%\bin\keytool -genkey -alias tomcat -keyalg RSA

n

For Unix: $JAVA_HOME/bin/keytool -genkey -alias tomcat -keyalg RSA

For both commands, use the password value changeit (for all other fields in the console dialog
that opens, you can use any value).
2. In the $CATALINA_BASE/conf/server.xml file (where $CATALINA_BASE is the directory
in which you installed Tomcat), do the following:
n

Remove comments from the entry SSL HTTP/1.1 Connector.

n

Set protocol="org.apache.coyote.http11.Http11Protocol" instead of
protocol="HTTP/1.1".
This command defines a Java (JSSE) connector, regardless of whether or not the APR
library is loaded.
Note: For a full description on how to configure server.xml to use SSL, see the Apache
Tomcat official site: http://tomcat.apache.org/tomcat-7.0-doc/ssl-howto.html

3. Restart the Tomcat server.
To use the HTTPS protocol for connection to the UCMDB server:
1. In the ucmdb_browser_config.xml file, assign the value https to the tag<protocol> and
assign the UCMDB server HTTPS port value (8443 by default) to the tag <port>.
2. Download the UCMDB server public certificate to the UCMDB Browser machine (if you use
SSL on the UCMDB server, the UCMDB administrator can provide you with this certificate),
and import it into the cacerts trust store on the JRE that is going to connect to the server by
executing the following command:
"%JAVA_HOME%\bin\keytool" -import -alias ucmdb -trustcacerts -file <UCMDBServer-certificate-file> -keystore "%JAVA_HOME%\jre\lib\security\cacerts"
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where <UCMDB-Server-certificate-file> is the full path to the UCMDB server public
certificate file.
3. Restart the Tomcat server.

Configure High Availability Mode
The typical configuration for a high availability environment has two or more UCMDB Browsers that
connect to the same UCMDB server, or to the same load balancer that manages a cluster of
UCMDB servers. The UCMDB Browsers are configured to work behind a load balancer, meaning
that the load balancer serves as the entry point to the UCMDB Browsers. All the UCMDB Browsers
are active at any given time and can handle requests from users. Requests are distributed to the
UCMDB Browsers in the cluster by the load balancer, and are shared evenly among all the UCMDB
Browsers.
Note:
l

The load balancer used for high availability must have the ability to insert cookies and must
be able to perform health checks ("keepalive").

l

These instructions are certified for the F5 BIG-IP version 10.x and F5 BIG-IP version 11.x
load balancers.
If you are using a different load balancer, the configuration should be performed by a
network administrator who has broad knowledge about how to configure load balancers, and
principles similar to those described here should be applied.

l

This procedure assumes that you already have at least one UCMDB Browser installed and
configured.

To set up a high availability environment:
1. Create a cluster of UCMDB Browsers.
Install one or more additional UCMDB Browsers to create a cluster. For information about
installing the UCMDB Browser, see "Installation" on page 7.
Note:
n

The machines used for all of the UCMDB Browsers in the cluster should have similar
hardware, including the same amount of memory, and should be running the same
operating system.

n

UCMDB Browsers in the cluster must use the same port number for HTTP, HTTPS,
and so on. You cannot configure multiple UCMDB Browsers for high availability if they
are using different ports.
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2. Start the UCMDB Browsers.
a. If the first UCMDB Browser is not started, start the process and wait for the startup
process to complete.
b. Start the additional UCMDB Browsers.
3. Configure the load balancer.
The load balancer is used to balance the load that is sent to the UCMDB Browsers in the
cluster. Configure the load balancer as follows:
a. On the load balancer, configure a Cluster VIP address that sends requests to the entire
UCMDB Browser cluster.
b. Configure a pool of back-end servers that represents all UCMDB Browsers in the cluster.
This pool is monitored by a health monitor, which is sent requests that can be processed by
any UCMDB Browser in the cluster.
c. Configure the health monitor by providing a keepalive address. The health monitor checks
for the keepalive page of each of the UCMDB Browsers. For the Cluster VIP address, use
the following URL for the keepalive address: /ucmdb-browser/public/ping.jsp.
Possible responses from this URL are:
Response HTTP Response Code
Up

200 OK (desired response)

Down

503 Service unavailable

d. Connect the health monitor to the UCMDB Browser pool configured in step b.
e. Configure session affinity on the load balancer:
o

Configure the load balancer to insert cookies to the responses that are sent back to
UCMDB Browser clients (internet browsers).

o

Using the Insert method, add a persistence profile cookie for the VIP address.
Note:
o

The cookie name and value are unimportant, as long as the load balancer knows
how to maintain stickiness with the cookies that it sends out.

o

F5 BIG-IP version 10.x adds a session cookie only to the first response per
connection to the server. Other load balancers you might use add a session cookie
to each response.
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f. If the VIP is configured to accept secure connections and the load balancer forwards the
requests to the UCMDB Browsers over HTTP, you must configure redirect rewrites. In the
load balancer software, enable the Redirect Rewrite select All option to configure the
HTTP profile associated with the Cluster VIP.

Configure CAC Support
This section describes how to configure Common Access Card (CAC) support on the UCMDB
Browser.
1. Make sure that you have access to the keystore, truststore, and crl files. If necessary, you can
create them using the following examples:
n

Import the server certificate into the keystore:
$ keytool -importkeystore -deststorepass changeit -destkeypass changeit
-destkeystore keystore.jks -srckeystore ../../certtest/localhost.p12 -src
storetype PKCS12 -alias sercer
Enter source keystore password:

n

Import the certificate authority (CA) certificate into the truststore:
$ keytool -import -keystore cacerts.jks -storepass changeit -alias my_ca file ../../certtest/ca.crt
Owner: EMAILADDRESS=ca@naive.sk, CN=CA Admin, OU=CA, O=Naive, L=Bratislav
a, ST=Bratislava, C=SK
...too long...
Trust this certificate? [no]:

yes

Certificate was added to keystore

2. Load the client certificate into your Web browser.
3. Open the server.xml file, located in <UCMDB_Browser_installation_
directory>\webapps\release\conf. Add the following lines, if they do not exist:
n

<Connector protocol="HTTP/1.1" port="8553" maxThreads="200"
This line specifies the port number. You can use any value, as long as it does not conflict
with an existing port. The default value is 8443.

n

SSLEnabled="true" scheme="https" secure="true" sslProtocol="TLS"
This line configures SSL for the Tomcat server.

n

truststoreFile="C:\Program Files\Apache Software Foundation\Tomcat
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7.0\certificates\server.truststore" truststorePass="hppass"
This line provides the path to the truststore file and the password of the truststore file.
n

keystoreFile="C:\Program Files\Apache Software Foundation\Tomcat
7.0\certificates\server.keystore" keystorePass="hppass"
This line provides the path to the keystore file and the password of the keystore file.

n

crlFile="C:\Program Files\Apache Software Foundation\Tomcat
7.0\certificates\server.crl"
This line provides the path to the certificate revocation list file.

n

clientAuth="true" />
This line specifies that login is permitted only when the client has a valid client certificate.

4. Disable access to other connectors ( to ensure that no user can connect to the Tomcat server
with unsecured HTTP access) by commenting out or deleting other connector tags that are
referenced in the file.
5. Save the server.xml file and restart the Tomcat server.

Configure Multiple UCMDB Servers
It is possible to configure the UCMDB Browser to work with multiple UCMDB Servers. This is done
by replicating the section <ucmdb_configuration>…</ucmdb_configuration> in the ucmdb_
browser_config.xml file, as shown in the following example:
<ucmdb_configuration name="configuration-1">
<protocol>http</protocol>
<host_name>ucmdb-server-1</host_name>
<host_port>8080</host_port>
<context_name>/</context_name>
<customer>
<customer_name>company_a</customer_name>
<customer_number>1</customer_number>
</customer>
</ucmdb_configuration>
<ucmdb_configuration name="configuration-2">
<protocol>http</protocol>
<host_name>ucmdb-server-2</host_name>
<host_port>8080</host_port>
<context_name>/</context_name>
<customer>
<customer_name>company_b</customer_name>
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<customer_number>6</customer_number>
</customer>
</ucmdb_configuration>

There is no limit to the number of UCMDB Servers that you can add in this manner.
Note:
l

The value of the name attribute in each configuration (for example, configuration-1 or
configuration-2 in the example above) is optional, but if it is defined it must be a unique
value.

l

You can specify a default customer by name, ID, or both. If you include the
<customer>...</customer> tag, you must provide details for it. On the login page of the
UCMDB Browser, only the customer that you defined as the default customer for a
particular UCMDB server will be visible in the drop-down list.

l

Configuring multiple UCMDB servers is not relevant to the embedded UCMDB Browser
since the embedded UCMDB Browser can connect to only one server. For more
information, see "Multiple Customer Support for the Embedded UCMDB Browser" on the
next page.

For each configuration section, the customers for that UCMDB server are retrieved automatically at
the moment that the application server starts, and a connection for each customer is formed using
the value from the name attribute in the ucmdb_configuration tag (if the name attribute is not
defined, the value from the host_name tag is used) and the name of the customer. All these
connections appear in the drop-down list in the login screen. For example, in the case of the xml
example above, if configuration-1 has two customers and configuration-2 has three customers,
then the drop-down list will contain five connections, in the form of:
l

configuration-1 – CustomerName1

l

configuration-1 – CustomerName2

l

configuration-2 – CustomerName1

l

configuration-2 – CustomerName2

l

configuration-2 – CustomerName3

If the UCMDB server defined in configuration-2 is inaccessible, then the connection for it is still
visible in the drop-down list (without any customer information), even if the user cannot login using
that server. In that case, the list will contain the connections:
l

configuration-1 – CustomerName1

l

configuration-1 – CustomerName2
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l

configuration-2

If only one server is available, then the server name does not appear in the connection name.
Caution: If you have launched the UCMDB Browser with a given UCMDB server, you cannot
open another instance of the UCMDB Browser with a different UCMDB server with the same
web browser. You can, however, open another instance of the UCMDB Browser with a
different UCMDB Server if you use a different web browser. For example, if you opened the
UCMDB Browser with Internet Explorer with a given UCMDB server, you can open the
UCMDB Browser using Google Chrome with another UCMDB server.

Note: The same LW SSO settings from the ucmdb_browser_lwsso_config.xml file are used
for all UCMDB configurations.

Retrieving Customer States
You can specify whether to retrieve the state(s) for each customer so that the state appears next to
the customer name in the login drop-down list. Currently, the possible states are Actual and
Authorized. The default value for this setting is false, meaning that the customer state does not
appear in the login drop-down list. If you change it to true, the state(s) for each customer is also
retrieved, in addition to the customer name. So if the server host has two customers, Customer-1
with an Actual state and an Authorized state, and Customer-2 with an Actual state, then the
connections will be host – Customer-1 (Actual), host – Customer-1 (Authorized), and host –
Customer 2 (Actual).
This setting also applies to the embedded UCMDB Browser, as described below.
To specify whether to retrieve the state for each customer:
For UCMDB server 9.04 CUP 5 and earlier versions: Use the <customers_states> tag in the
ucmdb_browser_config.xml configuration file. Set the value to true or false (the default value is
false). For example:
<customers_states>true</customers_states>

For UCMDB server 9.04 CUP 6 and later versions: In UCMDB, go to Administration >
Infrastructure Settings > UCMDB Browser Settings, and set the value for Enable customer
states.

Multiple Customer Support for the Embedded UCMDB Browser
The embedded UCMDB Browser can connect to only one UCMDB server and so configuration for
multiple UCMDB servers is not relevant. The information regarding the server is automatically sent
by the UCMDB server into which the Browser is embedded. Similar to the case of login for the nonembedded Browser, the embedded UCMDB Browser searches for all the customers for that server,
and for each customer it creates a different connection. For example, if the host server has two
customers, customer1 and customer2, then the connection names customer1 and customer2
appear in the drop-down list on the login page.
Also, if the setting to receive customer states has been set to true (as described above), then the
customer state appears next to the customer name in login drop-down for the embedded Browser.
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Change the Default Port of the Tomcat Server
The default port value (8080) of the Tomcat Server may conflict with an existing application (for
example, another web application already uses this port). If such a conflict exists, change the
default port as follows:
1. Locate the file server.xml in $CATALINA_BASE/conf/ where $CATALINA_BASE is the
directory in which you installed Tomcat.
2. In server.xml, find a statement similar to the following:
<Connector port="8080" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443" acceptCount="100"
connectionTimeout="20000" disableUploadTimeout="true" />

or
<Connector port="8080" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8443" />

3. Change the Connector port=”8080″ port to any other port number.
For example:
<Connector port="8181" protocol="HTTP/1.1"
connectionTimeout="20000"
redirectPort="8443" />

4. Save the server.xml file and restart the Tomcat server.

Deploy the UCMDB Browser with a Different Root
Context
You can change the default root context name /ucmdb-browser. To do this, rename ucmdbbrowser.war under <Tomcat installation path>\webapps.
For example, if you want to change the context name to /nice-application, rename ucmdbbrowser.war to nice-application.war.
You can also create a multilevel context name. For example, if you want to change the context
name to /very/very/nice-application, rename ucmdb-browser.war to very#very#niceapplication.war.

HP Universal CMDB Browser (3.1)

Page 28 of 147

Installation and Configuration Guide
Chapter 2: Configuration and Administration

Upgrade the UCMDB Browser
If you have a version of the UCMDB Browser that is older than the current version, you can upgrade
to the latest version as follows:
1. For UCMDB 9.05 and earlier versions: Download the file ucmdb-browser-install.zip from
HP Live Network (labeled UCMDB Browser without Tomcat on HP Live Network).
For UCMDB 10.0 and later versions: Download the file ucmdb-browser-install-forucmdb.zip from HP Live Network (labeled UCMDB Browser for UCMDB installation on
HP Live Network).
2. Stop the web application (Tomcat or UCMDB Server).
3. Delete the old ucmdb-browser.war file as follows:
n

n

If the Browser is installed on the same machine that runs the UCMDB server:
o

For UCMDB 9.05 and earlier versions: Delete the file ucmdb-api-ucmdbbrowser.war from the folder %UCMDB-Server%deploy-api/, where %UCMDBServer% is the UCMDB server root folder.

o

For UCMDB 10.0 and later versions: Delete the file ucmdb-browser.war from the
folder %UCMDB-Server%deploy/, where %UCMDB-Server% is the UCMDB server
root folder.

For all other installations: Delete ucmdb_browser.war from <Tomcat installation
path>\webapps. Also, in <Tomcat installation path>\webapps delete the ucmdb_
browser folder.

4. Copy the new ucmdb-browser.war file to the appropriate locations as follows:
n

n

If Browser is installed on the same machine that runs the UCMDB server:
o

For UCMDB 9.05 and earlier versions: Change the file name to ucmdb-api-ucmdbbrowser.war and copy it to %UCMDB-Server%deploy-api/.

o

For UCMDB 10.0 and later versions: Copy the file ucmdb-browser.war to
%UCMDB-Server%deploy/.

o

For all versions: Clear the ucmdb-browser.war folder from
C:\hp\UCMDB\UCMDBServer\runtime\jetty-cache before starting the UCMDB
server.

For all other installations: Copy ucmdb_browser.war to <Tomcat installation
path>\webapps.
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Note: If the server is running, use a cut-and-paste operation to put the new WAR file in
place, rather than copy-and-paste. Using cut-and-paste copies the file instantly and
causes the server to deploy the full application (instead of possibly deploying an
incomplete WAR file).
%UCMDB-Server% is the UCMDB server root folder. For example:
C:\hp\UCMDB\UCMDBServer.
5. Copy the necessary update resources, depending on the type of installation you have, as
follows:
n

If you have your own Tomcat installation (meaning, you installed the UCMDB Browser
according to the instructions in "Install the UCMDB Browser on an Existing Tomcat" on
page 8), copy the setenv.bat file to the bin folder.

n

If you installed the UCMDB Browser according to the instructions in "Install the UCMDB
Browser with Preconfigured Apache Tomcat Server on Linux" on page 12, copy the
setenv.sh file to the bin folder.

n

If you installed the UCMDB Browser according to the instructions in "Install the UCMDB
Browser with Preconfigured Apache Tomcat Server on Windows" on page 11, copy the
update_ucmdb_browser_service.bat file to the root folder of your installation (the same
place where the install_ucmdb_browser_service.bat is located) and run it.

6. Read the release notes for the latest version to determine which features and functionality you
want to use and update your Browser settings accordingly.
7. Start the Tomcat server or UCMDB server (depending on your installation).
All features and functionality from the previous installation are active in the new installation, as well
as the new features and functionality for the latest version.

Upgrade the UCMDB Browser Embedded in
Configuration Manager
You can independently upgrade to the latest version of the UCMDB Browser embedded in
Configuration Manager as follows:
1. Navigate to the following folder:
<Configuration Manager installation folder>/servers/server-0/webapps
2. Delete the ucmdb-browser.war file.
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3. Verify that the ucmdb-browser folder has been deleted as well. If the folder still appears after
approximately 30 seconds, stop the Configuration Manager service and delete the folder
manually.
4. Copy the new ucmdb-browser.war file into the folder:
<Configuration Manager installation folder>/servers/server-0/webapps
Note: If the server is running, use a cut-and-paste operation to put the new WAR file in
place, rather than copy-and-paste. Using cut-and-paste copies the file instantly and
causes the server to deploy the full application (instead of possibly deploying an
incomplete WAR file).
5. If you stopped the Configuration Manager service and deleted the ucmdb-browser folder
manually (as described in step 3), restart the Configuration Manager service.
6. Verify that the ucmdb-browser folder has been recreated.

Configure Reverse Proxy for the Apache Tomcat
and IIS Servers
The client can configure reverse proxy on the UCMDB Browser for either the Apache Tomcat or IIS
servers.

Configure Reverse Proxy for the Apache Tomcat Server
1. Configure reverse proxy to append header X-Reverse-Proxy with the reverse proxy URL for
Apache-server. To do this, open file %apache-home-directory%\conf\httpd.conf (where
%apache-home-directory% is the Apache server home directory), and add the following lines:
n

LoadModule headers_module modules/mod_headers.so

n

RequestHeader set X-Reverse-Proxy http://srp-server-front-end-url

Where http://srp-server-front-end-url is the entire reverse proxy’s frontend URL.
2. Restart the Apache Tomcat server.

Configure Reverse Proxy for the IIS Server
1. Configure ISAPI redirection to work with IIS. For details, see the section Set Up IIS to Enable
Access to UCMDB – Windows 2008 in the HP UCMDB Deployment Guide.
Note: At the step when you add a new virtual directory to the IIS web site, point the virtual
directory to the path c:/ucmdb_iis/ and not the path indicated in the Deployment Guide.
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2. Update the file uriworkermap.properties with /ucmdb-browser*=localAjp redirection.
3. Restart the IIS web server.

Configure an Environment to Use Multiple Reverse
Proxies
When clients are connected to the same UCMDB Browser instance through multiple reverse
proxies, the UCMDB Browser needs to know each client’s frontend URL to build correct direct links
to the HP Enterprise Collaboration, HP Configuration Manager, and HP Service Manager servers.
For example, a client who accesses the UCMDB Browser by reverse proxy https://reverse-proxy1 should get a direct link by the same https://reverse-proxy-1.
Therefore, a configuration based on relative URLs instead of full URLs should be implemented.
When the UCMDB-Browser receives a request with a header X-Reverse Proxy, it relates to
application URLs as relative URLs and concatenates part of the header with a relative URL. To use
this solution the customer should:
1. Configure each reverse proxy in the environment to append header X-Reverse-Proxy with the
Reverse Proxy’s frontend URL.
2. Use a relative URL for all servers behind the reverse proxy in the UCMDB-Browser
configuration.
To perform the actual configuration:
1. Configure reverse proxy to append header X-Reverse-Proxy with the reverse proxy URL for
Apache-server. To do this, open file %apache-home-directory%\conf\httpd.conf (where
%apache-home-directory% is the Apache server home directory), and add the following lines:
n

LoadModule headers_module modules/mod_headers.so

n

RequestHeader set X-Reverse-Proxy http://srp-server-front-end-url

Where http://srp-server-front-end-url is the entire reverse proxy’s frontend URL.
2. The UCMDB Browser configuration file should use relative URLs instead of full URLs. For
example, instead of http://cm-server/cnc, use /cnc. Specifically, it is very important that the
value of tag <ucmdb_ui_url> is defined and uses a relative path.
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Configure a One-Time Authentication Token
The one-time authentication token is an additional means for the user to access to UCMDB
Browser by a direct link (URL with parameters). With such a URL, the user does not need input
credentials. The advantage of this method is that:
l

The URL does not contain user credentials.

l

The URL is for one time use only (after initial use, the URL cannot be used again).
Note: You must have administrator rights in order to generate an authentication token for
another user.

To configure and use the one-time authentication token:
1. Create a URL for obtaining the one time authentication token as follows:
http://<server-name>:<port>/ucmdb-browser/generate-authenticationtoken.jsp?username=<your_user_name>&password=<your-password>&server=<ucmdbserver>&logged-in-user=<logged_in_user_name>
where the parameters server and logged-in-user are optional.
The following is an example of a URL for obtaining one time authentication token:
http://server-name:8088/ucmdb-browser/generate-authenticationtoken.jsp?username=johndoe&password=12345678&server=ucmdb-server
Note:
n

Parameter names are case sensitive and should be used exactly as they appear in this
documentation.

n

When an optional parameter (such as server) is omitted, the first server from the
configuration is used.

n

The server name in the [server] parameter should be taken from one of the <host_
name> fields in UCMDB Browser configuration file. If the [server] parameter is defined
but it’s value does not correspond to any of the values of the <host_name> field in
UCMDB Browser configuration file, the authentication token will be not generated.

2. Execute the URL prepared in the previous step. After successful execution, the
Authentication-Token field in the response http-header contains the authentication token
value created for the parameters you entered in the previous step. The http field is used here for
a return value to enlarge security strength.
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Note:
n

The response http-header fields can be viewed by using any external request
interceptor (such as Fiddler) or tools embedded into a web browser (for example, in
Chrome: Developer Tools > Network tab).

n

If the credentials provided in the previous step are not valid, the authentication-token
field is empty or not present at all.

3. Build the URL for the UCMDB Browser by using the parameter authentication-token and the
token value obtained in the previous step. For example:
http://server-name:8088/ucmdb-browser/?authentication-token=<token-value>
where token-value is the authentication token string obtained in the previous step.
After executing the URL, you are redirected to the UCMDB Browser without having to enter
user credentials.
Note: After restarting the server of the UCMDB Browser, all prepared authentication
tokens are no longer valid.

Configure Browser Internal Priorities (for the
Incidents and Problems Widgets)
For UCMDB 9.04 CUP 5 and earlier versions: For both the Incidents and Problems widgets,
configuration of the UCMDB Browser Internal Priorities is performed in the ucmdb_browser_
config.xml configuration file. The default configuration for both widgets is as follows:
<incident_widget_configuration>
<incident_direct_link_url>http://<service manager machine>:8080/webtier9.30/index.do?ctx=
docEngine&amp;file=probsummary&amp;query=number%3D%22
{$INCIDENT_ID}%22</incident_direct_link_url>
<open_incident_status_list>open</open_incident_status_list>
<urgent_incident_priority_list>1_critical</urgent_incident_priority_list>
<major_incident_priority_list>2_high</major_incident_priority_list>
<minor_incident_priority_list>3_average</minor_incident_priority_list>
<none_incident_priority_list>4_low</none_incident_priority_list>
</incident_widget_configuration>

You can change the priority names according to your system needs.
For UCMDB 9.04 CUP 6 and later versions: For both the Incidents and Problems widgets,
configuration of the UCMDB Browser Internal Priorities is performed in UCMDB.
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1. Go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.
2. In the Names column, find the following settings:
n

List of statuses for an major priority incident or problem

n

List of statuses for an minor priority incident or problem

n

List of statuses for an none priority incident or problem

n

List of statuses for an open incident or problem

n

List of statuses for an urgent priority incident or problem

3. In the Value column, change the priority name for any of the settings above according to your
system needs.

Disable Compatibility View for Internet Explorer 8
If you want to use the UCMDB Browser with Internet Explorer 8 (IE8), and you are not using the
Chrome Frame plug-in (as recommended by HP), you must disable compatibility view as follows:
1. In IE8, go to Tools > Compatibility View Settings.
2. In the Compatibility View Settings dialog box, uncheck the following options:
n

Display intranet sites in Compatibility View

n

Display all websites in Compatibility View

3. Click Close.

Configuration Mechanism (UCMDB 9.04 CUP 6 and
later versions)
If you are using the UCMDB Browser with UCMDB Server 9.04 CUP 6 or later version, the
UCMDB Browser configuration settings are not kept in the ucmdb_browser_config.xml file
(which is the case for UCMDB Server 9.04 CUP 5 and earlier versions) and are kept on the
UCMDB Server to which the UCMDB Browser is connected. The Browser configuration settings
on the UCMDB Server are accessible from in UCMDB (in Administration > Infrastructure
Settings > UCMDB Browser Settings). The settings appear only after initial login, which triggers
a settings deployment on the UCMDB Server.
For each group of configuration settings, there is a setting called: Enable XXX, where XXX is the
name of a Browser feature (for example, Enable Enterprise Collaboration Integration, Enable
Incidents Widget, and so on). This setting can be used to enable/disable the group of settings. For
example, if Enable Enterprise Collaboration Integration is set to false, the Enterprise
Collaboration feature is not available in the UCMDB Browser.
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Note:
l

For UCMDB Server 9.04 CUP 5 and earlier versions, configuration settings remain on the
UCMDB Browser ucmdb_browser_config.xml configuration file.

l

When upgrading to UCMDB 10.0x, the UCMDB Browser settings are not upgraded. The
UCMDB administrator should set them manually in Infrastructure Settings Manager in
UCMDB.

Specify the Number of Concurrent Sessions
By default, a user can open an unlimited number of sessions. You can specify the maximum
number of sessions that a user may log into concurrently.
Note: This setting cannot be used for:
l

UCMDB Browsers in a high availability environment.

l

a standalone UCMDB Browser that is connected to multiple UCMDB servers.

l

a standalone UCMDB Browser that is connected to a UCMDB server with multiple
customers.

l

the embedded UCMDB Browser of a UCMDB that is configured with CAC.

1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. In the Name column, choose Maximum sessions per user.
3. In the Value column, enter a number.
4. Click Save

.

5. Log out from the UCMDB Browser, and then log in again (this loads the new settings).

Enable/Disable Timeout of a Browser Session
It is possible to set a timeout for a Browser session if the UCMDB Browser is not used for a certain
period of time. If the timeout is enabled and a user does not perform any actions in the UCMDB
Browser for the set timeout period, then when the user tries to perform an action in the Browser a
message appears for 2 seconds stating that the session has expired and the user is redirected to
the Browser login page.
Note: The default wait period for the timeout is 30 minutes. This value can be changed in the
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Java web.xml file, located at:
%WEB_SERVER_HOME%\webapps\ucmdb-browser\WEB-INF\web.xml
By default this timeout is disabled, but you can change this setting according to the following
instructions.

Enable/Disable Timeout for UCMDB 9.04 CUP 6 and later versions
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. In the Name column, choose Enable the Session Timeout.
3. In the Value column, choose True or False (depending on whether you want to enable or
disable the timeout) from the drop-down list .
4. Click Save

.

5. Log out from the UCMDB Browser, and then log in again (this loads the new setting).

Enable/Disable Timeout for UCMDB 9.04 CUP 5 and earlier versions
For UCMDB 9.04 CUP 5 and earlier versions, set the <session_timeout_enabled> tag in the
ucmdb_browser_config.xml file as follows:
<session_timeout_enabled>true</session_timeout_enabled>

or
<session_timeout_enabled>false</session_timeout_enabled>

After saving and closing ucmdb_browser_config.xml, restart the web server on which the
UCMDB Browser is deployed.

Authorize Access to CIs
Browser CI Access Control enables you to assign granular access to the CIs in views or CI types
in UCMDB, according to a user's assigned role. A role that has global View or Edit permission can
see all CIs and relationships in UCMDB. A role that has View or Edit permission for a particular
view can see only the CIs and relationships in that view. In addition, permission can be granted to
view or edit particular CI types.
Note: You must have View permission on a particular CI in order to refocus on it, even if that
CI is visible in a widget because of Browser CI Access Control settings.
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To assign access to CIs:
1. In UCMDB, go to Security > Roles Manager.
2. Select the role to which you want to assign access.
3. Click the Browser CI Access Control tab and add available actions as required.
4. Select an available view or CI type for which you want to assign permissions.
5. When you are finished, click Save

.

For additional details about permissions, see "User Permissions for the UCMDB Browser" in the
HP Universal CMDB Administration Guide.
Note:
l

If a CI does not have Edit permission assigned through a view or CI type, the Edit button
will not be displayed in the Properties widget and it will not be possible to change any
property's attributes in the UCMDB Browser.

l

A user will be able to see the composite CIs of permitted CIs, even he has not been granted
specific permission for those composite CIs.

l

If a user has permissions on CIs of two CI types and those CIs are not composite CIs, in
order to have permission on their relationship (for example, to view them in the Environment
widget), the necessary triplet should be added to the calculated link. This is named
Authorized Relationship Addition (UCMDB Browser), and it can be found in CI Type
Manager > Calculated Relationships.

Use Cases
Enable a user to view or edit all CIs
l

Read only: Assign the global permission View All to all CIs for a role.

l

Read/Write: Assign the global permission Edit All to all CIs for a role.

Enable a user to view or edit only specific CIs
l

Read only:
n

Assign View permission to specific views.

n

Assign View All CIs permission to a particular CI type.
Note: By default, in the UCMDB Browser, the Party and Location CI types are
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automatically assigned View All CIs permission.

l

Read/Write:
Do one of the following:
n

To edit all CIs that you can view, assign Edit All CIs permission on all views.

n

To edit CIs in a specific view, assign Edit All CIs permission on only that view.

n

To edit only specific CI types in relevant views, assign Edit By CIT permission to the views
and Edit In View permission to a particular CI type.
Note: You can assign permissions to a group of views by selecting a node in the list of
Available Views, or apply the permissions to all views by selecting the Root node.

n

To edit all CIs of a specific CI type, assign Edit All CIs permission to that CI type.

Enable a user to view all CIs and edit only specific CIs
l

Assign the global permission View All to all CIs for a role.

Do one of the following:
l

To edit all CIs of a specific CI type, assign Edit All CIs permission to that CI type.

l

To edit only specific CIs:
n

To edit all CIs that you can view, assign Edit All CIs permission on all views.

n

To edit CIs in a specific view, assign Edit All CIs permission on only that view.

n

To edit only specific CI types in relevant views, assign Edit By CIT permission to the views
and Edit In View permission to a particular CI type.
Note: You can assign permissions to a group of views by selecting a node in the list of
Available Views, or apply the permissions to all views by selecting the Root node.

n

To edit all CIs of a specific CI type, assign Edit All CIs permission to that CI type.

Brand the UCMDB Browser
The majority of UCMDB Browser installations are delivered with Hewlett-Packard branding.
However, you have the ability to apply a header and footer, add custom text and an icon in the
header of the UCMDB Browser, and replace the image that appears on the landing page.
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In all UCMDB Browser installations, the <UCMDB_Browser_installation_directory>
\webapps\ucmdb-browser\public\branding folder contains sample icon, image, and stylesheet
files. You can replace or update these files as desired, and specify their location in the settings in
UCMDB, as described below.
Recommended image sizes are:
l

for icons - 20 x 20 pixels

l

for the landing page image - 135 x 135 pixels

Example of the CSS stylesheet:
.bannerClass {
background-color: yellow;
color: blue;
font-weight: bold;
font-style:italic;
}

To brand the UCMDB Browser:
1. In UCMDB, go to Administration > Infrastructure Settings Manager, and choose UCMDB
Browser settings.
2. Update the following settings as required:
Name

Value

Banner stylesheet URL

The URL of the stylesheet used for the banner text.

Banner text

The text that will appear in the header and footer.

Custom masthead text

Customized text that will appear in the masthead of the
UCMDB Browser.

Custom icon for masthead

The URL of the icon that will appear in the masthead of the
UCMDB Browser.

Custom image for landing
page

The URL of the image that will appear on the landing page of
the UCMDB Browser.
Note: For the best visual effect, use a graphic with a
transparent background.

Custom product name
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Note: If you specify customized text and an icon for the masthead, they will appear in
addition to the current Hewlett-Packard text and image, and not as replacements.

3. Click Save

.

Log User Statistics
The UCMDB Browser logs the user's functional activities, including aspects of the Browser's
performance and error messages. No user details are logged, and no UCMDB data, such as CI
attributes, are logged. The log files are stored in the same folder as the UCMDB Browser log folder.
The log files and their data are not sent in any way and remain strictly in the customer's local
environment. In the future, HP will request from customers to share the data in order to learn how
the UCMDB Browser is being used. It is possible to turn off this logging functionality by setting the
Enable user statistics UCMDB Browser setting to false.
Note: If UCMDB Browser is installed on a JBoss application server, logging is only supported
in versions 7.2.0 (6.1.0 EAP) and later.
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65

Specify CI Types Returned in Search Results (legacy search engine)

66

Export Search Results

67

Specify the Appearance and Order of Widgets

67

Configure Properties to be Displayed by the Properties Widget

68

Configure the Properties Widget to Show/Hide Empty Attributes

77

Assign Color Categories
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Change CI Attributes

79

Configure Impact Rules Used by the Impact Simulation widget
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Change the Source of Thumbnails (for the Stakeholder Widget)

84

Change the History Widget 'From Date'

85

Lightweight Modeling
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Notifications
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Export Widget Details
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Initiate Conversations using Enterprise Collaboration
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Properties Widget
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Environment Widget
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History Widget
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Change Request Widget
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Incidents Widget
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Monitoring Widget
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Automation Widget

115

Security Widget

116

Defects Widget

118

Dynamic Widgets

120

Business Widget

122

Logging In
To log in to the UCMDB Browser, enter the following in a web browser:
http://<server_name>:<8088>/ucmdb-browser
where <server_name> represents the fully qualified domain name (FQDN) of the UCMDB server.
Note:
l

To log in to the UCMDB Browser, your UCMDB license must be valid.

l

If you attempt to log in to the UCMDB Browser and a UCMDB server is not available, an
error message is displayed.

l

Starting from UCMDB version 10.10, if you attempt to log in to the UCMDB Browser in a
multi-customer environment and you have not been assigned a role with the permission, an
error message is displayed.

No user administration is possible from within the UCMDB Browser (this is only performed in
UCMDB).
Note:
l

The initial launch after the installation of the UCMDB Browser (prior to login) can take from
30 seconds up to a couple of minutes.

l

When logging in to the UCMDB Browser for the first time with any given UCMDB Server,
the login takes longer (from 30 seconds up to a couple of minutes) due to automatic
deployments.

l

If you are using the UCMDB Browser with a UCMDB 10.00 server, after login the logged-in
user locale information is taken from the UCMDB server and the Browser uses the user’s
locale. If there is no locale defined for the user, or if the UCMDB server is a version earlier
than 10.00, the locale of the Browser is used.
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Login to the UCMDB Browser occurs as follows:
l

UCMDB users. The users of the UCMDB Browser are the same as the users of UCMDB,
therefore, only users that exist in UCMDB are able to log in to the UCMDB Browser.

l

LDAP users. When the UCMDB server is configured to authenticate on LDAP, the UCMDB
Browser automatically detects this and uses this configuration to authenticate users against the
same LDAP.
Note: The following LDAP group configuration is relevant for UCMDB 9.xx only. For
UCMDB 10.xx and later versions, all LDAP configuration and group mapping is performed
only on the UCMDB server, as well as all authentication processing, including LDAP
integration.
When LDAP authentication is performed, you can manage permissions in the ucmdb_
browser_config.xml file. There are two permission options:
n

Allow access to UCMDB Browser for all LDAP users. Access for all LDAP users is enabled if
the section <ldap_configuration> does not exist in the ucmdb_browser_config.xml file or
does not contain at least one record as follows: <group>ldap-group</group> (where ldapgroup is an actual LDAP group name).

n

Allow access to the UCMDB Browser only for LDAP users that are related to LDAP groups.
For UCMDB server 9.04 CUP 5 and earlier, LDAP groups are defined in the ucmdb_
browser_config.xml file in the <ldap_configuration> section. If the ucmdb_browser_
config.xml file contains the <ldap_configuration> section and this section contains at least
one <group>ldap-group</group> record (see the example below), access to the UCMDB
Browser is permitted only to those users that are related to one or more groups that are
defined in the section <ldap_configuration>.
For UCMDB server 9.04 CUP 6 and later, LDAP groups are saved as a list, separated by
comma. The setting name is List of LDAP group (groups).
ldap-group Example:
<ldap_configuration>
<permitted_groups>
<group>group-1</group>
<group>group-2</group>
</permitted_groups>
</ldap_configuration>

Note: The example above of the <ldap_configuration> section with two sample
records is placed in the comments in the ucmdb_browser_config.xml file.

HP Universal CMDB Browser (3.1)

Page 44 of 147

Installation and Configuration Guide
Chapter 3: Search and Functionality

Configure the Enhanced Search Engine
Note: The Enhanced CI search engine is supported on UCMDB 10.00 and later versions.
The Enhanced CI search engine translates free text queries to TQL queries, with much better
performance and accuracy than the legacy search engine and flexible searching language. The
syntax of the search queries is based on the class model.
Note: The Enhanced CI search engine does not support any of the class model configurations
used by the legacy search engine.
The search engine can be configured in the following three areas:
l

Indexing. Configure what is indexed, which CI types are "searchable", which attributes are
"searchable", and what are types of the attributes. This configuration is performed with the
Search_Indexer_Configuration_XML and Search_Ranking_Configuration_XML files.
This configuration file includes a list of class types that are indexed and a list of attributes for
each one of the class types. This configuration influences the manner in which the search by
property condition is performed.

l

Parsing. Configure class model synonyms. Synonyms translate the user input string query into
a graph structure, TQL. This configuration is performed with the Search_Parser_
Configuration_XML file.
This configuration file includes a set of class synonyms, attribute synonyms, date synonyms,
relation synonyms, and a set of redundant words.

l

Ranking. Configure which CI types are presented and the order of presentation. Prioritization is
according to class model. This configuration is performed with the Search_Ranking_
Configuration_XML file.
This configuration file contains a list of attributes that are associated with five data fields, called
data0, data1, data2, data3, and data4. These fields are prioritized, where data4 has the highest
priority and data0 has the lowest priority.
This configuration influences the order of CIs in the search results.

The UCMDB Browser can be used out-of-the-box without initial configuration of the search engine.
However, if an attribute is not in the Indexer or Ranking lists, it does not appear in the search
results.
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Modify the currently indexed list
1. Go to JMX Console > UCMDB:service=Topology Search Services.
2. Choose one or more of the following operations:
n

editIndexerConfiguration – displays and enables editing of the Search_Indexer_
Configuration_XML file.

n

editParserConfiguration – displays and enables editing of the Search_Parser_
Configuration_XML file.

n

editRankingConfiguration – displays and enables editing of the Search_Ranking_
Configuration_XML file.

3. For each operation, enter the relevant customer ID and click Invoke.
Enable/Disable the Enhanced Search Engine
For the enhanced search engine to work, it must be enabled in UCMDB. By default, it is enabled
(unless it was disabled during UCMDB installation).
To change the enable/disable setting:
1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.
2. In the name field enter cmdb.search.enabled.
3. In the value field enter:
true: If you want the search enabled.
false: If you want the search disabled.
4. Click Invoke.
5. Restart the UCMDB server.
Note: If you disable the Enhanced Search Engine, the UCMDB Browser automatically reverts
to the legacy search engine.

Enable/Disable Searching for Federated Data
The enhanced search engine can be configured to perform searches on federated data. By default,
it is disabled. To enable searching for federated data, you must set the "federated search enable"
flag to True in the JMX Console and in the UCMDB Infrastructure Settings Manager.

Enable or disable searching for federated data in the JMX console
1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.
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2. In the name field enter cmdb.federation.search.enabled.
3. In the value field enter:
true: If you want to enable searching federated data.
false: If you want to disable searching federated data.
4. Click Invoke.
5. Restart the UCMDB server.

Enable or disable searching for federated data in the UCMDB
Infrastructure Settings Manager
Follow the instructions in the section "Specify Data stores Used for Data Loading" in the HP
Universal CMDB Administration Guide.

Enable searching of federated CIs by CI display name
To search for a federated CI by the CI display name (or sub-string of the display name), the CI type
must be assigned the qualifier CMS_BROWSER_SEARCH in the CI Type Manager.

Specific Configuration Options
Configure Search by Data
In the Search_Ranking_Configuration_XML file, you can associate attributes of a CI to a data
field according to the data field priority. This enables a search of the values of those CI attributes
and affects the order of CIs returned in the search results.

Configure Search by Topology
In the Search_Parser_Configuration_XML file, you can configure relationship synonyms that
associate phrases with class types. For example, in the example below, the phrase "owned by" is
associated with the class type "person".
<relationship>
<synonym>owned by</synonym>
<className>person</className>
</relationship>

As a result of the above configuration, if the user enters the search query "all windows owned by
John", the search engine looks for all windows CIs that are connected to a CI of type 'person' with
the name 'John'.

Configure Search by Path
In the Search_Parser_Configuration_XML file, you can define compound classes by inserting a
list of class types. In the example below, all the class types in the <string> tag make up the
compound class, which triggers the search by path. If this list is empty, no search by path is
initiated.
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You can change the number of linked paths through which you want to search, starting from the
original search term. To do this, go to the Infrastructure Settings Manager in UCMDB and change
the Search Engine Compound Depth setting to the value you want. For details, see "Infrastructure
Settings Manager" in the HP Universal CMDB Administration Guide.
<compoundClasses>
<string>msdomain</string>
<string>person</string>
<string>osuser</string>
<string>location</string>
<string>business_element</string>
<string>cluster</string>
<string>party</string>
</compoundClasses>

Configure Search by Cardinality Condition
In the Search_Parser_Configuration_XML file, you can define a set of cardinality synonyms that
associate phrases with cardinality types. For example, if you define
<cardinalitySynonym cardinalityType="MIN" cardinalityPhrase="with at least"/>

and then a user enters the search query "all NT with at least 2 CPUs", the search engine looks for
all CIs with class type 'NT' that have two or more CIs of type CPU related to them.
The out-of-the-box cardinality synonyms are as follows:
<cardinalitySynonyms>
<cardinalitySynonym
<cardinalitySynonym
m"/>
<cardinalitySynonym
<cardinalitySynonym
<cardinalitySynonym
m"/>
<cardinalitySynonym
<cardinalitySynonym
<cardinalitySynonym
less than"/>
<cardinalitySynonym
ly"/>
<cardinalitySynonym
t"/>
<cardinalitySynonym
more then"/>
<cardinalitySynonym
<cardinalitySynonym
<cardinalitySynonym
<cardinalitySynonym

cardinalityType="MIN" cardinalityPhrase="min"/>
cardinalityType="MIN" cardinalityPhrase="with minimu
cardinalityType="EQUAL" cardinalityPhrase="with"/>
cardinalityType="MAX" cardinalityPhrase="max"/>
cardinalityType="MAX" cardinalityPhrase="with maximu
cardinalityType="MIN" cardinalityPhrase="minimum"/>
cardinalityType="MAX" cardinalityPhrase="before"/>
cardinalityType="MAX_EXCLUDED" cardinalityPhrase="with
cardinalityType="EQUAL" cardinalityPhrase="with exact
cardinalityType="MIN" cardinalityPhrase="with at leas
cardinalityType="MIN_EXCLUDED" cardinalityPhrase="with
cardinalityType="MIN"
cardinalityType="MIN"
cardinalityType="MIN"
cardinalityType="MAX"
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<cardinalitySynonym
<cardinalitySynonym
more than"/>
<cardinalitySynonym
<cardinalitySynonym
t"/>
<cardinalitySynonym
<cardinalitySynonym
less then"/>
<cardinalitySynonym
</cardinalitySynonyms>

cardinalityType="NOT" cardinalityPhrase="without"/>
cardinalityType="MIN_EXCLUDED" cardinalityPhrase="with
cardinalityType="MIN" cardinalityPhrase="after"/>
cardinalityType="MAX" cardinalityPhrase="with at mos
cardinalityType="MAX" cardinalityPhrase="maximum"/>
cardinalityType="MAX_EXCLUDED" cardinalityPhrase="with
cardinalityType="MAX" cardinalityPhrase="at most"/>

Configure Search by Property Condition
This search is based on attribute synonyms. In the Search_Parser_Configuration_XML file, you
can define synonyms for the CI attribute names that are defined in UCMDB. In the following
example, the CI attribute display_label has four different synonyms defined for it:
<attributeSynonym>
<synonym>name</synonym>
<attributes>
<attributeName>display_label</attributeName>
</attributes>
</attributeSynonym>
<attributeSynonym>
<synonym>display label</synonym>
<attributes>
<attributeName>display_label</attributeName>
</attributes>
</attributeSynonym>
<attributeSynonym>
<synonym>display</synonym>
<attributes>
<attributeName>display_label</attributeName>
</attributes>
</attributeSynonym>
<attributeSynonym>
<synonym>label</synonym>
<attributes>
<attributeName>display_label</attributeName>
</attributes>
</attributeSynonym>

Another type of search by property condition occurs when a cardinality synonym is followed by a
number, which can also include a unit. For example, if the user enters the search input text
windows with at least 4GB memory, since memory is a synonym for the attribute types
memory_size and nt_physical_memory as shown in the code example below, this triggers a
search by property condition.
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<attributeSynonym>
<synonym>memory</synonym>
<attributes>
<attributeName>memory_size</attributeName>
<attributeName>nt_physicalmemory</attributeName>
</attributes>
</attributeSynonym>
.
.
.
<unit>
<multiplyBy>1073741824</multiplyBy>
<synonym>gigabytes</synonym>
<synonym>g</synonym>
<synonym>giga</synonym>
<synonym>gb</synonym>
</unit>

You can add additional synonyms for cardinality phrases, synonyms for attribute names, and
synonyms for unit types in order to refine this type of search. In the example above, the memory
size attribute is stored in bytes, and in order to search by gigabytes, the search engine uses the
conversion defined in the <multiplyBy> tag (this definition is provided out-of-the-box). In addition to
the conversion for gigabytes, out-of-the-box conversions are also provided for megabytes and
kilobytes.
Note: Units and numbers are rounded according to the range definitions defined by the Use
Update Value Policy qualifier. For more information on setting range definitions, see the
description of the Use Update Value Policy qualifier in the HP Universal CMDB Modeling
Guide.

Configure Search by Category
In the Search_Parser_Configuration_XML file, you can specify labels to be used when searching
for CIs. In the following example, the labels "category" and "color" enable you to search for the
strings “all windows color green” and “all servers category editable”.
<categoryLabelSynonyms>
<categoryLabelSynonym>category</categoryLabelSynonym>
</categoryLabelSynonyms>
<categoryColorSynonyms>
<categoryColorSynonym>color</categoryColorSynonym>
</categoryColorSynonyms>

Configure Class Name Conditions
In the Search_Parser_Configuration_XML file, you can create synonyms for class names. In the
following example, the synonym "windows" was created for the class name "nt".
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<classSynonym>
<synonym>windows</synonym>
<className>nt</className>
</classSynonym>

Configure String Replacement
In the Search_Parser_Configuration_XML file, you can configure string replacements. With the
code example below, if the user enters "virtual node" the search engine converts this to "node host_
isvirtual 1". The CI property 'host_isvirtual' is a boolean property, and is true if the node is virtual,
but the user does not need to know this and this string replacement converts his search query
without the user knowing these details.
<replace>
<from>virtual
node</from>
<to>node
host_isvirtual
1</to>
</replace>

String replacement can be implemented using the '%' wildcard character. With the following code
example, if the user enters the search query "linux nodes" or "linux machine", the search engine
converts this to "nodes version linux" and “machine version linux”, respectively.
<replace>
<from>linux
%1</from>
<to>%1
version
linux</to>
</replace>

Configure Enriching Capability
The enriching mechanism executes enriching queries over the search results. Enriching queries are
defined in two ways, one is user-defined and the other is based on existing folding rules.
The enriching mechanism reviews the CIs in the search results and extends the results by applying
each one of the enriching queries as a perspective over the CI. The enriching process is executed
repeatedly, where after each execution search results are received and then enriched again by the
enriching TQLs, which in turn produces more search results. By default, this process is repeated 3
times, but this can be changed by means of the cmdb.search.enriching.depth parameter. For
instructions on configuring this parameter, see "Configure Repetition of the Enriching Mechanism"
on page 53.
User-Defined Enriching Queries
To create user-defined enriching queries:
1. In UCMDB, go to Modeling > Modeling Studio and click New

.

2. From the drop-down menu, select Query. The Query Definition editor opens.
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3. Click Query Definition Properties

. The Query Definition Properties dialog box opens.

4. In the Type field, select Perspective from the drop-down list.
5. In the Bundles field, click Select Bundles

.

6. From the Bundles list, select search_result_enriching_tqls and click OK.
7. Define the query according to your system needs.
8. Define one of the nodes of the query as Set as Contact Query Node. The query definition is
similar to the perspective definition and therefore should include at least one contact node,
where the contact node is the CI that should be enriched.
There are also two out-of-the-box enriching queries provided in the Modeling Studio. You can view
and edit them as follows:
1. Go to Modeling > Modeling Studio, and select the Resources tab.
2. From the Resources Type drop-down list, select Queries.
3. In the list of queries, go to Search Engine > Enriching TQLs.
4. Under Enriching TQLs, choose one of the enriching queries. You can view it and edit it
according to you system needs.
Enriching Queries Based on Existing Folding Rules
As mentioned above, in addition to the user-defined enriching queries, there is an existing set of predefined enriching queries based on folding rules.
To view, add, or edit enriching queries based on folding rules:
1. Go to Modeling > CI Type Manager.
2. From the CI Types drop-down list, choose Calculated Relationships.
3. In the list of Calculated Links, select Folding Rules (Configuration Manager).
4. Select the Triplets tab on the upper right. The list of Triplets appears.
From each one of the listed triplets there is an automatic mechanism that creates at run-time
an enriching query. It enriches the Target CI type by the Source CI type. In this case, the
Target CI type is the contact node of the query.
5. To add a new triplet, click Add
. If you select the forward relationship direction (from Source
to Target), the Target CI type is enriched by the Source CI type. If you select the backward
relationship direction (from Target to Source), the Source CI type is enriched by the Target CI
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type.
6. To edit a triplet, select the triplet in the list and click

.

Configure Repetition of the Enriching Mechanism
To configure the number of times that enriching is performed on search results:
1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.
2. In the name field enter cmdb.search.enriching.depth.
3. In the value field enter the number of times that you want enriching to be repeated on search
results.
4. Click Invoke.
5. Restart the UCMDB server.

Configure Redundant Words
There is a set of words that the search engine ignores when parsing the search query. To configure
this list, go to the Search_Parser_Configuration_XML file and go to the <blacklist> section.
Add to or edit the list as needed.
The current list of redundant words is a follows:
<blacklist>
<blacklistItem>to</blacklistItem>
<blacklistItem>such as</blacklistItem>
<blacklistItem>with</blacklistItem>
<blacklistItem>for</blacklistItem>
<blacklistItem>or</blacklistItem>
<blacklistItem>a</blacklistItem>
<blacklistItem>the</blacklistItem>
<blacklistItem>like</blacklistItem>
<blacklistItem>in</blacklistItem>
<blacklistItem>and</blacklistItem>
<blacklistItem>of</blacklistItem>
<blacklistItem>if</blacklistItem>
<blacklistItem>an</blacklistItem>
<blacklistItem>on</blacklistItem>
<blacklistItem>linked</blacklistItem>
<blacklistItem>all</blacklistItem>
</blacklist>

Configure Search of CIs Changed in a Specific Time Period
In the Search_Parser_Configuration_XML file, there are a sets of words defined as month-name
synonyms and day-name synonyms. For example:
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<monthSynonym>
<monthName>january</monthName>
<monthNumber>0</monthNumber>
</monthSynonym>
<monthSynonym>
<monthName>jan</monthName>
<monthNumber>0</monthNumber>
</monthSynonym>
.
.
.
<daySynonym>
<dayName>sunday</dayName>
<dayNumber>1</dayNumber>
</daySynonym>
<daySynonym>
<dayName>sun</dayName>
<dayNumber>1</dayNumber>
</daySynonym>

Values in the tags <monthNumber> and <dayNumber> should not be modified. These configurations
allow support of search queries like “all windows created last Sunday” and “all nodes changes
between August 8th 1980 and 25/5/2011”.

Configure Date Format
The search engine supports two dates formats: day-month-year (DMY) and month-day-year (MDY),
which can be configured as follows:
1. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.
2. In the name field enter: cmdb.search.date.format.
3. In the value field enter the desired date format: DMY, MDY, or both.
4. Click Invoke.
5. Restart the UCMDB server.

Configure Number of CIs Returned in Search Results
You can configure the number of presentable CIs that the UCMDB Browser returns in search
results (default=1000). To change this, go to Administration > Infrastructure Settings Manager
and set the value for the setting cmdb.search.autocompletion.from.model.items.

Configure Autocompletion
In the Search_Autocompletion_Configuration_XML file, you can expand the UCMDB Browser's
search capabilities by configuring the UCMDB server to suggest matches for substrings of words in
a search, including CI attribute values.
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1. Go to JMX Console > UCMDB:service=URM Services > listResourceTypes and click
Invoke.
2. Click Topology_AUTOCOMPLETION_CONFIGURATION.
3. Click Search_Autocompletion_Configuration_XML.
4. Enter the fields of classes that you want to index for autocompletion. Since the class name
supports inheritance, you can enter the following:
<supportedAutocompletionFields>
<autocompletionField>
<className>managed_object</className>
<attributeName>display_label</attributeName>
</autocompletionField>
</supportedAutocompletionFields>

or, for example:
<supportedAutocompletionFields>
<autocompletionField>
<className>nt</className>
<attributeName>display_label</attributeName>
</autocompletionField>
<autocompletionField>
<className>unix</className>
<attributeName>display_label</attributeName>
</autocompletionField>
</supportedAutocompletionFields>

5. Click Save resource.

Troubleshooting
UCMDB doesn’t start because of the search subsystem manager. What do
I do?
Stop UCMDB, delete the folder <UCMDB installation folder>/search, then restart UCMDB.
If the search still does not start, disable it, as explained in "Enable/Disable the Enhanced Search
Engine" on page 46 and revert to the legacy search engine.

The search doesn’t return any results
1. Check that UCMDB Search Engine is enabled.
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2. If the search engine is enabled, then in Topology Search JMX, perform the following:
n

restoreFactoryDefaults: This restores factory configuration for the search.

n

reindex: This recreates a search index for CIs in the UCMDB model. Note, this can take up
to several hours for large databases (approx 1M CIs/hour).

The search doesn't find CI types that I want.
There are several different possible causes for this. Check the following:
l

Check that the attribute and CI type are indexable according to the indexing configuration. If they
are not, add the class attributes configuration item as explained "Modify the currently indexed
list" on page 46.

l

Check that you have correct synonyms defined for the class in Class synonyms.

l

Check that rating and pageItemCount for this CI are non-zero. Check for rating in the Attribute
ranking and for pageItemCount in Presentable CI types.

Cardinality conditions don't work or return incorrect results
In addition to checking attribute synonyms, check that the attribute type is defined as numeric in
Indexing Configuration and that units configuration matches attribute units in Search_Parser_
Configuration_XML.

Search presents too many unwanted results
l

Check if you are you using queries with natural language. This can limit results of the "best
guess" of what the user intended.

l

If you need to be 100% certain that your query returns results only of one specific CI type, use
type: ci-type filter in the query.

l

If the two suggestions above don't help, contact the R&D team with your use case and status
report from JMX.

Problem with configuration - restore factory defaults
To restore the default configuration XML files from the factory content, go to JMX Console >
UCMDB:service=Topology Search Services and invoke the restoreFactoryDefaults() method.
Caution: This method overwrites the current configuration. You should back up the
configuration files before invoking it.

Logs and debugging info
Logs
search.log logs everything related to searches. Default log level is INFO, only statistics are
printed. The log level and number of logs are configured with the search.loglevel variable in
conf/log/cmdb.properties.
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Status Report
The topology search JMX status report displays all current configuration tables and statistics for the
search engine component. It is useful to include it when reporting issues to R&D.
Content of Solr Database
The Solr search engine is embedded inside UCMDB server. To query it directly, go to JMX
Console > UCMDB:service=Topology Search Services and invoke the debugSolrQuery()
method.
Example queries:
l

empty query returns all CIs

l

"id:a6693cd46cfd1b4fab0c3551bac9289e" returns a CI with cmdbId
a6693cd46cfd1b4fab0c3551bac9289e. This uses Solr/Lucene syntax.

Using the Enhanced Search Engine
Note: This feature is supported on UCMDB 10.00 and later versions.
The UCMDB’s powerful enhanced search engine analyzes the input search text to retrieve CI data
from UCMDB. Based on the input search text, the search engine performs various types of
searches simultaneously to provide optimum and comprehensive results to the user. The search
engine makes extensive use of synonyms so you do not need to enter the precise name or data of
the items you are looking for to find that items in the search results.
To enhance your ability to obtain better search results, examples and explanations of the available
types of searches are provided here.
Note:
l

The search engine is provided ready to use out-of-the box. However, it is highly configurable
and the various types of searches described here can be modified by the UCMDB
Administrator to meet your system needs. For more information on configuring the
enhanced search engine, see "Specific Configuration Options" on page 47.

l

The enhanced search engine is not case sensitive.

l

The free text search in the enhanced search engine can only be performed in English, other
languages are currently not supported. However, CI names, attributes, and values in other
languages can be found by the enhanced search engine.

Simple Search
The simple search is the most basic type of search. The search engine searches for CIs according
to CI data and synonyms for CI data. CI data can include class names and attributes.
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Simple Search Examples
l

If you enter all Unix or all business application, this triggers a search by class name, since
Unix and business application are class names. The search results include all Unix machines
in the system (when searching for all Unix), or all business applications in the system (when
searching for all business application).

l

If you enter all Windows, since windows is a class name synonym for NT, a search by class
type is triggered for all Windows PCs in the system.
For information on how to configure class name synonyms, see "Configure Class Name
Conditions" on page 50.

l

If you enter Windows version 2008, since version is a synonym of the property discovered_
os_name, this triggers a search for all Windows PCs where the property discovered_os_
name = 2008.

l

If you enter Windows with more than 4GB of memory, since memory is a synonym of the
property memory_size, this triggers a search by property condition for all Windows PCs with
the attribute memory_size > 4GB.
Note: Searches can be performed with any type of pre-defined unit, as explained in
"Configure Search by Property Condition" on page 49. Out-of-the-box definitions are
provided for kilobyte, megabyte, and gigabyte.
For more information on how to configure attribute synonyms, see "Configure Search by
Property Condition" on page 49.

l

If you enter all nodes changed last week, all Unix machines created today, or all Windows
changed since Aug 21st 2013, the search engine can interpret this correctly to yield
appropriate results.
For information on how to configure this search, see "Configure Search of CIs Changed in a
Specific Time Period" on page 53. For information on configuring date formats, see "Configure
Date Format" on page 54.

Search According to CMDB Structure
Searches Based on CI Relationships
If you enter Windows 2008, the search engine looks for CIs with the class name or property
Windows that have a related CI with a property value 2008. This could include, for example, a
Windows server connected to SQL server 2008.
For information on how to configure searching based on CI relationships, see "Configure Search by
Topology" on page 47.
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Search by Path
l

If you enter Windows London, this triggers a search that yields results of all Windows PCs in
the system that are connected directly or indirectly to the London CI.
For more information on how to configure this type of search, see "Configure Search by Path" on
page 47.

l

If you enter all Windows owned by John, the search engine returns all Windows PCs owned
by the user called John.

l

If you enter Oracle 16.55.158, the search engine yields search results with all Oracle servers in
the 16.55.158.* IP address range.

Search by Cardinality Condition
Certain words or phrases trigger a cardinality search, such as with more than or with less than. If
you enter Windows with more than 5 CPUs, this triggers a search that yields results of all
Windows PCs with at least 5 CIs of type CPU connected to them. The term that follows the
cardinality phrase must be a class name or class synonym. In the example here, CPU is a class
synonym.
For information on how to configure the search by cardinality, see "Configure Search by Cardinality
Condition" on page 48.
Note: The example above triggers a search based on CI relationships, since in the UCMDB
CPUs are modeled separately from servers (with direct relationship between them) and this
information may be transparent to the user.

Different Types of Search Results Based on the Same
Input Text
As mentioned above, based on the input search text, the search engine can perform various types
of searches simultaneously. For example, if you enter Windows 2008, the search engine returns
the following results:
l

CIs with the class name or property Windows that have a related CI with a property value 2008
(search based on CI relationships, as described above).

l

All CIs that have both a property called Windows and a property called 2008.

l

All CIs with the class name Windows and a property called 2008.

Special Support
Searches for Exact Strings Using Quotation Marks
If you want to search for an exact string, enter the text with quotation marks. For example, if you
enter “New York”, this yields search results of CIs containing the exact string New York and not
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the two separate strings of New and York. This type of search can also return results of CIs
containing New York as a sub-string, such New Yorker or New York Times.

Better Handling of Searching for Numeric Values
In the UCMDB’s discovery process, some numeric values (for example memory size, disk size,
and so on) are stored as a non-rounded value (for example memory size of 2.999 GB). Searching for
a CI with memory size of 3 GB also yields CIs with a close value, such as 2.999 GB.
For information on how to configure handling of numeric values, see "Configure Search by Property
Condition" on page 49

Phrase Replacement
If you enter Linux machine, this triggers a search of all Unix machines with version = Linux.
For information on how to configure this search, see "Configure String Replacement" on page 51.

Search with Keywords
The search engine supports a set of pre-defined keywords that allow you to perform special
searches. The keywords are type, view, and query.

Search with type Keyword
You can use the type: keyword to filter search results. For example, London John type:Windows
returns only CIs of class type nt located in London and owned by John.
Note: If you do not use type: keyword, the search results may contain CIs of any type. In the
example above, if you were to enter only London John and leave out type: Windows, then
the search engine would yield results of CIs of any type that are located in London and owned
by John.

Search with view Keyword
You can search for CIs in a view by using the keyword view: followed by the view name. For
example, view:myView returns all CIs in the myView view result. You may also want to refine the
search result by combining the keyword with the search algorithms specified above. For example, if
you enter all Windows owned by Alice in view:myView, this returns all Windows PCs that are
both in the myView view result and owned by Alice.
Note: The view name is case sensitive (in the UCMDB the user can define two views myView
and MyVIEW). Also, if the view name contains more than one word (separated with spaces)
the view name should be surrounded with quotation marks, for example view:"My view".

Search with query Keyword
You can also search for CIs in query results. This is similar to searching for CIs in view results, but
for the active query defined in UCMDB. For example, query:myQuery returns all CIs in the
myQuery result.
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Searches Based on Logical Operators
You can use a combination of conditions separated by logical operators. The search engine parses
the search input string from left to right without regards to the prioritization of logical operators, and
not according to the standard rules of logical operator prioritization. For example, A or B and C is
treated as (A or B) and C, and not as A or (B and C).

Examples
l

If you enter PCs owned by John or Jim, this triggers a search that yields results of all PCs in
the system with an owner John and all PCs in the system with an owner Jim.

l

If you enter All Windows with more than 4 CPUs and with at least 4 GB memory, the
search engine yields results of all Windows PCs in the system that have both more than 4
CPUs and at least 4 GB memory.

l

If you enter All Windows versions not 2008, the search engine yields results of all Windows
PCs in the system that are not version 2008.

Enriching Search Results
Explanation and Examples
Since the user is not always aware of how IT entities are modeled in UCMDB, he may enter search
input text for one thing while his real intention was something else. The search engine has been
designed with an enriching mechanism that can "guess" the user’s real intention. For example, if
the user searches for the IP address 16.59.188.16, he may be actually interested in the IP’s
connected node, and so the enriching mechanism looks for all nodes connected to the IP address.
It is possible that the user enters London, but what he really wants to know are the nodes at this
location. The enriching mechanism has been designed to look for all nodes connected to a location
CI, so in this example the search engine would return all nodes connected to the London CI.
For information on how to configure the search engine's enriching capability, see "Configure
Enriching Capability" on page 51.

Federated Search
Explanation and Examples
All the types of searches described above are not performed on federated data. However, the
search engine contains some predefined hard-coded topological queries for performing searches on
federated data. For example, if you enter myServer name and the server name is a federated CI,
there is a federated query that tries to retrieve the CI by its name. This TQL is executed for the CI
types node, business element, and CI collection.
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Note:
l

The search on federated data can only be performed if it is enabled. By default, it is
disabled.

l

The search for federated CIs according to their display names (or sub-string of their display
names) is performed if the CI type has been configured for this.
For instructions on enabling/disabling the search on federated data and enabling a search of a
federated CI by the CI display name, see "Enable/Disable Searching for Federated Data" on
page 46.

The user can also retrieve data on relationships between federated CIs. For example, the user can
retrieve CIs by their IP address. If you enter 16.1.100.45 and this is the IP address of a federated
CI, the search engine returns the actual node connected to this IP address.

Auto-Completion Search Entry Capability
Auto-completion capability is added to the search field and supports the following language entries:
l

CI Type names and synonyms (for example: Windows=NT)

l

Attribute names and synonyms (for example: version=DiscoveredOsName)

l

Relationship names and synonyms (for example: linked to and located in)

l

Cardinality phrases (for example with more than and at least)

Legacy CI Search Engine
The search is performed in the most intuitive way possible using natural language, in the same
manner as modern search engines. The UCMDB Browser currently supports searches for CIs
according to the following attributes:
l

ID

l

Display Label

l

Location

l

IP Address

l

Party (that is, owner)

l

Any attribute marked with the CMS_SEARCHABLE_ATTRIBUTE qualifier. For details on how
to add this qualifier to an attribute, see "Adding the Search Qualifier to an Attribute" on page 64.
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Note: For all UCMDB 9.0x versions, setting the CMS_SEARCHABLE_ATTRIBUTE on an
attribute of a CI Type that inherits attributes from its parent CI Type is an attribute override
and is not supported for performance reasons.

l

If searching for a term that matches a CI Type Display Label, all the instances of the matching
CI Type are displayed along with the results of the normal search.
Note: For all UCMDB 9.0x versions, searching for a date attribute is not supported.

The following are some search examples:
l

Searching for John Doe, who is a project manager, yields all Business Elements and Nodes
whose owner is John Doe

l

Searching for 172.16, which is the most significant part of an IP address, yields all Nodes with
an IP-address starting with “172.16” (that reside in that subnet)

l

Searching for Ohio yields all Nodes residing in data centers located in the state of Ohio, USA

l

Searching for Oracle yields all nodes and relevant running software related to the Oracle DB

l

If the DiscoveredOsName attribute is marked with the CMS_SEARCHABLE_ATTRIBUTE
qualifier, searching for Windows 2008 Server yields all Nodes with the DiscoveredOsName
attribute equal to Windows 2008 Server.

Search Results: Search results (in the current version – CIs) are the heart of the UCMDB Browser.
Users get results of their search criteria, view relevant information at a glance, and, if required,
zoom into the results for a more detailed view. Search results include only Star CI types, which are
the most important CI types. Star CI types receive special treatment from all (or most) widgets,
thus allowing users to receive more comprehensive and relevant information regarding them.
The following is a list of all Star CI types:
l

Business Elements Related

l

CI Collection

l

Node

l

Running Software (excluding Agent, Inventory Scanner)

l

All CI types with the Modeling Enabled or CMS_BROWSER_SEARCH qualifier

Composite Search: A Composite Search allows searching for any CI Type (not just Star CI
types). The search terms must be in the form: X + Y (two search terms, separated by the "+"
character). Any of the search terms can be a possible CI Type display label (for example,
"Windows + server_partial_name" is equivalent to "server_partial_name + Windows").
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Performing a Composite Search greatly increases the number of CIs that can be found in the
UCMDB Browser. Searching is performed on the CI Type represented by one of the search terms.
The other search term is considered as input for the normal search algorithm (described above).
Federated data is also searched, if federation is enabled from the configuration file. For details, see
"Specify Data Stores Used for Data Loading" on the next page.
The matching algorithm attempts to find an exact match on the first term. If nothing is found, it
attempts to find a partial match on the first term (for example, entering "dows" matches the
"Windows" CI Type, entering "nix" matches "Unix" CI Type). If no results are found, the algorithm
attempts to find an exact match on the second term, and if nothing is found, it attempts to find a
partial match on the second term. If no results are found on the second term, the algorithm performs
a search on both terms together including the '+' character.
The Composite Search is not case sensitive. If there are multiple CI Type matches, only the first
one will be returned. If there are more than two terms (for example, a+b+c), the search is performed
on the entire expression, including the '+' character.
Search by Global ID: The user can perform a search for a CI according to its Global ID. This is
useful in the case of federated CIs, where the Global ID and the CMDB ID differ. For example, if a
CI has a Global ID with a value of daily%0Ant%0A1%0ACMDB_ADAPTER_
ID%3DSTRING%3Df37a5e73a861db7f417ba1ee4192544b%0A%03%03%03rmiron1%0Ant
%0A1%0ACMDB_ADAPTER_ID, you can use the Global ID value as search input in the UCMDB
Browser.
Note: To search by Global ID in UCMDB versions 9.0x, you must add the CMS_
SEARCHABLE_ATTRIBUTE qualifier to the Global ID.
CI Refocus: Each CI presented in the UCMDB Browser, either as a search result or as part of a
specific widget, can be refocused by simply selecting it. Refocusing a CI presents its data using
the information widgets.
Adding the Search Qualifier to an Attribute
The qualifier CMS_SEARCHABLE_ATTRIBUTE can be added to a CI attribute, thus enabling
that CI to appear in search results performed in the UCMDB Browser.
Note: This qualifier should not be added to an attribute that does not support the LIKE_
IGNORE_CASE operator (for example integer attributes). This qualifier should only be used
with attributes that support LIKE_IGNORE_CASE operator, such as string attributes.
To add the CMS_SEARCHABLE_ATTRIBUTE qualifier to an attribute:
1. In UCMDB, go Modeling > CI Type Manager.
2. Select the class in which you want to change an attribute.
3. Select the Export to XML button in the upper right of the CI Types tree.
4. Save the XML file containing the exported class on a local drive.
5. Open the XML file for editing.
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6. Find the section corresponding to the attribute to which you want to add the CMS_
SEARCHABLE_ATTRIBUTE qualifier.
An attribute section appears like this:
<Attribute name="attr_name" type="type">
<Attribute-Qualifiers>
<Attribute-Qualifier name="ATTRIBUTE_QUALIFIER1"/>
<Attribute-Qualifier name="ATTRIBUTE_QUALIFIER2"/>
….
</Attribute-Qualifiers>
</Attribute>

Note: If the attribute you want to edit does not have the <Attribute-Qualifiers> section,
add it as specified above.
7. In the <Attribute-Qualifiers> section, add the new <Attribute-Qualifier> tag as follows:
<Attribute-Qualifier name=”CMS_SEARCHABLE_ATTRIBUTE”/>
8. Save the XML file.
9. Go back to the CI Type Manager.
10. Select the class that you previously exported.
11. Select the Import from XML button in the upper right of the tree.
12. Select the XML file that you previously modified.
13. Wait for the import to complete. You will see a success notification message if the import
process is successful, or a failure message with errors if the process fails.

Specify Data Stores Used for Data Loading
The flag federated_search_enabled is used to enable or disable the use of federation regarding
several operations in the UCMDB Browser. If this flag is set to False (this is the default value), the
legacy search engine, enhanced search engine, Properties widget, Environment widget, and
Impact Simulation widget all use only the local data store for gathering data. If this flag is set to
True, all data stores are used when running a search in the legacy search engine and enhanced
search engine, and also when data is loaded for the Properties, Environment, and Impact
Simulation widgets.
For UCMDB 9.04 CUP 6 and later versions, this flag is set on the UCMDB server. For UCMDB
9.04 CUP 5 and earlier versions, this flag is set in the ucmdb_browser_config.xml file (see
instructions below).
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Set the federated_search_enabled flag for UCMDB 9.04 CUP 6 and later
versions
1. In UCMDB, go to Administration > Infrastructure Settings Manager, and choose UCMDB
Browser settings.
2. In the Name column, choose Show federated search results.
3. In the Value column, choose True or False from the drop-down menu.
4. Click Save

.

Set the federated_search_enabled flag for UCMDB 9.04 CUP 5 and earlier
versions
For UCMDB 9.04 CUP 5 and earlier versions, the federated_search_enabled flag is set in the
ucmdb_browser_config.xml file as follows:
<federated_search_enabled>false</federated_search_enabled>

The default value is False. To enable the use of federation, set the value to True.

Limitations on Using Federated Data
The use of federated data has the following limitations:
l

The Environment widget cannot load data from a completely remote CI (that is, a CI that exists
only in a remote data store and does not exist in the local data store).

l

For completely remote CIs, the Properties widget does not display properties calculated from
related CIs.

Specify CI Types Returned in Search Results
(legacy search engine)
In the legacy search engine, this Boolean configuration allows the user to control which CI types
are returned in search results.
For UCMDB server 9.04 CUP 5 and earlier: In the ucmdb_browser_config.xml file, if the
<use_cms_qualifier_results_only> configuration flag is true, the search results show only CI
Types with the CMS_BROWSER_SEARCH qualifier. If the flag value is false, all default CI types
appear, including ones marked as CMS_BROWSER_SEARCH.
For UCMDB server 9.04 CUP 6 and later: In UCMDB, configuring the CI Types to be returned in
Search Results is done through the Show only results with CI Types with CMS_BROWSER_
SEARCH class qualifier setting. This Boolean determines the CI candidates for search. The
default option (false) searches for Star CIs and also CIs with the CMS_BROWSER_SEARCH
qualifier. When this Boolean is true the search is conducted on CIs with the CMS_BROWSER_
SEARCH qualifier only.
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Export Search Results
You can perform a search and export the search results to a CSV or Excel file.
To specify the attributes to be exported:
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. Do the following:
n

In the Name column, choose Minimal export of search results and choose True if you
want to export only the display label, class name, CI ID, and Global ID attributes for each
CI. Choose False if you want to export all attributes that are displayed in the Properties
Widget.
Additional attributes can be excluded if they are marked in the CI Type Manager in UCMDB.
For details, see the description of the Hide in Export Search Results qualifier in the HP
Universal CMDB Modeling Guide.

n

In the Name column, choose Remove logical attributes (owner, location) from export
of search results and choose True to remove the owner and location attributes from the
exported search results.

To export search results to a file:
Click Export search results
l

Current page > XLS or CSV

l

All pages > XLS or CSV

in the search results toolbar. The following options are available:

The created file is named with the date and time that the export was performed.

Specify the Appearance and Order of Widgets
You can specify which widgets appear in the Browser and in what order.
l

For UCMDB server 9.04 CUP 5 and earlier: You configure which widgets appear in the
Browser using the <removed_widgets> tag in the ucmdb_browser_config.xml configuration
file. Enter the name of the widget(s) that you do not want to appear in this tag. For example:
<removed_widgets>ENVIRONMENT</removed_widgets>

would remove the Environment widget from the Browser.
You can configure the order in which widgets appear (from top to bottom) using the <widgets_
order> tag in the ucmdb_browser_config.xml configuration file. For example, if you entered:
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<widgets_order>POLICY,IMPACT,ENVIRONMENT,PROPERTIES</widgets_order>

The Policy widget appears first (top), followed by Impact, Environment, and Properties at the
bottom.
If a widget appears in both the <removed_widgets> tag and the <widgets_order> tag, it does
not appear in the Browser. If a widget is not specifically removed in the <removed_widgets>
tag, it appears in the Browser even if it is not listed in the <widgets_order> list (it appears at the
bottom of the list).
l

For UCMDB server 9.04 CUP 6 to 10.01: In the Infrastructure Settings Manager in UCMDB,
you specify the list of widgets that you do not want to appear in the Browser with the List of
widgets to be removed from the application setting and the order that the widgets appear
with the List of widget order in the application setting. For details, see "Infrastructure
Settings Manager" in the HP Universal CMDB Administration Guide.

l

For UCMDB server 10.10 and later: In addition to specifying whether widgets (including
dynamic widgets) and their order are visible for all users (as mentioned in the previous section),
you can choose the widgets that you want to appear in the Browser only for a particular role by
selecting them on the Resources tab of the Roles Manager in UCMDB. For details, see "Roles
Manager" in the HP Universal CMDB Administration Guide.

Configure Properties to be Displayed by the
Properties Widget
For UCMDB 9.04 CUP 5 to 9.05 CUP 4, and UCMDB 10.00 versions
You can configure attributes of CI Types to be either displayed by the Properties widget or not
displayed by the Properties widget as follows:
1. In UCMDB, go to Modeling > CI Type Manager.
2. In the list of CI Types on the left, choose the CI Type with the attribute(s) that you want to
configure.
3. Select the Attributes tab in the editor on the right.
4. In the list of attributes, double-click on the attribute that you want to configure.
The Edit Attribute window appears.
5. In the Edit Attribute window, click the UCMDB Browser Qualifiers tab and do one of the
following:
n

To hide an attribute:
o

Deselect CMS Browser Visible (UCMDB 9.04 CUP 5 to 9.05 CUP 4 versions).

o

Select Hide in Properties Widget (UCMDB 10.00 version).
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Note: If you select Hide in Properties Widget, make sure that CMS Browser
Visible is not also selected. Otherwise, notifications may appear for attributes that
are not visible.
To display an attribute:

n

Select CMS Browser Visible.
6. Click OK.
CI Overview Mode
A maximum of three properties are displayed for the selected CI, according to the following
priorities:
Note: The order in which properties are presented is alphabetic and cannot be configured.

l

For Non-Star CIs: The first three properties according to these priorities:
a. Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are
inherited from Star CIs
b. Concrete attributes (not inherited)
Note: Configuring the CMS Browser Visible qualifier through the CI Type Manager is
available from UCMDB 9.04 CUP 5 and later.

l

For Star CIs:
n

Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are
inherited from Star CIs.

n

Special or calculated attributes
o

o

For Node Star CI type:
o

Discovered Model

o

Discovered OS Name

o

Display Label from all connected IP Address (comma-separated)

o

Memory Size

For Running Software CI type:
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o

Discovered Product Name

o

Display Label from connected Node

o

Application Category

o

For CI Collection type: the same attributes as for the Non-Star CI

o

For Business Element Related CI type:
o

Business Criticality

o

Last Modified Time

Concrete from the actual CI type or inherited from the Star CI.

n

The order in which properties are presented in CI Overview mode is alphabetic and cannot be
configured.
Widget Details Mode
Properties are displayed in the three panels as follows:
1. Core Properties
n

Star CIs
o

o

Node
o

CMDB Object ID/Global ID

o

Discovered OS Name

o

Node Operating System Installation Type

o

Serial Number

o

Discovered OS Version

o

Discovered Vendor

o

Domain Name

o

Memory Size attribute from instance

o

CPU Type from connected CPU, if empty – Name from connected CPU

o

Calculated number of Core Number from all connected CPU CIs

o

Calculated total File System Size from all connected File System CIs

Running Software
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o

o

n

o

CMDB Object ID/Global ID

o

Discovered Product Name

o

Version

o

Vendor

Business Element/CI Collection
o

CMDB Object ID/Global ID

o

Business Criticality (for Business Element)

Also:
o

All concrete attributes (not derived) that are Visible, excluding static attributes, or
attributes that are inherited from the Star CI.

o

For UCMDB 9.04 CUP 4 and earlier versions: All concrete attributes (not derived)
that are Visible, excluding static attributes.

Non-Star CIs
o

CMDB Object ID/Global ID

o

All concrete attributes (not derived) that are Visible, excluding static attributes.

o

For UCMDB 9.04 CUP 4 and earlier versions: All concrete attributes (not derived)
that are Visible, excluding static attributes.

2. Complementary Properties
n

Star CIs
o

o

Node
o

Last Modified Time

o

Updated By

o

Node Boot Time

o

Node Is Virtual

Running Software
o

Application Category

o

Application Installed Path

HP Universal CMDB Browser (3.1)

Page 71 of 147

Installation and Configuration Guide
Chapter 3: Search and Functionality

o

o

n

o

Application Version Description

o

Last Modified Time

o

Updated By

Business Element/CI Collection
o

Create Time

o

Created By

o

Last Modified Time

o

Updated By

Also:
o

Concatenation of Display Name (comma-separated) of all directly connected Party
CIs. For example," John Doe, UCMDB UI, CMS, HP SW, HP” (divided into two
labels, Owners for Person CIs and Organizations for Organization CIs).

o

Concatenation of Display Name (comma-separated) of all directly connected
Location CIs. For example, “Room 301, 3rd floor, M1, Cupertino, California, World,
Milky Way, Universe”.

Non-Star CIs
o

Last Modified Time

o

Updated By

o

Concatenation of Display Name (comma-separated) of all directly connected Party CIs.
For example," John Doe, UCMDB UI, CMS, HP SW, HP” (divided into two labels,
Owners for Person CIs and Organizations for Organization CIs).

o

Concatenation of Display Name (comma-separated) of all directly connected Location
CIs. For example, “Room 301, 3rd floor, M1, Cupertino, California, World, Milky Way,
Universe”.

3. Additional Properties
n

All attributes complying with the following rule and that were not displayed in any other
panel:
!Static && Have value && Visible && !Deprecated (excluding all attributes derived from
Managed Object)
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For UCMDB 9.05 CUP 5 and later, and UCMDB version 10.00 CUP 1 and
later versions
You can configure attributes of CI Types to be either displayed or not displayed by the Properties
widget, and determine whether an attribute appears in CI Overview mode and in which properties
group it appears in Widget Details mode, as follows:
1. In UCMDB, go to Modeling > CI Type Manager.
2. In the list of CI Types on the left, choose the CI Type with the attribute(s) that you want to
configure.
3. Select the Attributes tab in the editor on the right.
4. In the list of attributes, double-click on the attribute that you want to configure.
The Edit Attribute window appears.
5. In the Edit Attribute window, click the UCMDB Browser Qualifiers tab and do one of the
following:
n

To hide an attribute:
o

Deselect CMS Browser Visible (UCMDB 9.05 CUP 5 and later versions).

o

Select Hide in Properties Widget (UCMDB 10.00 CUP 1 and later versions).
Note: If you select Hide in Properties Widget, make sure that CMS Browser
Visible is not also selected. Otherwise, notifications may appear for attributes that
are not visible.

n

To display an attribute:
Select CMS Browser Visible.

6. If you checked CMS Browser Visible in the previous step, set the following properties:
n

View in preview mode: From the drop-down list, chose True if you want the attribute to
appear in the CI overview, or False if you do not want it to appear in CI Overview mode.

n

Properties group assignment: From the drop-down list, choose the properties group
(Core, Complementary or Additional) in which you want this attribute to appear in Widget
Details mode.

7. Click OK.
CI Overview Mode
A maximum of three properties are displayed for the selected CI, according to the following
priorities:
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Note: The order in which properties are presented is alphabetic and cannot be configured.

l

For Non-Star CIs: The first three properties according to these priorities:
a. Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are
inherited from Star CIs
b. Concrete attributes (not inherited)
Note: Configuring the CMS Browser Visible qualifier through the CI Type Manager is
available from UCMDB 9.04 CUP 5 and later.

l

For Star CIs:
n

Attributes with the CMS Browser Visible qualifier on concrete attributes or attributes that are
inherited from Star CIs.

n

Special or calculated attributes
o

o

n

For Node Star CI type:
o

Discovered Model

o

Discovered OS Name

o

Display Label from all connected IP Address (comma-separated)

o

Memory Size

For Running Software CI type:
o

Discovered Product Name

o

Display Label from connected Node

o

Application Category

o

For CI Collection type: the same attributes as for the Non-Star CI

o

For Business Element Related CI type:
o

Business Criticality

o

Last Modified Time

Concrete from the actual CI type or inherited from the Star CI.

The order in which properties are presented in CI Overview mode is alphabetic and cannot be
configured.
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Widget Details Mode
Properties are displayed in the three panels as follows:
1. Core Properties
n

Star CIs
o

o

o

o

Node
o

CMDB Object ID/Global ID

o

Discovered OS Name

o

Node Operating System Installation Type

o

Serial Number

o

Discovered OS Version

o

Discovered Vendor

o

Domain Name

o

Memory Size attribute from instance

o

CPU Type from connected CPU, if empty – Name from connected CPU

o

Calculated number of Core Number from all connected CPU CIs

o

Calculated total File System Size from all connected File System CIs

Running Software
o

CMDB Object ID/Global ID

o

Discovered Product Name

o

Version

o

Vendor

Business Element/CI Collection
o

CMDB Object ID/Global ID

o

Business Criticality (for Business Element)

Also:
o

All attributes with CMS Browser Visible qualifier set to true and the Properties Group
data item set to Core.
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n

Non-Star CIs
o

CMDB Object ID/Global ID

o

All attributes with CMS Browser Visible qualifier set to true and Properties Group data
item set to Core.

2. Complementary Properties
n

Star CIs
o

o

o

o

Node
o

Last Modified Time

o

Updated By

o

Node Boot Time

o

Node Is Virtual

Running Software
o

Application Category

o

Application Installed Path

o

Application Version Description

o

Last Modified Time

o

Updated By

Business Element/CI Collection
o

Create Time

o

Created By

o

Last Modified Time

o

Updated By

Also:
o

Concatenation of Display Name (comma-separated) of all directly connected Party
CIs. For example," John Doe, UCMDB UI, CMS, HP SW, HP” (divided into two
labels, Owners for Person CIs and Organizations for Organization CIs).

o

Concatenation of Display Name (comma-separated) of all directly connected
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Location CIs. For example, “Room 301, 3rd floor, M1, Cupertino, California, World,
Milky Way, Universe”.
o

n

All attributes with the CMS Browser Visible qualifier set to true and Properties
Group data item set to Complementary.

Non-Star CIs
o

Last Modified Time

o

Updated By

o

Concatenation of Display Name (comma-separated) of all directly connected Party CIs.
For example," John Doe, UCMDB UI, CMS, HP SW, HP” (divided into two labels,
Owners for Person CIs and Organizations for Organization CIs).

o

Concatenation of Display Name (comma-separated) of all directly connected Location
CIs. For example, “Room 301, 3rd floor, M1, Cupertino, California, World, Milky Way,
Universe”.

o

All attributes with the CMS Browser Visible qualifier set to true and Properties Group
data item set to Complementary.

3. Additional Properties
n

All attributes complying with the following rule and that were not displayed in any other
panel:
!Static && Have value && Visible && !Deprecated (excluding all attributes derived from
Managed Object)

n

All attributes with CMS Browser Visible qualifier set to true and Properties Group data item
set to Additional.

Configure the Properties Widget to Show/Hide
Empty Attributes
The Properties widget has a setting called Show attributes that have no value, which can be set
to True or False. If this setting is True, any empty attribute (that is, an attribute with no value) for
the selected CI is displayed with the value N/A, both in the CI Overview and the Widget Details
modes. If this setting is set to False, any empty attribute for the selected CI is not displayed. The
default value of this setting is False.
To set the Show attributes that have no value setting:
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
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2. Set the value of Show attributes that have no value to the value that you want, either True or
False.

Assign Color Categories
Note: This feature is supported on UCMDB 10.10 and later versions.
Color categories in the UCMDB Browser help you with the navigation and searching of CIs. You
may assign any of the available colors to any CI:
Gray (if no category is specified)
Blue
Cyan
Green
Orange
Red
Sky Blue
Violet
Yellow
You can view and change the color categories by clicking the colored icon:
l

in the lower right corner of each CI on the search results page (both in grid view and thumbnails
view)

l

in the lower right corner of each CI on the Most Visited page

l

in the upper right corner of the CI overview page for a selected CI

To assign a color category, click the color icon in any of these locations, and select the color
category that you want to apply to the CI. Changes are reflected in all places where categories are
indicated.
After assigning colors, you can use the color categories to refine your search (for example, "all red
Windows servers" or "all blue business applications located in Seattle".
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Enable color categories
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. Set the value of Enable categories to True.
3. Click Save

.

4. Log out from the UCMDB Browser, and then log in again (this loads the new setting).

Manage color categories
1. Click the Settings

button and select Manage System Categories.

2. Change the label for one or more of the available colors.
3. Click OK.

Change CI Attributes
In the Properties widget, you can change the selected CI's attributes in the CI details pane. A CI
attribute can be edited if the following conditions are met:
l

The attribute is marked with UCMDB_BROWSER_EDITABLE_ATTRIBUTE qualifier. Even if
the attribute does not appear in the CI details, if it is marked with this qualifier it appears when
you click Edit. For instructions on how to mark an attribute with this qualifier, see "Mark an
attribute as CMS Browser editable" on page 82.

l

The attribute is not defined as read-only. Any one of the following qualifiers defines an attribute
as read-only:
n

STATIC_ATTRIBUTE

n

READ_ONLY_ATTRIBUTE

n

ID_ATTRIBUTE

n

CALCULATED_ATTRIBUTE

Note: CI attributes cannot be changed for federated CIs.
In addition to the standard CI types that can be defined for a CI in UCMDB, this widget also allows
for editing location and owner attributes of the selected CI. The list of CI locations that you can
choose from is derived from the list of available Locations CIs in UCMDB, and the list of owners
that you can choose from is derived from the list of available Party CIs in UCMDB. The owner
attribute can have multiple instances. To change the location or owner, see "Change CI location
and owner" on page 82. To add an additional owner to a CI, see "Add an additional owner" on page
82
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The following attribute types have unique editing features in the Properties widget:
l

Boolean. If an attribute is defined as boolean, a drop-down box appears that allows you to
choose True or False.

l

Date. If an attribute is defined as date number, a date picker appears that allows you to pick the
date according to day, month, and year.

l

xml. If an attribute is defined as xml, a text editor appears that allows you enter free text for this
attribute.

l

bytes. If an attribute is defined as bytes, a text editor appears that allows you enter free text for
this attribute. The difference between this attribute type and the xml attribute type is that the
value of this attribute type is archived before it is saved to the database.

l

List of integers. If an attribute is defined with this type, you can add a list of integers to this
attribute. For instructions on how do this, see "Add a list of Integers or Strings to an attribute" on
the next page.

l

List of Strings. If an attribute is defined with this type, you can add a list of strings to this
attribute. For instructions on how do this, see "Add a list of Integers or Strings to an attribute" on
the next page.

To define an attribute in UCMDB with one of the types above, follow the instructions in "Create a CI
attribute with a unique type" on page 83.
Caution: If you attempt to save input for string, xml, or byte attributes that is longer than the
limit defined in the UCMDB CI Type Manager, the following error message appears: "The
following error occurred: Reconciliation DataIn general error. The changes were not saved." If
this happens, re-enter the input so that it is within the defined limit.
The following changes can be made:
l

"Change a CI attribute" on the next page

l

"Change a CI attribute with Enumeration type" on the next page

l

"Add a list of Integers or Strings to an attribute" on the next page

l

"Change CI location and owner" on page 82

l

"Add an additional owner" on page 82

l

"Mark an attribute as CMS Browser editable" on page 82

l

"Create a CI attribute with a unique type" on page 83
Note:
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l

Changing CI location and owner is supported only on UCMDB 9.05 CUP 1 and later
versions.

l

Changing all other CI attributes is supported only on UCMDB 9.05 CUP 3 and later
versions.

l

This feature is only accessible to users with editing permissions on the selected CI.

Change a CI attribute
1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.
2. Change the value of the CI attribute.
3. Click Save Changes.
Note: For an attribute that appears in CI Overview mode, if you update it in Widget Details
mode the updated value will appear if you return to CI Overview mode.

Change a CI attribute with Enumeration type
1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.
2. By the location of the enumeration attribute, click the down arrow.
3. From the drop-down list, select the value that you want to assign to this attribute.
4. Click Save Changes.

Add a list of Integers or Strings to an attribute
If an attribute has been defined with the type list of integers or list of strings (as described in
"Create a CI attribute with a unique type" on page 83), you can add a list of integers or strings to the
attribute as follows:
1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.
2. Go to an attribute that is defined as list of integer or list of strings, and click the Edit
button.
3. In the input field that appears, enter a string or integer.
4. If you want to add an additional string or integer, click the Add
additional string or integer in the input field that appears.

button and enter the

5. Continue adding strings or integers in this manner until you have entered the data you want,
and then click Save Changes.
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Change CI location and owner
1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit..
2. By the Location or Owner field, click the Edit

button. A drop-down list appears.

3. From the drop-down list, select a Location/Owner.
Tip: If you have a long drop-down list, you can filter the list by typing the initial characters
of the Location/Owner name at the top of the drop-down list. For example, if you type the
letters 'Per' at the top of the Owner drop-down list, the list is filtered to show only Owner
names that start with 'Per'.
4. Click OK in the drop-down list.
Note: After selecting a Location /Owner and clicking OK, you can remove your selection
by clicking the 'X' button by the Location/Owner field.
5. Click Save Changes.

Add an additional owner
1. Ensure that Widget Details mode is displayed for the Properties widget, and click Edit.
2. To the right of the owner field, click the Add

button. An additional owner appears.

3. In the new owner field, assign a value as described above.
4. Click Save Changes.

Mark an attribute as CMS Browser editable
1. In UCMDB, go to Modeling > CI Type Manager and select the Attributes tab.
2. Choose the desired CI Type.
3. Choose the attribute that you want to make "editable" from the displayed list, and click the Edit
button .
4. In the Edit Attribute dialog box that appears, click the Advanced tab, check CMS Browser
Editable, and click OK.
5. Save your changes to the CI type.
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Create a CI attribute with a unique type
1. In UCMDB, go to Modeling > CI Type Manager and select the Attributes tab.
2. Choose the desired CI Type.
3. Click the Add

button. The Add Attribute dialog box opens.

4. In the Attribute type section, select Primitive, and from the drop-down list select one of the
following:
n

list of integers

n

list of strings

n

boolean

n

date number

n

xml

n

bytes

5. Save your changes to the CI type.

Configure Impact Rules Used by the Impact
Simulation widget
The Impact Simulation widget runs an impact analysis that uses impact rules, in the same manner
as UCMDB. These impact rules can be grouped into bundles. The default setting is to run the
analysis using all available bundles, however you can choose to run the analysis using only certain
bundles and not others. For UCMDB Server 9.04 CUP 6 and later versions, you can select the
bundles you want to use for impact analysis on the UCMDB server (see instructions below). For
UCMDB Server 9.04 CUP 5 and earlier versions, you can select the bundles you want to use for
impact analysis in the ucmdb_browser_config.xml file (see instructions below).

Select bundles for impact analysis for UCMDB 9.04 CUP 6 and later
versions:
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. In the Name column, choose List of impact rules bundles to be used by impact widget.
3. In the Value column, enter a comma-separated list of bundle names.

HP Universal CMDB Browser (3.1)

Page 83 of 147

Installation and Configuration Guide
Chapter 3: Search and Functionality

Note:
n

Incorrect bundle names are ignored.

n

A bundle name that contains a comma cannot be used.

4. Click Save

.

5. Log out from the UCMDB Browser, and then log in again (this loads the new bundle settings).

Select bundles for impact analysis for UCMDB 9.04 CUP 5 and earlier
versions:
For UCMDB 9.04 CUP 5 and earlier versions, set the tag <impact_widget_rules_bundles> in the
ucmdb_browser_config.xml file as follows:
<impact_widget_rules_bundles><enter here bundle names separated by commas></
impact_widget_rules_bundles>

Incorrect bundle names are ignored. A bundle name that contains a comma cannot be used.
After saving and closing ucmdb_browser_config.xml, log out from the UCMDB Browser and then
log in again to load the new bundles settings.

Change the Source of Thumbnails (for the
Stakeholder Widget)
The default source for pictures of CI owners (both direct and indirect) presented in the Stakeholder
widget is the gravatar.com web site. This source location can be changed according to the
following instructions.
For UCMDB 9.04 CUP 6 and later versions:
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. In the Name column, choose Stakeholder Image URL.
3. In the Value column, enter the URL for the new source location. The URL should have a
parameter (or parameters) in square brackets (as shown in the examples below), which is an
attribute name from the Party CIT, or from the Organization CIT or Person CIT which are
children of the Party CIT. At runtime, the actual value of this attribute is set in the URL in order
to receive the image.
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Examples:
n

To use an image from the gravatar site, enter:
http://www.gravatar.com/avatar/[email]?s=42&d=mm
where [email] is an attribute of the Person CIT and will be replaced by the actual email
address of the Stakeholder at runtime.

n

To use an image from Facebook image, enter:
https://graph.facebook.com/[attr_name]/picture
where [attr_name] is an any attribute that contains the Facebook User ID (this attribute
should be added to Party CIT) and will be replaced by the actual Facebook User ID of the
Stakeholder at runtime.

n

To use an image from Google, enter:
https://profiles.google.com/s2/photos/profile/[attr_name]?sz=42
where [attr_name] is an any attribute that contains the Google User ID (this attribute should
be added to Party CIT) and will be replaced by the actual Google User ID of the Stakeholder
at runtime.

For UCMDB 9.04 CUP 5 and earlier versions:
For UCMDB 9.04 CUP 5 and earlier versions, the URL is defined in the Browser configuration file
as follows:
<stakeholder_widget_configuration>
<image_url><The url you want to use for the image></image_url>
</stakeholder_widget_configuration>

Change the History Widget 'From Date'
Note: The History widget is supported on UCDMB 9.0x versions from UCMDB 9.05 CUP6
and later, and on UCMDB 10.x versions from UCMDB 10.01 and later.
The History Widget uses a beginning date and end date to show changes in CI data that occurred
during the period defined by those two dates. The default end date is the current date and time and
the default beginning date is the current end date minus the History Widget From Date setting
that is set in UCMDB. The default value for the History Widget From Date setting is 7, but this
value can be changed by the UCMDB Administrator as explained below.
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To change the History Widget 'From Date':
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. In the Name column, choose History Widget From Date.
3. In the Value column, enter the number of days that you want for the From Date.
4. Click Save

.

5. Log out from the UCMDB Browser, and then log in again (this loads the new setting).

Lightweight Modeling
Note: Lightweight modeling is supported on UCDMB 10.01 and later versions.
Lightweight modeling in the UCMDB Browser provides a more accessible interface for CI modeling
than is available in UCMDB. Lightweight modeling is designed for end-users who do not need the
full modeling capabilities that the UCMDB provides for administrators. The UCMDB Browser
provides a very intuitive and straightforward user interface for creating CIs and relationships
between CIs.
Lightweight modeling is performed according to modeling templates. Best practice modeling
templates are provided out-of-the-box. The best practices templates can be used out-of-the-box ‘as
is’, or the UCMDB administrator can edit them according to your organization's needs. New
modeling templates can also be created by the UCMDB administrator. For instructions on creating
templates, see "Create Modeling Templates" on page 90.
To change the order in which modeling layers are displayed, see "Change the Modeling Layering
Order" on page 91.
Note: To use lightweight modeling, users must have data-update permissions assigned in the
UCMDB Security Manager.

Get Started with Lightweight Modeling
Do one of the following:
l

When no CI is selected:
a. Click the Modeling tab at the top of the UCMDB Browser screen.
b. Select a template from the Template drop-down list.
Note: If the model is empty, the first created CI can be of any type and can belong to any
one of the model's group nodes. When the model is no longer empty (for example, after the
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first CI has been created), only CIs relating to the existing CI or CIs can be created.
When a CI is selected and its CI details are displayed in the UCMDB Browser:

l

Click Model in the upper right of the CI Details window, and select a model from the drop-down
list.
The modeling topology map is displayed with the selected CI automatically loaded in the model,
along with its related CIs as defined by the template.
Note:
l

The templates displayed in the drop-down menu are according to the user’s permissions on
the query resource and also according to the selected CI type.

l

The selected template can be changed after you have started to make modeling changes.
However, if you change the template all modeling changes made with the previous template
are not saved.

Modeling Actions
You can perform the following modeling actions:
l

"Edit the Properties for the Selected CI" below

l

"Remove the Selected CI from the Model" on the next page

l

"Remove the Selected CI from UCMDB" on the next page

l

"View in the Model a List of All CIs that are Related to the Selected CI" on the next page

l

"Add an Existing CI to the Model" on page 89

l

"Create New CIs and Add Them to the Model" on page 89

l

"Create and Remove Relationships between the Selected CI and Other CIs in the Model" on
page 90

l

"Save Changes to the Model" on page 90

l

"Create Modeling Templates" on page 90

l

"Change the Modeling Layering Order" on page 91

Edit the Properties for the Selected CI
1. Ensure that a CI is selected in the map.
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2. In the right panel, click Edit CI.
Note:
n

Similar to the Properties widget in the UCMDB Browser, the CI properties are displayed
in the right panel. In the LW modeling window, mandatory properties are marked with an
‘*’. All of the mandatory fields must have a value to save changes you make to any of
the CI properties.

n

For a property to be edited, it must be defined as CMS Browser Editable in UCMDB,
in the same manner as the Properties widget.

n

If an attribute of a CI type has the Hide in Modeling qualifier selected, it is not
displayed when editing the CI.

3. Edit the property values.
4. Click Apply on the bottom of the panel.

Remove the Selected CI from the Model
1. Ensure that the CI you want to remove is selected in the map.
2. In the right panel, click Remove from Model.
The CI is removed from the model.
Note:
l

If you create a model based on a particular CI, you cannot remove that CI from the model.

l

If you create a model based on an empty template, you can remove all CIs from the model.

Remove the Selected CI from UCMDB
1. Ensure that the CI you want to remove is selected in the map.
2. In the right panel, click Remove from UCMDB.
The CI is removed from the model and deleted entirely from UCMDB.

View in the Model a List of All CIs that are Related to the Selected CI
You can view in the model all CIs related to the selected CI (as defined by the selected template) as
follows:
In the right panel, click Show All Connected CIs. This loads, from UCMDB, all CIs related to the
selected CI, as defined by the modeling template. The related CIs are displayed in the model.
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Add an Existing CI to the Model
You can add an existing CI to the model. When you do this, it is automatically connected to the
selected CI in the model. This may not be the CI that started the model.
1. Do one of the following:
n

In the right panel, go to the section called Add CIs and click Existing under the CI type that
you want.

n

Click Plus
in one of the CI type sections in the model. Then, in the right panel, click
Add Existing <CI type>.

The search screen appears. By default, a list of all CIs with the CI type you selected in the
previous step is displayed.
2. Locate the CI you want to add either by finding it in the displayed list or by searching for it in the
search box and click Add, which appears when you hover over the CI.
The CI is now added to the model, directly linked to the selected CI.
3. You can continue to add more CIs in this manner. When finished, click Done at the bottom of
the right panel.

Create New CIs and Add Them to the Model
You can create a new CI and add it to the model. When you do this, it is automatically connected to
the selected CI in the model. This may not be the CI that started the model.
Note: Only CIs with a CI type that has been assigned the MODELING_ENABLED qualifier in
UCMDB (by the system administrator) can be created in the LW modeling screen.
1. Do one of the following:
n

In the right panel, go to the section called Add CIs and click New under the CI type that you
want.

n

in one of the CI type sections in the model. Then in the right panel, click
Click Plus
Create New <CI type>.
Note:
o

Similar to the Properties widget in the UCMDB Browser, the CI properties are
displayed in the right panel. In the LW modeling window, mandatory properties are
marked with an ‘*’. All of the mandatory fields must have a value to save changes
you make to any of the CI properties.

o

For a property to be edited, it must be defined as CMS Browser Editable in
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UCMDB, in the same manner as the Properties widget.
o

If an attribute of a CI type has the Hide in Modeling qualifier selected, it is not
displayed when editing the CI.

2. Edit the property values.
3. Click Apply on the bottom of the panel.
The CI is now added to the model, linked to the CI that was selected.

Create and Remove Relationships between the Selected CI and Other CIs
in the Model
You can create relationships between CIs in the model and the selected CI, or remove existing
relationships between CIs in the model and the selected CI.
1. In the right panel, go to the Edit Connections section and hover over the CI that you want to
create a relationship with or remove the relationship from the selected CI.
Note: You can create relationships only with those CIs that are allowed by the template to
have a relationship with the selected CI and only with those CIs that are displayed.
2. Click Connect or Disconnect.

Save Changes to the Model
Click Save at the top right of the modeling screen. When you click Save, all the changes you have
made in the LW modeling screen are saved to UCMDB. Until you click Save, none of the changes
you have made are saved.
It is possible that when you click Save, you will receive an error message(s) indicating what needs
to be fixed. Also, if there are errors the invalid CI is marked with a red triangle on the upper left
corner.

Create Modeling Templates
1. In UCMDB, go to Modeling Studio and click New

.

2. From the drop-down menu, select Query. The Query Definition editor opens.
3. Click Query Definition Properties

. The Query Definition Properties dialog box opens.

Note: By default, the Type field in the Query Definition Properties dialog box is Integration.
This value should not be changed.
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4. Ensure that Integration is selected in the Type field (it should be selected by default).
5. In the Bundles field, click Select Bundles

. The Select Bundles dialog box opens.

6. From the Bundles list, select modeling and click OK. If modeling does not appear in the list,
enter modeling in the text field and click Add New Bundle.
7. In the Query Definition Properties dialog box, click OK.
8. Build the TQL query and save it to any location.
Note:
l

For a user to view the template in the UCMDB Browser, he must have permissions on the
query resource.

l

The following limitations exist on modeling templates:
n

Virtual links and compound links are not allowed.

n

The TQL query must not have circular dependency.

Change the Modeling Layering Order
You can change the order in which the modeling layers are displayed.
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. In the Name column, select Layer ordering.
3. In the Value field, change the layering order to the order that you want. Ensure that all layering
names are separated by commas.
4. Click Save.
5. If the UCMDB Browser is currently open, log off and then login again to see the changes in the
layering order. If the UCMDB Browser is not open, you will see the changes in the layering
order the next time you login.

Notifications
Note: Notifications are supported on UCDMB 10.10 and later versions.
Notifications in the UCMDB Browser enable you to see which property (CI or attribute) has
changed, been added, or been deleted since the last time notifications were generated.
Notifications are sent according to values specified in the UCMDB settings.
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After enabling notifications in UCMDB (as described in "Configuring notifications" on the next
page), click
to specify the widgets for which you want to see notifications. This icon appears in
the following locations:
l

on the search results page

l

on the Most Visited page

l

in CI Overview mode

l

in Widget Details mode

A list of notifications appears in the Notifications tab in the UCMDB Browser, marked with a
(unread) or (read) indicator, as well as in the locations mentioned above. In the Notifications tab,
you can choose to display all notifications or only unread notifications.
Clicking a notification opens the CI in CI Overview mode. Here, the widgets to which you have
subscribed that contain changes are marked with a
indicator (the changes themselves are
visible only in Widget Details mode). After entering Widget Details mode for any of the marked
widgets, the icon in CI Overview mode changes to
. For widgets that contain changes, in
Widget Details mode, notifications that are marked with an
indicator display their values inline.
If
is displayed, click the indicator to see the older values in a pop-up window.
Indicators for changed values appear in the following widgets:
Properties widget

An indicator is displayed next to each changed attribute (simple or logical,
such as owner, CPU, memory, and so on). For details, see "Properties
Widget" on page 96.

Environment
widget

An indicator is displayed for each newly added CI in the CI list. For details,
see "Environment Widget" on page 97

History widget

An indicator is displayed for the current CI and for CIs related to the current
CI (up to five levels). For details, see "History Widget" on page 99.

Policy widget

An indicator is displayed on each new policy or on a change in the policy
status. For details, see "Policy Widget" on page 104.

Stakeholder
widget

An indicator is displayed for each CI in the list, as well as on the
stakeholder's personal information (email address and phone numbers). For
details, see "Stakeholder Widget" on page 114.
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Widgets related
to Service
Manager: Change
Request,
Incidents, and
Problems widgets

An indicator is displayed for each ticket, summarizing the changes in the
ticket. Indicators appear for new and updated items (what changed in the
affected CIs, phase, severity value, dates, and so on).
Note: You may receive notifications for these widgets but not be able to
view the corresponding widget details if:
l

The particular request from Service Manager is in a state that
currently is not configured as being displayed in the UCMDB
Browser. To specify Service Manager request states to be
displayed, in UCMDB, go to Administration > Infrastructure
Settings Manager > UCMDB Browser Settings and specify the
statuses that you want to be displayed.

l

The particular CI that was subscribed to notifications for these
widgets from Service Manager is no longer affected by a request.

Note: In all widgets, for data that has been removed or deleted, a
indicator
appears next to the widget's title. Click the indicator to view a pop-up window containing all
deleted CIs and attributes.

Configuring notifications
l

To enable notifications:
a. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB
Browser settings.
b. In the Name column, choose Enable notifications.
c. In the Value column, set the value to True.
d. Click Save

.

e. Log out from the UCMDB Browser, and then log in again to load the new setting.
f. In the UCMDB Browser, click
notifications.
l

and specify the widgets for which you want to see

To specify persistency values for notifications:
The length of time that notifications are retained and how often they are generated are defined in
the JMX console:
a. Go to JMX Console > UCMDB:service=Settings Services > setSettingValue.
b. To change each setting, follow these steps:
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i. In the name field, enter one of the strings listed below:
o

tql.tracker.queue.evaluation.initial.delay.in.min - the initial delay (in minutes) after
startup, before a TQL query is calculated.

o

tql.tracker.queue.evaluation.period.in.min - the interval (in minutes) of how often a
TQL query is scheduled to run.

o

tql.tracker.queue.max.single.run.time.in.min - the maximum length of time (in
minutes) for the system to work on calculating changes on CIs or TQL queries
during a single execution.

o

tql.tracker.min.time.between.tracker.runs.in.min - the minimum length of time
between two runs of a TQL query.
Note: To find the default value for each setting, enter the required string in the
name field of getSettingDefaultValue and click Invoke.

ii. In the value field, enter the value you want to set.
iii. Click Invoke.
c. Restart the UCMDB server.

Exporting notifications
You can choose to export results for all notifications or only for unread notifications. On the
Notifications tab, click View: Unread or View: All as required.
In addition to the attributes that you specify in the Infrastructure Settings Manager in UCMDB, the
name of the widget in which the changed CI appears is also included in the results.
l

To specify the attributes to be exported:
a. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB
Browser settings.
b. Do the following:
o

In the Name column, choose Minimal export of search results and choose True if you
want to export only the display label, class name, CI ID, and Global ID attributes for each
CI. Choose False if you want to export all attributes that are displayed in the Properties
Widget.
Additional attributes can be excluded if they are marked in the CI Type Manager in
UCMDB. For details, see the description of the Hide in Export Search Results qualifier
in the HP Universal CMDB Modeling Guide.

o

In the Name column, choose Remove logical attributes (owner, location) from
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export of search results and choose True to remove the owner and location attributes
from the exported search results.
If you set Minimal export of search results to False, the attributes displayed in the expanded
mode of the Properties widget are exported.
To export notification results:

l

Click Export search results
available:
n

Current page > XLS or CSV

n

All pages > XLS or CSV

in the search results toolbar. The following options are

The created file is named with the date and time that the export was performed.

Export Widget Details
You have the ability to export the details for a selected CI in any of the supported widgets
(Properties, Environment, Impact Simulation, History, and Stakeholder widgets).
To enable this functionality, in UCMDB, go to Administration > Infrastructure Settings
Manager > UCMDB Browser Settings and set Enable reports to True. If this feature has not
been enabled, the export icons do not appear in the UCMDB Browser.
Note: Generated reports that are older than one week are automatically deleted.

Export details for a specific widget
In CI Overview mode, click the
icon on a supported widget, or in Widget Details mode, click the
icon and select one of the following options:
l

Export to PDF

l

Export to XLS

l

Export to CSV

The details that are displayed in the selected widget are generated in a file which you can view
immediately or save.
Note: For the History widget, the following details are exported:
l

The report generated from the Selected tab contains the history of the changed attributes
and related CIs for the selected CI, based on a specified time range.
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l

The report generated from the Model tab begins with the same content as the Selected
report, but continues listing the details of the Selected report for each CI found in the
selected CI's Model. This report is also based on a specified time range.

Export details for all supported widgets
In CI Overview mode, click the
options:
l

Export to PDF

l

Export to XLS

icon at the top of the screen and select one of the following

The details that are displayed for all supported widgets are generated in a file which you can view
immediately or save.

Initiate Conversations using Enterprise
Collaboration
You can initiate Enterprise Collaboration (EC) conversations in the UCMDB Browser by clicking
button. When you click this button, Enterprise Collaboration opens on the right side of
the EC
the UCMDB Browser and you can initiate a conversation in the context of the selected CI, as well
as manage new posts and users in a conversation.

Properties Widget
The Properties widget is used to present the main, general properties of the selected CI, either by
means of a search result or by refocusing it. The properties presented are customized and differ for
each selected CI type. CI Overview mode presents the most important properties and Widget
Details mode displays additional properties. The information presented in this widget is logically
connected to the selected CI and not according to the UCMDB Data Model.
To specify the properties that are displayed by this widget, see "Configure Properties to be
Displayed by the Properties Widget" on page 68.
To display attributes with empty values (by default, attributes with empty values are not displayed),
see "Configure the Properties Widget to Show/Hide Empty Attributes" on page 77.
If the UCMDB administrator has configured a property as CMS Browser Editable an Edit button is
displayed. Click this Edit button to edit the attributes of these properties. When you are finished,
click Save changes or Cancel.

CI Overview Mode
In this mode, for all CI types, a maximum of three properties are displayed for the selected CI.
These properties are configured by the system administrator.
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Note: For details about the priorities that are displayed, see "Configure Properties to be
Displayed by the Properties Widget" on page 68.

Widget Details Mode
In this mode, each property is presented on a separate line. The display is divided into three panels,
as follows:
l

Core Properties. This panel displays the most important and valuable properties of the selected
CI. For example, for a node the displayed properties could include its OS name, serial number,
memory size, etc.

l

Complementary Properties. This panel displays other important properties for the selected CI.
These properties are usually less important than the ones presented in the Core properties
panel, but may still interest most UCMDB Browser users. All properties depicting the CI’s
discovery process are included in this panel.

l

Additional Properties. This panel is configured entirely by the UCMDB administrator, and can
include all other properties the Administrator thinks may interest UCMDB Browser’s users.
Attributes that are defined as CMS Browser Visible but do not appear in one of the other two
panels are also be displayed in this panel.

The panels are presented in consecutive order and labeled with the panel name. A panel with no
properties is not presented. The order in which the properties are presented within each panel is
alphabetic and cannot be configured. If a byte type attribute value does not fit entirely in the panel (it
is displayed truncated), the indicator "..." appears next to the displayed text and a Show All link
appears next to it. Clicking Show All displays the byte type attribute value entirely in a pop-up
window.
Note: For instructions on how to assign the panel in which an attribute is displayed, see
"Configure Properties to be Displayed by the Properties Widget" on page 68.

Environment Widget
The Environment widget presents the closest environment of the selected CI (as defined in by the
calculated links that are specified in the CI Type Manager in UCMDB). Details about CIs in the
environment can be displayed in either textual or graphical mode.
Starting with UCMDB versions 9.05 CUP 5 and 10.00 CUP 1, user preferences are saved in the
UCMDB server's user preferences. Otherwise, the user preferences are saved in the web
browser's cookies.

CI Overview Mode
A count of CIs contained in the selected CI's environment are displayed, divided by classification.
Only classifications containing more than one CI are displayed. Each classification includes the
name of the classification, its icon, and the number of CIs included in it. Clicking a particular
classification displays the widget details and filters the selected classification (in both Graphical
Mode and Textual Mode).

HP Universal CMDB Browser (3.1)

Page 97 of 147

Installation and Configuration Guide
Chapter 3: Search and Functionality

When you click the direct link icon, another web browser window opens, displaying UCMDB's
IT Universe Manager in the Get Related CIs module.

Widget Details Mode
Viewing the widget details does the following:
l

Replaces the data displayed in CI Overview mode.

l

Presents the detailed environment data in either textual or graphical mode, whichever was last
used. Graphical mode is the default view mode.
Note: If graphical mode does not display, it may be due to the fact that the drive of the
machine where the UCMDB server is installed is full. Free up some space on that drive in
order to view graphical mode.

n

Toolbar
The top row of the Environment widget acts as a toolbar and enables you to:
o

Switch between graphical and textual modes

o

Click a button (in graphical mode only) that opens or closes the CIs pane. The default
mode for the CIs pane is closed.
Note: You can also open the CIs pane by selecting a classification in the Topology
map.
The CIs pane details the CIs contained in the classification that is selected in the
Topology pane, dividing it into all relevant CI types.

n

Graphical mode
Note: When the UCMDB Browser is embedded in an UCMDB server running on a Linux
system, runlevel 5 (enabled X server) is needed for the graphical mode of the
Environment Widget to operate properly. In addition, add unset DISPLAY to the
server.sh script. Restart the UCMDB Server for the server.sh changes to take effect.
In graphical mode, information is displayed in a topology map format.
o

For each classification containing at least one CI, the name and number of CIs in that
classification is displayed. Clicking a classification displays all CIs contained in that
classification and matching the current filter. In addition, a thumbnail is displayed for each
CI type that contains more than a single CI.

o

Classification icons are displayed in layers according to the relative hierarchy of the CIs
as displayed in the topology map in UCMDB.
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Directional lines representing links are displayed with other items in the view if the selected
CI has a direct relationship with at least one other CI (either in the same classification or in a
different classification).
n

Textual mode
o

Left pane. The left pane displays an alphabetical list of all classifications containing at
least one CI. Each classification is broken down into a list of the CI types in that
classification that have at least one CI. Selecting any line in this pane displays its details
in the right pane.

o

Right pane. The right pane displays detailed information about the item that is selected in
the left pane, divided by CI type.

History Widget
Note: The History widget is supported on UCDMB 9.0x from UCMDB 9.05 CUP6 and later
versions, and on UCMDB 10.x from UCMDB 10.01 and later versions.
The History widget is used to compare details about the selected CIs between different points in
time. The comparison is based on the UCMDB History storage, and can present the following
information:
l

Changes in attribute values.

l

Changes in connectivity between the selected CI and related CIs (due either to addition or
deletion of links between CIs).

l

Creation of the CI in UCMDB.

The Selected tab displays historical changes for the selected CI only. The Model tab shows CIs
related to the selected CI that have historical changes. Clicking one of the related CIs displays
historical changes for that related CI.
Note:
l

Changes are compared between two points in time. Additional or multiple changes are
neither counted nor presented. For example, the value of an attribute that changes on date X
from value A to value B, and then on date Y from value B to value A, is not displayed as
changed.

l

Dates presented in the History widget are displayed in the format defined in the user's
default browser. Only changes after Jan. 1, 1970 are shown. If no changes were made on
the selected CI between the two comparison dates, the message “No data available for
History widget” is displayed.
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For all historical comparison purposes, the snapshot time taken into account is the time that
the CI was changed.

l

User preferences are saved per user according to the last user's selection:
l

The Compare mode (either Selected or Model mode, explained below)

l

The latest From and To dates for comparison

CI Overview Mode
This mode displays a graph summarizing the historical changes that occurred in the selected CI
(the default display option) or its model during the previous four weeks. The X axis lists five dates,
from four weeks ago to the current date. The Y axis shows the number of changes in a single day.

Widget Details Mode
The following information is displayed in the widget details mode:
l

Presents the Compare mode and the beginning and end dates used for comparison. The default
end date is the current date and time. The default beginning date is the current end date minus
the History Widget From Date setting that is set in UCMDB. The beginning date always starts
from 12:00 AM. For example, if the History Widget From Date setting is 5, and the current date
is Jan. 30, 2013, then the default beginning date is Jan. 25, 2013 at 12:00 AM. The default value
for the History Widget From Date setting is 7, but this value can be changed by the UCMDB
Administrator, as explained in "Change the History Widget 'From Date'" on page 85.

l

If the Compare mode in the last user’s filter is Selected, the History Comparison View for the
selected CI, according to the filter settings, is displayed.

l

If the Compare mode in the last user’s filter is Model, the Model view, with all classifications and
CI types according to the filter settings (either the last user selection or default values) is
displayed.
Note: Displaying Widget Details Mode clears the data displayed in the CI Overview mode.

The widget details are divided into the following sections:
l

Filter section
When the History widget is expanded, the Filter section is loaded with the latest user selections
(as saved in the user preferences, if any). If there is no latest user selection, the default values
are:
n

Compare mode – Selected

n

Last history comparison dates:
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o

From date – this date is calculated as follows: current date minus the History Widget
From Date setting that is set in UCMDB, starting from 12:00 AM.

o

To date – the current date

Each time a filter field is changed, its data is saved in the user preferences.
Use the following UI elements to configure the information displayed by the History widget:
n

n

The Compare mode tabs toggle between displaying the history comparison only on the
selected CI, or in the wider context of the model (explained above). When you toggle between
the two modes, the following changes occur:
o

If the value changes to Selected – the History Comparison view for the selected CI using
the current filter is displayed (regardless of the previous view).

o

If the value changes to Model – the Model view, with all classifications and CITs resulting
from the current filter (regardless of the previous view) is displayed.

The date pickers allow you to select From and To dates (defining the history comparison date
boundaries). Any valid date can be selected. When you select dates, the history comparison
is recalculated according to the new dates, resulted in the displayed view being refreshed
(either history comparison or CI selection).
Note: If the To date is earlier than the From date, an error message is displayed.

l

Model View
The Model view displays all CIs contained in the selected CI’s model that match the current filter
(that is, have at least one historical change during the selected time frame), divided by
classification and CI type. This area is only visible when the Compare mode is set to Model, and
it is divided into two panes:
n

Left pane
The left pane summarizes the number of CIs that match the current filter, divided into an
alphabetical list of classifications and CI types.
o

The first line (displaying the word All) shows the total number of CIs matching the current
filter. Clicking this line displays, in the right pane, all CIs contained in the selected CI’s
model and matching the current filter.

o

Groups are displayed in alphabetical order.

o

For each group with more than a single CI, the name and number of CIs in that group is
displayed. Clicking a group displays, in the right pane, all CIs contained in that group and
matching the current filter.
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n

o

Following each group's name, an alphabetical list of all CI types in that group (with more
than a single CI) is displayed. Clicking a CI type displays, in the right pane, all CIs of that
CI type and matching the current filter.

o

The icon, name, and number of CIs in that group are displayed for each CI type.

Right pane
The right pane displays the details of the data in left pane, divided into all relevant CI types
(listed in alphabetical order). For each CI type, the following details are displayed.
o

The name of the CI type and the number of CIs contained in it.

o

The list of CIs contained in the CI type, including the icon, name, and type for each CI.

In addition, hovering over a displayed CI shows the following:
o

The number of changes detected in the CI between the specified From and To dates.

o

The date of the last historical change.

o

A selection button. Clicking this button opens the History Comparison view for the
selected CI.

Ten CIs are displayed for each CI type. If there are more than ten CIs for a CI type, a link
appears, enabling you to view all of the CIs.
Clicking on a CI in this pane opens the History Comparison view for that CI.
If the number of CIs matching the current filter is 0, the first line of the widget displays All 0,
and the right pane is empty.
l

History Comparison View
The History Comparison view displays an alphabetical list of the changes in a specific CI
between two selected points in time. This view appears when:
n

The Compare mode is set to Selected – the selected CI is used for the historical comparison.

n

The Compare mode is set to Model and a CI is selected in the Model view – that CI is used for
the historical comparison. In this case, a Back button also appears. Clicking the Back button
switches back to the Model view.

In the upper left corner of the History Comparison view, the following information is displayed for
the CI used for comparison: CI icon, name, and CI type. Clicking on the CI name here takes you
to the CI Overview for the CI under comparison.
The History Comparison view has two sections: Changed Attributes and Changed Related CIs.
These sections are described in detail below.
Changed Attributes section
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In the Changed Attributes section two columns appear, displaying the values for the selected CI
on the From and To dates.
The date appearing in the header of the From column is the closest date to the current date from
among:
n

the filter's From date

n

the date that the CI was created

n

the earliest date that has history events for the selected CI

For each changed attribute, its name and the value it had on the From and To dates is displayed.
Clicking on a displayed attribute expands the row on which the information is displayed and
shows the date of the latest change and the user who caused that change. If the value of a byte
type attribute does not fit entirely in the panel (it is displayed truncated), the indicator "..."
appears next to the displayed text and a Show All link appears next to it. Clicking Show All
displays the byte type attribute value entirely in a pop-up window.
If no changes are detected during the selected time period, the message "There are no items to
display" appears.
Changed Related CIs section
The Changed Related CIs section displays an alphabetical list of all CIs that were either
attached to (linked to) or detached from the selected CI between the From and To dates. This
section appears when:
n

CIs that were linked to the selected CI on the From date are no longer linked on the To date.

n

CIs that were not linked to the selected CI on the From date, but are linked to it on the To
date.

The following information is displayed for each CI listed in this section:
n

CI icon

n

name

n

CI type

n

linkage state, which is either Related or Not Related

When clicking a CI in this section, it expands and shows the last update date. When expanded,
if you click the CI type, icon, or name; the CI Overview for that CI is displayed. Clicking
elsewhere reverts to the previous view where no update information is presented.
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Impact Simulation Widget
The Impact Simulation widget is used to present the impact analysis of a selected CI (that is, which
CIs are impacted by it, according to a selected impact severity level).
The following table displays the severity levels used in the UCMDB Browser and the comparable
severity levels in the UCMDB server:
UCMDB Browser UCMDB Server
Critical

Critical(9)

High

Major(8)

Medium

Minor(6)

Low

Warning(2)

Note: To view data in the Impact Simulation widget, there must be an impact rule created in
UCMDB and you must have View permission for the Resource Groups > Impact Analysis
resource.
This widget uses out-of-the-box impact rules from UCMDB. To configure the impact rules used by
this widget, see "Configure Impact Rules Used by the Impact Simulation widget" on page 83

CI Overview Mode
This mode summarizes the number of CIs impacted by the selected CI by means of an Impact Bar,
according to the four severity levels: Critical, Major, Minor and Normal.

Widget Details Mode
This mode presents detailed information on all the CIs impacted by the selected CI. There is a
toggle bar where the user can choose to display the impacted CIs according to the severity level.

Policy Widget
The Policy Widget is presented only if a live Configuration Manager (CM) system is deployed in the
UCMDB environment. The terminology and icons used in both the CI Overview and Widget Details
modes are identical to what is used in CM. All Key Performance Indicators (KPIs) and related
attributes are taken from CM (that is, no calculation is performed by the Browser).
Note: To use the Policy Widget, you must have CM version 9.30 or later installed, and CP10 or
later installed on the UCMDB server.

CI Overview Mode
This mode displays the selected CI's overall policy KPI, taken from CM, as follows:
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l

Overall policy compliance status: whether it is satisfied or in breach

l

Overall policy compliance value (in terms of percentage, graphically presented in a bar)

l

KPI description, automatically generated by the CM

For business elements, the CI overview presents the overall business policy KPI (that is, a
summary of all CIs linked to the Business CI, as opposed to the CI itself). A direct link to the CM
system, with the context of the selected CI, is presented in the widget.

Widget Details Mode
This mode adds the following details, taken from CM:
l

All policies linked to the selected CI. Each policy is separated from the others by an empty
space.

l

For each linked policy, the policy name, compliance status, and a description are displayed.

Change Request Widget
The Change Request widget presents the Change Requests related to the selected CI. CI
Overview mode displays the total number of Change Requests for each Change Request state.
Widget Details mode displays a list of all the Change Requests related to the CI and all their
details. The Change Request widget is presented only when HP Service Manager (SM)
configuration element in the UCMDB Browser XML configuration file is set (for UCMDB 9.04 CUP
5 and earlier versions) or is enabled and configured from the UCMDB user interface Infrastructure
Settings (for UCMDB 9.04 CUP 6 and later versions). All data presented is taken from the UCMDB
federated RequestForChange CI and its relationships.
A Change Request is considered related to a CI if it meets one of the following criteria:
l

All Change Requests linked directly to the CI.

l

If the selected CI is a Model: All Change Requests linked to all the CIs contained in that model
(meaning, any other contained model or CI).

l

If the selected CI is a Person: All Change Requests that are connected to all the CIs owned by
that person.

l

In all other cases: All Change Requests that are linked with a composition link to the selected CI
(for example: Running Software to Windows Server).

CI Overview Mode
In this mode, change requests related to the selected CI that have one of the following statuses are
presented:
l

Recent. All Change Requests that terminated in the recent time frame (default – 3 days, is
refreshed if the selected time frame is changed in the widget details).
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l

In Progress. All Change Requests that are currently in-progress. A Change Request is
considered In Progress if it is open, meaning that it's planned start date has passed and its
planned end date has not yet passed. Also, its phase must qualify as In Progress, meaning that
it is defined in the In Progress list in the XML configuration file.

l

Overdue. An overdue Change Request is a Change Request that was In Progress but whose
planned end-date has passed.

l

Planned. All Change Requests that are planned to start in the recent time frame (default – 3
days, is refreshed if the selected time frame is changed in the widget details.

l

Delayed. A Change Request is Delayed if it was a Planned Change Request but its planned
start-date has passed.

The UCMDB administrator can define which IT SM RFC Phase is mapped to each one of the
Change Request statuses Recent, In Progress, and Planned (the Overdue and Delayed statuses
are automatically calculated by the UCMDB Browser). The UCMDB Browser is configured by
default in the following manner:
UCMDB Status IT SM RFC Phase
Recent

Evaluation, Closure

In Progress

Implementation

Planned

Approval

If a Change Request’s phase does not exist in the configuration list it is ignored, meaning that it is
not be included in the Change Request summary or detailed list.
If a Change Request’s planned start date or end date are not defined, the UCMDB Browser uses
the current date for both planned start/end dates (in both the CI Overview and Widget Details
modes).

Widget Details Mode
This mode adds the following to the summary displayed in the CI overview:
l

Timeline Span toggle: +/-3 days , +/-1 week, +/-1 month. Selecting a timeline span details all
Change Requests related to the selected CI hat are contained within the selected timeline (that
is, either their start date or due date are within that timeline). Note that changing the timeline
should change the summary displayed in the CI overview.

l

Show toggle: All/Late. Selecting All details all Change Requests related to the CI in the
selected timeline, selecting Late presents only those Change Requests that are either overdue
or delayed (as explained above).

l

All relevant Change Requests, sorted by their status (Recent, In Progress, Overdue,
Planned, and Delayed). The internal sort within each status group is according to Change
Request phase and then planned start date.

The following information is provided per each Change Request:
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l

ID. This is a clickable field that refocuses on the RequestForChange CI when selected

l

Phase

l

Planned Start Date. Is emphasized if the Change Request is Delayed.

l

Planned End Date. Is emphasized if Change Request is Overdue.

l

Affected CIs. Up to 10 CIs within the context of the selected CI are presented, with a link to
show all results in the event that there are more than 10 affected CIs within the context of the
selected CI linked to the Change Request. Affected CIs can be refocused.

l

Affected Service. The first BusinessService CI, within the context of the selected CI,
connected to the Change Request CI through a membership link. If no such CI exists, the
Affected Service header is not displayed. The Affected Service can be refocused.

l

Severity

l

A direct link to the Service Manager system with the context of the selected change request is
presented per each change request, if this link is configured by the system administrator. For
instructions on how to configure this direct link to Service Manager, see "Configure a Direct Link
to Service Manager for a Selected Problem, Incident, or Change Request" on page 139.

Incidents Widget
The Incidents widget presents the incidents related to the selected CI. CI Overview mode shows
the number of incidents per priority, where the priority groups are Urgent, Major, Minor, and None.
Widget Details mode displays incident details. The Incidents Widget is presented only when the
Incidents setting element in the UCMDB Browser XML configuration file is set (for UCMDB server
9.04 CUP 5 and earlier) or is enabled and configured from the Infrastructure Settings Manager in
UCMDB (for UCMDB server 9.04 CUP 6 and later). All data presented is taken from the UCMDB
federated Incidents CI and its relationships.
This widget displays incidents related to the selected CI as follows:
l

All incidents linked directly to the CI through a Connection link.

l

If the selected CI is a Model. All incidents linked to all the CIs contained in that model
(meaning, any other contained model or CI).

l

All incidents linked to CIs that are connected to the currently selected CI through a composition
or membership relationship.

l

For BusinessService CIs. All incidents linked directly to the CI through an applicationLink
link.

If an incident’s priority does not map to a UCMDB Browser’s Internal Priority, it should not be
counted in CI Overview mode nor presented in Widget Details mode. For instructions on how to
configure the UCMDB Browser's Internal Priorities, see "Configure Browser Internal Priorities (for
the Incidents and Problems Widgets)" on page 34.
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CI Overview Mode
This mode presents the number of open incidents from SM that have an Open Date within the
Timeline Span selected in the Widget Details mode (see the description below). The incidents are
categorized by their Internal Priority, where:
l

Open incidents are all incidents whose status (an IT SM attribute, federated to UCMDB) is
within a configured range of values defined by two configuration parameters. If an incident status
does not belong to that set of values, it is not considered open.

l

Internal Priority is a UCMDB Browser set of values (1-4), where each value has a configurable
label and is mapped to a set of IT SM Priority values (an SM attribute, federated to UCMDB). For
instance, a valid configuration could be of four Internal Priorities (Urgent, Major, Minor, None),
where each is mapped to a specific unique set of IT SM Priority values.

l

Both configuration parameters are defined only by the UCMDB administrator.

Widget Details Mode
This mode adds the following information to the summary displayed in CI overview mode:
l

Timeline Span toggle. This is a 3-way toggle, with the options Less than a day, Between 1
to 3 days, and More than 3 days. Selecting a timeline span displays all open incidents related
to the selected CI that are in the timeline span (that is, their Open Date is within that timeline
span). Changing the timeline span also changes the incident groups displayed in CI Overview
mode. The default timeline span in Widget Details mode is Less than a day, unless there are no
incidents in that span, in which case Between 1 to 3 days is displayed.

l

All relevant incidents, divided by their Internal Priority. The internal sort within each priority group
is according to the incident’s Open Date. The following items are provided per each incident:
n

Incident ID. This is a clickable field that refocuses on the Incident CI when selected.

n

Status

n

Impact

n

Urgency

n

Priority

n

Open Date

n

Title

n

Outage Start (this is an optional SM parameter)

n

Affected CI. Only a single CI is presented with a link to display all results. The CI presented
is either the node to which the incident is linked (if it is not the current CI) or a Business CI
affected by the incident (if the current CI is directly linked to the Incident CI). If there is a
Business Service connected directly to the incident, it should be displayed as an affected CI.
Affected CIs can be refocused.
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Note: The affected CI is displayed only if it is within the context of the selected CI.

n

Affected Service. The first BusinessService CI connected to the Incident CI through a
membership link. If no such CI exists, the Affected Service header will not be displayed.
Affected Service can be refocused.

l

A direct link to the Service Manager system with the context of the selected incident is
presented per each incident, if this link is configured. For instructions on how to configure this
direct link to Service Manager, see "Configure a Direct Link to Service Manager for a Selected
Problem, Incident, or Change Request" on page 139.

l

Each incident is separated from the others by empty space.

Problems Widget
The Problems widget presents the problems related to the selected CI, either according to their
numbers (in CI Overview mode) or by their details (in Widget Details mode). A problem is
considered related to a CI if it meets one of the following conditions:
l

It is linked directly to the CI through a Membership link. Note that IT Service Manager connects
a Problem to its affected Business Service in the same manner (that is, a Membership link
connects the Problem CI with the Business Service CI).

l

If the selected CI is a Model, all problems linked to all the contained CIs in that model (meaning,
any other contained model or CI) are considered related to the selected CI.

l

In all other case, all problems linked to the selected CI's composition/membership connected
CIs (probably a Node) are considered related to the selected CI.
Note:
l

This widget appears only when it is enabled in UCMDB (for UCMDB 9.04 CUP 6 and later
versions) or in the UCMDB Browser configuration file (for UCMDB 9.04 CUP 5 and earlier
versions). For instructions on how enable this widget, see "Enable the Problems Widget" on
page 111.

l

If you are connecting to a UCMDB Server that has Content Pack 10 or an older version
installed, you must perform the instructions in the section "Configure the Problems Widget
to Work with Content Pack 10 or Earlier Versions" on page 111 below so that the Problems
widget functions properly.

All presented data is taken from UCMDB Federated Problems CI (and its relationships).

CI Overview Mode
This mode presents the total number of Open problems, categorized by their Internal Priority. Open
problems are all problems with a Status (a Service Manager attribute, federated to UCMDB) that is

HP Universal CMDB Browser (3.1)

Page 109 of 147

Installation and Configuration Guide
Chapter 3: Search and Functionality

within a configured set of values. If a problem’s Status does not belong to that set of values, it is not
considered open.
Internal Priorities are a set of UCMDB Browser values (1-4), where each value has a configurable
label and is mapped to a set of Service Manager Priorities (these are Service Manager attributes
that are federated to UCMDB). For instance, a valid configuration could be four Internal Priorities
(Urgent, Major, Minor, None), where each is mapped to a specific unique set of Service Manager
Priority values.
Configuring the set of values to define when a Problem is open and configuring the four UCMDB
Browser Internal Priorities should be performed only by the UCMDB administrator.
The UCMDB Browser’s mapping between Internal Priorities and Service Manager priorities should
be defined once and be used by all relevant Widgets (that is, the same configuration settings are
used for both the Incidents and Problems Widgets). If a Problem’s priority does not map to a
UCMDB Browser Internal Priority, it is not counted in the CI overview or presented in the widget
details.
For instructions on how to configure the UCMDB Browser Internal Priorities, see "Configure
Browser Internal Priorities (for the Incidents and Problems Widgets)" on page 34.

Widget Details Mode
This mode displays all relevant problems according to their Internal Priority. The internal sort within
each priority group is by alphabetic order. The following information is presented for each problem:
l

Problem ID: This is a clickable field that refocuses on the Problem CI when selected. The ID is
taken from the reference_number attribute.

l

Title: Taken from the name attribute.

l

Status: Taken from the problem_status attribute.

l

Impact: Taken from the impact_scope attribute.

l

Urgency: Taken from the urgency attribute.

l

Priority: Taken from the priority attribute.

l

Affected CI: Only a single CI is presented with a link to show all results. The CI presented is
either the node to which the problem is linked (if it is not the current CI) or a Business CI affected
by the problem (if the current CI is directly linked to the Problem CI). If there is a Business
Service connected directly to the Problem, it should be displayed as an affected CI. Affected
CIs can be refocused.

l

Affected Service: The first BusinessService CI connected to the Problem CI through a
membership link. If no such CI exists, the Affected Service header is not displayed. The
Affected Service can be refocused.

l

A direct link to the Service Manager system with the context of the selected problem is
presented per each problem, if this link is configured. For instructions on how to configure this
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direct link to Service Manager, see "Configure a Direct Link to Service Manager for a Selected
Problem, Incident, or Change Request" on page 139.

Enable the Problems Widget
To enable the Problems widget in UCMDB (for UCMDB 9.04 CUP 6 and later versions):
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. In the Name column, choose Enable Problems widget.
3. In the Q:\UCMDB_daily_build\UCMDB_Browser\Ver_3.0\UCMDB_Browser_Online_
Help\UCMDB_Browser_Online_Help.htm column, choose True from the drop-down list.
4. Click Save

.

To enable the Problems widget in the UCMDB Browser configuration file (for UCMDB 9.04
CUP 5 and earlier versions):
1. In the UCMDB Browser configuration file, remove the comments from the <problem_widget_
configuration> section.
2. If the <incident_widget_configuration> section is commented out, remove the comments.

Configure the Problems Widget to Work with Content Pack 10 or Earlier
Versions
To configure the Problems widget to work with Content Pack 10 or older versions:
1. In UCMDB, go to Modeling > CI Type Manager.
2. From the menu bar, choose CI Types > System Type Manager.
3. In the System Type Manager dialog box, select ProblemStatus and click the Edit

button.

4. In the Update List Definition dialog box that appears, in the Values section click the Add
button and add a new value called closed.
5. Click OK in the Update List Definition dialog box and then Apply in the System Type Manager
dialog box.

Monitoring Widget
The Monitoring widget displays the statuses of KPIs (received from the BSM) for the selected CI.
KPI statuses can be one of the following: Ok, warning, minor, major, critical, info, no data, and
downtime.
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CI Overview mode displays the worst KPI status for the selected CI (where downtime is the worst
status, and Ok is the best status). Widget Details mode shows all the details of all KPIs related to
the selected CI.
The UCMDB Browser comes with a BSM adapter that is deployed on the UCMDB server when the
Browser first loads. For this widget to work, the UCMDB administrator must configure this adapter,
as described in "Configure the BSM Health Indicator (for the Monitoring Widget)" on page 129.
Note:
l

System time on the UCMDB server and BSM server should be synchronized, otherwise
monitoring data in the UCMDB Browser will be empty.

l

The BSM does not return KPIs for CI collections.

l

For the Monitoring Widget to properly display KPI statuses for the selected CI, ensure that
all CIs monitored in the BSM have the attribute Store KPI History For Over Time=true.

Adding Another Data Source for Display in the Monitoring Widget
If you want to add another data source to be displayed in the Monitoring widget, you must add an
additional integration point name to the <data_stores> tag in the ucmdb_browser_config.xml
configuration file, as shown in the following example:
<bsm_configuration>
<data_stores>
<data_store>bsm_adapter</data_store>
<data_store>second_adapter</data_store>
</data_stores>
</bsm_configuration>

Conversations Widget
The Conversations widget displays Enterprise Collaboration (EC) conversations containing the
display labels of the selected CI and the CIs in the relevant environment surrounding the selected
CI. For example, if the selected CI has a display label vmnode123, and that node is connected to
another CI with the display label tomcat_server, the widget displays all EC conversations that
contain either both terms, or at least one of them. For the conversation to be displayed, it is enough
for the search term to appear in the conversation's subject, body (that is, conversation posts), or in
its attached facets.
Note: The Conversations Widget is available only when working with EC version 1.01.
For the Conversations widget to appear in the UCMDB Browser, this widget must be enabled as
follows:
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l

For UCMDB Server 9.04 CUP 5 and earlier versions: In the Browser configuration file, set
<conversation_widget_enabled>true</conversation_widget_enabled>

l

For UCMDB Server 9.04 CUP 6 and later versions: In UCMDB, go to Administration >
Infrastructure Settings > UCMDB Browser Settings,and set Enable the Conversations
widget=True.

Also, to use the Conversations Widget, you must first configure the UCMDB to use the EC
Adapter, as described in "Configure the Enterprise Collaboration Adapter (for the Conversations
Widget)" on page 127. This adapter is then deployed on the UCMDB Server when the Browser first
loads.
Refine Search
The Conversations widget has an internal Refine Search feature that allows you to add another
term to the initial search. For example, if the initial search term was alNode1 and this CI is
connected to the running software tomcat_web_server, the initial search is performed on the string
alNode1;tomcat_web_server. That is, the CI Search Engine looks for conversations that contain
both terms, then for conversations with only one term. Using the Refine Search feature, you can
add the term offline, and a new search is performed on the string alNode1;tomcat_web_
server;offline.
Filters
The Conversations widget has two filter options that allow filtering the displayed EC conversations.
The first filter option allows filtering conversations according to where the search term is located in
the conversation. The options are Everything, In Body, In Subject, and Attached Facets. The
second filter option allows filtering conversations according to how recently the conversation was
last edited. The options for this filter are Anytime, Past day, Past week, and Past month.
Limitation
When performing a search, text phrases with ':' should not be entered. If such phrases are entered,
they are omitted.

CI Overview Mode
In this mode, a summary of how many conversations were found is displayed, grouped by where
the search term was found in the conversation. For example, if the search term was found in the
subject of 5 conversations and in the body of 6 conversations, the CI overview displays "In Subject
(5)" and "In Body (6)".
Note: A conversation can show up in more than one category. Therefore, it is possible that the
total sum of all the conversations in each group displayed in the CI overview is greater than the
actual number of conversations found for the selected CI.

Widget Details Mode
In this mode, for each conversation, the widget displays:
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l

The subject of the conversation

l

The fragments of text in which the search terms were found (highlighted)

l

The name of the conversation participants

l

The last modified date

Stakeholder Widget
The Stakeholder widget displays data on the owner of the selected CI and also on owner(s) of CIs
directly related to the selected CI. A stakeholder is defined as either the owner of the selected CI or
the owner of a CI directly related to the selected CI.
Note: If the type of the selected CI is Person, this widget is collapsed, disabled, and displays
the following message: “This widget is not relevant for selected CI”.

CI Overview Mode
In this mode, if there is more than one owner for the selected CI this widget displays the total
number of owners (called Direct Stakeholders in the user interface) If there are one or more owners
of CIs directly related to the selected CI, this widget displays the total number of owners of those
directly related CIs (called Other Stakeholders in the user interface). If the selected CI has no direct
owner, the message “There is no direct stakeholder” is displayed in the center of widget.
This widget also displays the following information on the owner of the selected CI:
l

Thumbnail picture (if it exists)

l

Name

l

Organization or Functional Group (if defined)

l

Email address (if defined)

l

Telephone number(s) (if defined). If there is more than one phone number for the owner, there is
a button that expands the list of available phone numbers and indicates the type of phone of the
owner.
Note:
l

The owner can have one of the following CI types:Organization, Functional Group, or
Person. If there are two or more direct owners of the selected CI, this widget displays the
owner in CI Overview mode according to the following priority levels: Organization (highest
priority), Functional Group, Person (lowest priority).
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If , according to the priority levels above, there are two or more direct owners with the same
priority level to be displayed, this widget displays the owner that comes first according to
alphabetical order.
l

For the Person CI Type, this widget displays the Person's name according to the following
priority levels: user label (highest priority), name, name of type (lowest priority).
Only if the user label does no exist, will the widget display the Person's name. And only if
the user label and name do not exist, will the widget display the name of type.

Widget Details Mode
This mode displays the same information that is listed in CI Overview mode, but for every
stakeholder of the selected CI,and also displays all CIs owned by the stakeholder, within the
context of the selected CI.
Note: The default source of the thumbnail pictures is the gravatar.com web site; however, this
source can be changed as described in "Change the Source of Thumbnails (for the Stakeholder
Widget)" on page 84.

Automation Widget
Note: The Automation widget is supported on UCMDB 9.05 CUP 1 and later versions.
The Automation widget allows the user to execute Operations Orchestration (OO) flows on the
selected CI and the CIs that are in the selected CI’s environment. These flows are run according to
the user's permissions in OO. This widget displays all the available OO flows that can be run on the
selected CI and CIs within the CI’s environment, and displays a history of the available flows that
have actually been run on those CIs.
For the Automation Widget to appear in the UCMDB Browser, this widget must be enabled in
UCMDB by going to Administration > Infrastructure Settings > UCMDB Browser Settings,
and setting Enable the Automation widget=True.
The UCMDB Browser comes with an Automation Flow adapter that is deployed on the UCMDB
server when the Browser first loads. For this widget to work, the UCMDB administrator must
configure this adapter, as described in "Configure the Automation Flow Adapter (for the Automation
Widget)" on page 130. The UCMDB Browser also deploys several out-of-the-box automation flows
that can be used immediately after the Browser connects to the UCMDB server, and can be used
as examples for constructing other automation flows.
To select and define Automation Flows in UCMDB, see "Select and Define Automation Flows (for
the Automation Widget)" on page 131

CI Overview Mode
This mode displays the total number of available flows that can be run on the selected CI and CIs in
its environment (called Available Flows), and the number of times that any of the available flows
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have been executed on the selected CI or on CIs in its environment (called Execution History).

Widget Details Mode
This mode is split into the following sections:
Available Flows. This section displays the flows that can be run on the selected CI and CIs in
its environment. From here you can:

l

n

Select an Automation Flow

n

Select the CIs on which to run the flow

n

Configure the flow's input parameters

n

See a summary of the configuration before running it

n

Run the configured flow

n

See on which CIs the flow was executed, and on which CIs it was not

Running the Automation Flow is possible only when all mandatory input parameters have input
values.
Execution History. This section displays the actual flows from the Available Flows section that
have been run on the selected CI and CIs in its environment. It displays the status of each run,
the date when the flow was run, and on which CI it was run on.

l

For all flows with the status Canceled, Ended, Finished, or Unknown, the user can re-run the
flow using the menu on the right side of the Automation Flow history record. Each execution has
a Response Report that opens the OO report related to the specific execution. This OO report
can also be opened from the menu on the right side of the Automation Flow history record.

Security Widget
The Security widget displays security-related data for the selected CI. This widget appears only if a
live ArcSight Enterprise View (EV) system is deployed with a valid integration between it and the
logged-in UCMDB.
Note:
l

For this widget to work, the UCMDB administrator must configure the Enterprise View
adapter, as described in "Configure the Enterprise View Adapter" on page 135.

l

For instructions on integrating Enterprise View with UCMDB, see "Configure Integration
with Enterprise View" on page 132.

CI Overview Mode
In this mode, the following security-related data is presented for the selected CI (taken directly from
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ArcSight EV and not processed by the UCMDB Browser):
l

Overall security score (from 0-100, 0 is the best, 100 is the worst)

l

Overall security status icon (uses the same icons as within ArcSight Enterprise Security
Manager). The possible icon values are:

l

n

High

n

Medium

n

Low risk

n

No data

A direct link to the ArcSight EV system asset summary

Widget Details Mode
In this mode, the following information is added to the summary displayed in CI Overview mode
(taken from the ArcSight EV and not processed by the UCMDB Browser):
l

l

l

l

Risk:
n

Score: from 0-100, 0 is the best, 100 is the worst

n

Icon: Possible icon values are High, Medium, Low risk, and No data

Compliance:
n

Score: from 0-100, 0 is the best, 100 is the worst

n

Icon: possible icon values are High, Medium, Low risk, and No data

n

Progress: shows the percentage of overall asset compliance with a policy

Maturity:
n

Score: from 0-5, 0 is the worst, 5 is the best

n

Icon: possible icon values are High, Medium, Low risk, and No data

n

Progress: shows the percentage of the overall control maturity within a policy

Vulnerability:
n

Score: from 0.00-10.00, 0.00 is the best, 10.00 is the worst

n

Icon: possible icon values are High, Medium, Low risk, and No data
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l

Enterprise Security Manager Threat:
n

Score: from 0.00-10.00, 0.00 is the best, 10.00 is the worst

n

Icon: possible icon values are High, Medium, Low risk, and No data

Defects Widget
The Defects widget presents the defects opened on all ALM projects that are linked (directly or
indirectly) to the selected business element CI. In CI Overview mode, defects are displayed
according to the defect number; in Widget Details mode, defect details are displayed, as described
below.
A business element CI can be linked directly to one or more ALM project(s), using ALM filters (). A
business element CI can also be linked indirectly to ALM projects, through its descendants (it is
connected to another business element CI which is linked directly to one ALM project or more).
This widget is displayed only if it has been properly configured in UCMDB. For details on this
configuration, see "Integrate with ALM (for the Defects Widget)" on page 135.
This widget and the Defects adapter use the Defects CI type (part of UDM) for federating data from
ALM and using it in the widget.

CI Overview Mode
The total number of Open defects in all projects linked to the selected CI are displayed, according to
severity level. The severity levels are Low, Medium, High, Very High, and Urgent.

Widget Details Mode
The following information on defects related to the selected CI is displayed:
Left pane:
The following filters are used to filter the defects displayed in the widget's right pane:
l

Refine field. Enter a value here to filter the displayed defects to only those defects that contain
this value in one of the attributes configured for search refinement. For example, if 12 is typed,
all defects that contain “12” in at least one of the configured attributes remain visible, the others
are hidden. This is a cross filter with the other two filters (Severity and First-level, described
below).
Configure attributes for the Refine search as follows:
<search_refining_attribute_names>DefectReferenceNumber,DefectSummary
</search_refining_attribute_names>

This is a comma-separated list, and the attributes listed here must belong to the Defect CI type.
An attribute that does not belong to the Defect CI type is ignored.
An "X" button appears to the right of the field, which allows clearing the entered text.
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l

Severity. This is a toggle between available severity levels You can filter defects according to
severity level. For example, you can choose to display only defects with Urgent severity level.
The default is All Severities, meaning that it displays defects of all severity levels. The number
of defects for each severity level is displayed.

l

First level filtering. Since the resulting number of related defects can be high, it is possible to
filter them according to one of the following:
n

If more than a single ALM Project is defined (either directly or indirectly), you can filter defects
according to a specific project. The number of defects per ALM project is displayed. With this
type of filtering, it is only possible to see defects of a specific ALM project. There is no option
to see all defects of all ALM projects in a single view.

n

If a single ALM project is defined, first level filtering is determined is determined by the
system administrator.

Right pane:
All relevant defects, filtered by the search string, severity level, and first-level filtering are
presented. Since all displayed defects belong to a single ALM project, the defect details presented
are configurable. Each defect can be presented in a collapsed or expanded mode; collapsed is the
default.
In collapsed mode, the following information is displayed:
l

Defect ID

l

Summary: The summary data is truncated to fit the two line column size.

l

Severity (configurable, see above)

l

Release: By default, sorting is done using the Severity field on a downward order. It is possible
to sort defects according to any of the above fields, either upward or downward, using the arrows
that appear on each field's label.

Sorting is done by default using the Severity field in descending order. Sorting defects by any field,
either ascending or descending, is done using the arrows displayed on each field's label.
Expanding a Defect
The following information is added to the data presented in the collapsed mode when expanding the
defect:
l

Full summary information

l

All defect-related properties that the UCMDB administrator configured to be displayed per ALM
project.

All properties are textual, and are presented in two columns.
Defect Description in Widget Details Mode
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The defect description setting configures which attribute of the Defect CIT is displayed in
Expanded mode. The default setting is DefectSummary, as shown below:
<description_attribute_name>DefectSummary</description_attribute_name>

The setting here must be an attribute of the Defect CI Type. If it is not, DefectSummary is used by
default.

Severity Mapping
From the UCMDB Browser settings, it is possible to configure the list of values of the
DefectSeverity attribute that are mapped to severity levels in the UCMDB Browser.
For each Severity, the mapping can be configured from the UCMDB Browser settings as follows:
<severity_urgent_values>5:Urgent</severity_urgent_values>
<severity_very_high_values>4:Very High</severity_very_high_values>
<severity_high_values>3:High</severity_high_values>
<severity_medium_values>2:Medium</severity_medium_values>
<severity_low_values>1:Low</severity_low_values>

If the DefectSeverity of the Defect CI type has the value: “2:Medium”, it is mapped as Medium in
the UCMDB Browser. It is also possible to have a comma-separated list of values here.
Note: For UCMDB 9.05 CUP 1 and later versions, the severity displayed in the UCMDB
Browser can be modified through UCMDB. Go to Administration > Infrastructure Settings
Manager > UCMDB Browser Settings.

Dynamic Widgets
Note: Dynamic widgets are supported on UCMDB 10.10 and later versions.
Dynamic widgets are widgets that display data about a particular view. You create dynamic
widgets in the Modeling Studio in UCMDB.
Note:
l

After you create a dynamic widget in UCMDB, you must log out of the UCMDB Browser
and then log in again to see the newly created widget.

l

Only one level of grouping is supported.

l

If no grouping option has been specified in the hierarchy tree, all CI attributes appear in a
single screen.

CI Overview Mode
On the Widget tab of the dynamic widget configuration, you must set an attribute to True in the
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Overview column for it to be displayed in CI Overview mode.
The CI Overview mode displays up to six individual properties (six random properties from all nodes
specified in the dynamic widget).

Widget Details Mode
On the Widget tab of the dynamic widget configuration, you must set an attribute to True in the
Details column for it to be displayed in Widget Details mode.
Properties in Widget Details mode are displayed in different ways, depending on the dynamic
widget's configuration:
l

If no grouping classifications have been specified in the hierarchy tree of the dynamic widget's
configuration, all attributes that are defined as True for being shown in Widget Details mode are
displayed in a list.

l

If grouping classifications have been specified, in the first level of this mode CIs are displayed
by group (as specified in the hierarchy tree) and show a maximum of two random attributes that
are defined as True for being shown in CI Overview mode. Selecting one of the CIs shows all of
the attributes for that CI that are defined as True for being shown in Widget Details mode,
grouped by the group name for that attribute that was specified in the widget's configuration.

Create a dynamic widget
1. In UCMDB, go to Modeling > Modeling Studio.
Note: To create a dynamic widget, you must have Create Dynamic Widget permission
assigned in the Roles Manager in UCMDB.

2. Click New
and from the drop-down menu select Dynamic Widget. In the New Dynamic
Widget dialog, select the base TQL query on which your new dynamic widget is based, or
select Create new query to build a new TQL query.
a. In the View tab, add the query nodes and relationships that define the query.
Specify whether to use a manual (default) or rule-based hierarchy when defining the TQL
query.
Note: If you are starting with a blank widget, you must add at least one query node in
order to save your widget.
b. In the Report tab, select a node in the Hierarchy pane, and choose the attributes for that
node that you want to appear in the widget.
c. In the Widget tab, select a node and set values for that node's attributes:
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UI Element

Description

Overview

Boolean. Specifies whether this attribute appears in the CI Overview
mode.

Details

Boolean. Specifies whether this attribute appears in the Widget Details
mode.

Refocusable Boolean. Causes the attribute to appear as a hyperlink, which will refocus
to the CI on which it is defined.
Group Name String. Specifies the name of the section under which the attribute will be
grouped in the Widget Details mode.
o

Select the Show path check box to cause the UCMDB Browser to display the route in
the dynamic widget from a specific node in the view definition to all the node's children.

o

Select the Enforce Browser CI access control check box to ensure that the dynamic
widget displays data only according to the permissions that were specified in UCMDB
(on the Browser CI Access Control tab in the Roles manager). If the check box is not
selected, the dynamic widget will display all data, without permission enforcement.

o

Select an initial display mode for the dynamic widget.
o

Properties Mode. Displays individual properties for CIs.
Note: If you do not select a Widget Type value, Properties Mode is enabled by
default.

o

Topology Map Mode. Displays CIs according to your current topology.

o

Topology CIT Group Mode. Displays CIs grouped by CI type according to your
current model.

o

Topology Textual Mode. Displays a list of CIs broken down by CI type.

The topology mode that you select is the initial view selection until you change to
another one in the UCMDB Browser.
3. When you are finished, click Save

.

For additional details, see "Modeling Studio" in the HP Universal CMDB Modeling Guide.

Business Widget
Note: The Business widget is supported on UCMDB 10.10 and later versions.
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The Business widget is based on a dynamic widget and can be configured according to dynamic
widget capabilities. For more information, see "Dynamic Widgets" on page 120. The widget
provides additional modes for displaying the business topology of a CI. It looks for containment and
dependency relationships between a business element and other CIs.
Note: You should only specify the report layout in the dynamic widget definition if the Widget
Type is set to Properties. Otherwise, your specified layout is disregarded.

CI Overview Mode
A count of CIs contained in the current CI's environment are displayed, divided by classification.
Only classifications containing at least one CI are displayed. Each classification includes the name
of the classification, its icon, and the number of CIs included in it. Clicking a particular classification
displays the widget details and filters the selected classification (in both Topology Group CIT mode
and Textual mode).

Widget Details Mode
Viewing the widget details does the following:
l

Replaces the data displayed in CI Overview mode.

l

Presents the detailed environment data in Map mode, CIT Group mode, or Textual mode,
whichever was last used. The default mode is the Widget Type value that is selected during
creation of the dynamic widget in UCMDB.
Note: If graphical mode does not display, it may be due to the fact that the drive of the
machine where the UCMDB server is installed is full. Free up some space on that drive in
order to view graphical mode.

n

Toolbar
The top row of the Business widget acts as a toolbar and enables you to:
o

Switch between the different presentation modes

o

Click a button (in graphical mode only) that opens or closes the CIs pane. The default
mode for the CIs pane is opened.
The CIs pane details the CIs contained in the classification that is selected in the CIT
Group pane, dividing it into all relevant CI types.

n

Map mode
Note: When the UCMDB Browser is embedded in a UCMDB server running on a Linux
system, runlevel 5 (enabled X server) is needed for the graphical mode of the Dynamic
widget to operate properly. In addition, add unset DISPLAY to the server.sh script.
Restart the UCMDB Server for the server.sh changes to take effect.
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o

Classification icons are displayed in layers according to relationships in the topology and
not according to the actual hierarchy.

o

When you select a CI, a refocus
link appears in the corner of the selected node.
Clicking this link causes the UCMDB Browser to refocus on that node.

Directional lines representing links are displayed with other items in the view if the selected
CI has a direct relationship with at least one other CI (either in the same classification or in a
different classification).
n

CIT Group mode
o

For each classification containing at least one CI, the name and number of CIs in that
classification is displayed. Clicking a classification displays all CIs contained in that
classification and matching the current filter. In addition, a thumbnail is displayed for each
CI type that contains at least a single CI.

o

Classification icons are displayed in layers according to the relative hierarchy of the CIs
as displayed in the topology map in UCMDB.

Directional lines representing links are displayed with other items in the view if the selected
CI has a direct relationship with at least one other CI (either in the same classification or in a
different classification).
n

Textual mode
o

Left pane. The left pane displays an alphabetical list of all classifications containing at
least one CI. Each classification is broken down into a list of the CI types in that
classification that have at least one CI. Selecting any line in this pane displays its details
in the right pane.

o

Right pane. The right pane displays detailed information about the item that is selected in
the left pane, divided by CI type.
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Load Embeddable Widgets
The embeddable widgets feature allows loading only a single widget instead of the entire UCMDB
Browser. This enables other products to include widgets inside their own applications.
Developers should be aware of two limitations:
There is no login window. If using LW-SSO, the user enters the URL of the UCMDB Browser
and adds to that URL certain parameters that tell the UCMDB Browser which widget to show,
how to show it, and which CI to show for that widget. The Embedded widget checks the LWSSO cookie to verify that the current user is logged on. If there is no valid session, an error
message is displayed.

l

If not using LW-SSO, the user enters the URL of the UCMDB Browser and certain parameters
as mentioned above, and adds to that a username and password. This method is not
recommended since it exposes user credentials.
n

There is no search UI, only a single widget. This means that when loading the widget, the
user must know and set the CI ID.
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To load an embeddable widget:
For LW-SSO users, you load an embeddable widget by entering the base URL and other
information as follows:
http://<UCMDB Browser host>:< UCMDB Browser port>/ucmdb-browser/ucmdb_
widget.html#widget=<widget type>;refocus-selection=<CI ID>
This URL can be divided into the following parts:
l

Base URL: This is the URL of the UCMDB Browser. For example:
http://<UCMDB Browser host>:< UCMDB Browser port>/ucmdb-browser/

l

Widget Entry Point: This is a static value, will always be:
ucmdb_widget.html#

l

Widget type: This must be one of the possible widget types: PROPERTIES, ENVIRONMENT,
HISTORY, IMPACT, POLICY, RFC, INCIDENTS, PROBLEMS, BSM, STAKEHOLDER,
CONVERSATIONS, AUTOMATION, SECURITY, or DEFECTS.

l

CI ID: The ID for the CI whose data will be displayed by the widget. For example, 123456789.

Therefore, to load a widget with the examples given above, using LW-SSO, you would enter a
URL of:
http://<UCMDB Browser host>:< UCMDB Browser port>/ucmdb-browser/ucmdb_
widget.html#widget=environment;refocus-selection=123456789
And if not using LW-SSO, using the above example:
http://<UCMDB Browser host>:< UCMDB Browser port>/ucmdb-browser/ucmdb_
widget.html#widget=environment;refocus-selection=123456789;username=guest;
password=765432
Once logged on, the user sees the CI Overview and Widget Details modes of the widget and CI
specified in the URL. Widget Details mode cannot be collapsed.

Configure Integration with Enterprise
Collaboration
HP Enterprise Collaboration (EC) is a collaboration platform that enhances and facilitates the
collaboration that takes place in almost any flow in the IT organization using HP products. It does
this by connecting the structured data managed in various applications in the IT workspace with the
unstructured collaboration that supports it.
There are two procedures for configuring integration of the UCMDB Browser with Enterprise
Collaboration, depending on the version of UCMDB.
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For UCMDB server 9.04 CUP 5 and earlier versions:
1. Open the ucmdb_browser_config.xml file.
2. In the tag <ec_link>, add the URL for the Enterprise Collaboration server URL. For example:
http://EC_SERVER.DOMAIN:8080/diamond
3. Restart the UCMDB Browser server.
4. After restart, you can use Enterprise Collaboration in the UCMDB Browser by clicking the EC
button.
For UCMDB server 9.04 CUP 6 and later versions:
1. In UCMDB, go to Administration > Infrastructure Settings and set the value of Enable
Enterprise Collaboration to true.
2. Set the value of the Enterprise Collaboration URL setting. For example:
http://EC_SERVER.DOMAIN:8080/diamond
3. Restart the UCMDB Browser server.
4. After restart, you can use Enterprise Collaboration in the UCMDB Browser by clicking the EC
button.

Configure the Enterprise Collaboration Adapter
(for the Conversations Widget)
To use the Conversations widget, you must create an integration point for the Enterprise
Collaboration adapter as follows:
1. In UCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:
n

Integration name: Enterprise Collaboration Integration

n

Adapter: EntepriseCollaborationAdapter

n

Hostname: Enterprise Collaboration hostname (use FQDN or IP address)

n

Customer ID: Enter the Customer ID

n

Credentails ID: Choose the connection Credentials as follows as follows:
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i. Click the Select Credential ID

button. The Choose Credentials dialog box opens.

ii. In the dialog box, under the Protocol column select Generic Protocol.
iii. If correct credentials are listed in the Credentials list, select them and click OK in the
Choose Credentials dialog box .
Note: You can determine whether credentials are correct by selecting them,
clicking OK in the Choose Credentials dialog box, then clicking the Test
connection button in the New Integration Point dialog box.
If correct credentials are not listed in the Credentials list:
i. Click the Create new connection details
Parameters dialog box opens.

button. The Generic Protocol

ii. In the dialog box, enter the following:
o

User label: any label name that you prefer

o

User Name: the user name used to log in to the EC server

o

Password: the password used to log in to the EC server

iii. Click OK in the Generic Protocol Parameters dialog box.
iv. Click OK in the Choose Credentials dialog box.
3. Select the following check boxes:
n

CollaborationObject

n

SearchResult

n

HitResult

n

Conversation

n

ParticipantInfo

n

Person

n

HighlightField

n

Fragment

4. Save the integration point.
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Note:
l

The EC adapter cannot connect to EC using SSL. The EC adapter should be configured to
connect to EC using the EC HTTP port and set Use SSL=false.

l

The Enterprise Collaboration adapter is deployed on the UCMDB server upon initial login to
the UCMDB Browser. This triggers deployment of content and makes it available for
configuration on the UCMDB server.

Configure the BSM Health Indicator (for the
Monitoring Widget)
To use the Monitoring widget, you perform the following configurations:
1. Synchronize the CMS and BSM:
a. In UCMDB, go to Data Flow Management > Integration Studio.
b. Create a new integration point with the following settings:
o

Integration name. BSM synchronization

o

Adapter. BSM

o

Hostname. BSM hostname

o

Port. BSM host port

o

Credentials. Choose ‘generic protocol’

o

Push Back IDs. Choose ‘enabled’

c. Save the integration point and invoke synchronization.
2. Create the BSM KPI Adapter Integration Point:
a. In UCMDB, go to Data Flow Management > Integration Studio.
b. Create a new integration point with the following settings
o

Integration name. BSM Kpi Adapter

o

Adapter. BSMKpiAdapter

o

Hostname. BSM hostname (use only FQDN)

o

Port. BSM host port
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o

Credentials. Choose ‘generic protocol’

o

Customer ID. Enter the Customer ID

c. Select the Kpi and KpiObjective check boxes and save the integration point.
Note: The BSM KPI Adapter is deployed on the UCMDB server upon initial login to the
UCMDB Browser. This triggers deployment of content and makes it available for
configuration on the UCMDB server.
3. Specify Data Over Time settings:
a. In BSM, go to Admin > Service Health.
b. On the CI Indicators tab, select a view that contains one or more CIs with KPIs.
c. Select one or more CIs in the upper pane (that have the KPIs you want to view in the
Monitoring widget).
d. In the CI Data pane at the bottom of the screen, select the Save KPI data over time for
the selected CIs check box.

Configure the Automation Flow Adapter (for the
Automation Widget)
Note: The Automation Widget is supported only on UCMDB 9.05 CUP 1 and later versions.
To use the Automation widget, you must create an Integration Point for the Automation Flow
Adapter as follows:
1. In UCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:
n

Integration name. Automation Flow Adapter (required)

n

Adapter. AutomationFlowAdapter (required)

n

Protocol. Https (required)

n

Hostname. Enter the OO server's hostname (required)

n

Port. Enter the OO host's port (required)

n

Application Context. /PAS/services/WSCentralService (optional)
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n

Use LW-SSO. True or False (required)

n

Credentials ID. Choose Generic Protocol with your credentials (required if Use LWSSO=False)
Note: If Use LW-SSO=True, the OO server and UCMDB server must both enable LWSSO. LW-SSO configuration on the UCMDB server is described in the section LWSSO Authentication Overview in the HP Universal CMDB Deployment Guide (for
UCMDB 9.05 and earlier versions) or in the HP Universal CMDB Hardening Guide (for
UCMDB 10.00 and later versions). LW-SSO configuration on OO is described in HP
Operations Orchestration Administrator Guide. A user who performs actions (run/view
automation flows) on OO must exist as an external user on the OO server with the
same user name that he has on the UCMDB Browser and with the correct permissions.
If Use LW-SSO=False, all users who performs actions on OO get the permissions of
an integration user, which are defined in the Credentials ID field.

3. Save the integration point.
Note: The Automation Flow Adapter is deployed on the UCMDB server upon initial login to the
UCMDB Browser. This triggers deployment of content and makes it available for configuration
on the UCMDB server.

Select and Define Automation Flows (for the
Automation Widget)
Note: The Automation Widget is supported only on UCMDB Server version 9.05 CUP 1 and
later versions.
1. In UCMDB, go to Modeling > Modeling Studio.
2. Select New, and from the drop-down menu choose Automation Flow Mapping.
The New Automation Flow Mapping dialog opens.
3. In the New Automation Flow Mapping dialog, choose Create new query or Choose base
query.
The Automation Flow Mapping Editor opens, with two tabs: Query Definition and
Automation Flows.
4. In the Query Definition tab, define the Automation Flow mapping by defining a query with at
least one node as the contact node.
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5. In the Automation Flows tab, add flows by clicking the Add Automation Flow link.
The Select Automation Flow window opens.
6. Enter text for a search in this window (you can search by name, description, domain, or
category) and click the Search button.
The search results appear.
7. Choose a flow from the list of search results.
The flow name now appears in the Automation Flows tab window with its input fields. If the
input field has a default value, it is set in the field.
8. Enter inputs in each field. Inputs can be added by typing free text in the field, by selecting an
attribute from a TQL node, or by entering a complex expression containing both free text and an
attribute from a TQL node. If default values exist, you can change them.
9. You can add more flows by repeating steps 5-8.
Note: Automation Flow Mapping supports one contact node only.

Configure Integration with Enterprise View
To enable the Enterprise View/UCMDB Integration, you must first install Enterprise View (EV) and
BusinessObjects. Once these are installed, you must perform the following procedures:
l

"Deploy a Universe for Integrating the UCMDB Browser into BusinessObjects" below

l

"Deploy a Report Designed for UCMDB Browser Integration into BusinessObjects" on page 134

Deploy a Universe for Integrating the UCMDB Browser
into BusinessObjects
1. Verify that an EnterpriseView Universe exists with the correct description.
a. Open the Central Management Console (go to Programs > Business Objects XI 3.1 >
Business Objects Enterprise > BusinessObjects Enterprise Central Management
Console, or in a web browser, go to the URL: http://<CMS host>:<CMS HTTP port>/
CmcApp).
b. Log in with the user name and password that you defined in BusinessObjects installation.
c. Go to Universes.
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d. Open the folder EnterpriseView Universe, and check that EnterpriseView Universe is
there and that version 0.52 appears in the Description field.
2. Back up Existing Universe
a. Right-click on the universe EnterpriseView Universe and go to Organize > Move To.
b. Choose the root folder Universes and click the right arrow to move the folder to the
Destinations column.
c. Click Move.
d. Exit the Central Management Console and create a new file system folder.
e. Copy the files export.properties and export.bat from the folder
ImportExportEVUniverse located in the UCMDB Browser content folder on HPLN into
the folder you created in the previous step.
f. In the file export.properties in the folder you just created, change the following parameters
to the correct username, password, host name, and port of the host where the
BusinessObjects application is installed:
o

userName=<BO_user_name>

o

password=<BO_password>

o

CMS=<host_name>:<port>

g. Run export.bat from the newly created folder where you copied export.properties.
Note: If you export from the original ImportExportEVUniverse, the universe you export
overwrites the original file that contains the EV Universe for the UCMDB Browser
integration.
3. Import the Universe for Integration with UCMDB Browser
a. Open the folder ImportExportEVUniverse and in the file import.properties, change the
following parameters to the correct username, password, host name, and port of the host
where the BusinessObjects application is installed:
o

userName=<BO_user_name>

o

password=<BO_password>

o

CMS=<host_name>:<port>

b. From the same folder (ImportExportEVUniverse), run import.bat.
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c. In the CMS console, ensure that EnterpriseView Universe is still situated under the root
folder Universes, and that the description field has changed to version 0.52 a.
d. Move the universe back to the folder EnterpriseView Universe (right-click the imported
universe, select Organize > Move To and select the EnterpriseView Universe folder).
4. Change the Database Connection for the Newly Imported Universe
a. On the machine where the BusinessObjects application is installed, go to Programs >
Business Objects XI 3.1 > Business Objects Enterprise > Designer.
b. Skip the Quick Design window.
c. Go to File > Import.
d. Select the folder EnterpriseView Universe and choose the universe EnterpriseView_
Universe.
e. Go to Tools > Connections.
f. Select EnterpriseView Connection and click Edit.
g. In the Edit dialog box, enter the details of the Oracle EnterpriseView user.
h. Click Next and enter the following for the Configuration Parameters:
o

Pool timeout = 10 minutes

o

Array fetch size = 1

o

Array Bind size = 5

o

Login timeout = 600 minutes

i. Click Save.
j. Go to File > Export, select the EnterpriseView Universe folder, and click OK.

Deploy a Report Designed for UCMDB Browser
Integration into BusinessObjects
1. On the machine where the BusinessObjects application is installed, go to Programs >
Business Objects XI 3.1 > Business Objects Enterprise > Web Intelligence Rich Client.
2. Select File > Open, and open the file UCMDB_Browser_Integration.wid, located in the
UCMDB Browser content folder on HPLN.
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3. Select File > Export to CMS, and in the folders list, select EnterpriseView Reports.
4. Click OK.

Configure the Enterprise View Adapter
1. In UCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:
n

Integration name: EnterpriseViewDataSource (required)

n

Adapter: EnterpriseViewAdapter (required)

n

Hostname: enter the Business Object’s server hostname (required)

n

Port: enter the Business Object’s host port (required). The default port is 6400.

n

Credentials ID: Choose Generic Protocol with your credentials

3. In the Data Flow Probe drop-down list, select a probe.
4. Save the integration point.
Note: The EnterpriseViewAdapter adapter is deployed on the UCMDB server upon initial login
to the UCMDB Browser. This triggers deployment of content and makes it available for
configuration on the UCMDB server.
For instructions on integrating Enterprise View with UCMDB, see "Configure Integration with
Enterprise View" on page 132

Integrate with ALM (for the Defects Widget)
The following configuration procedures need to be performed to use the Defects widget in the
UCMDB Browser:
l

"Set Up the Defects Adapter" below

l

"Create New Attribute and Severity Mapping Properties Files (optional)" on the next page

l

"Create the DefectsFilter CI and Relate it to the Business Element" on page 138

l

"Enable the Defects Widget in UCMDB" on page 138

Set Up the Defects Adapter
1. In UCMDB, go to Data Flow Management > Integration Studio.
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2. Create a new integration point with the following settings:
n

Integration Name. Defects Adapter

n

Adapter. ALMAdapter

n

Protocol. must be http or https

n

HostnameIP. the name or IP address of the machine where ALM is installed

n

Port. the port number of the ALM server

n

Domain. the domain that is defined in ALM

n

Credentials ID. click the browse button and from the list that appears choose credentials
for connecting to ALM, or create new credentials

3. Optional: Click Test Connection to ensure that a connection can be established with the
ALM server.
4. Click OK.
5. Under the Supported and Selected CI Types panel, check the Defect CI type.
6. Click the Save Integration Point button.

Create New Attribute and Severity Mapping Properties Files (optional)
There are two out-of-the-box mapping properties files, one for attributes and one for severities. The
attributes mapping properties files map between names of defect fields in ALM to names of
attributes of the class type Defect in UCMDB. The severities mapping properties file maps
between severity levels in ALM to the five severity levels in UCMDB, as defined in the
DefectSeverity typedef in UCMDB. These files can be accessed by means of the Defects
Adapter, by going to Data Flow Management > Adapter Management > ALMAdapter >
Configuration Files. The files are called sample.attribute.mappings.properties and
sample.severity.mappings.properties.
You may want to create your own customized attributes or severity mapping properties files. This
could be necessary if the names of the fields in the out-of-the-box mapping properties files do not
match the names in your ALM system, or could be useful if you want to add additional fields that do
not exist in the out-of-the-box mapping properties files.
To create a new attribute or severity mapping properties file:
1. If you are creating an attribute mapping properties file:
a. To retrieve the ALM defect attribute field names that you need to create the mapping, go to
the following URL:
http://<ALM server>:8080/qcbin/rest/domains/<domain>
/projects/<project>/customization/entities/defect/fields?login-form-required=y

HP Universal CMDB Browser (3.1)

Page 136 of 147

Installation and Configuration Guide
Chapter 4: Integrate with Other Applications

b. In the ALM login page, enter your user credentials.
c. In the XML file that appears there is a list of the defect’s fields. Note the Name element in
each field, you are going to map the value that appears for the Name element here to the
names of attributes of the class type Defect in UCMDB.
2. In UCMDB, go to Data Flow Management > Adapter Management.
3. Click the New button and from the pop-up menu select New Configuration File.
4. Enter a name that starts with ALMAdapter/…, for example:
ALMAdapter/attribute.mappings.properties.
Note: The custom attribute mappings file should be named
attribute.mappings.properties, and the custom severity mappings file should be named
severity.mappings.properties. If project-specific mappings files are required, they
should be named <project-name>.attribute.mappings.properties and <projectname>.severity.mappings.properties for attributes or severities, accordingly.
5. Click the Browse button by the Package field, choose ALMAdapter from the list that appears,
and click OK.
6. In the text editor, for attributes mapping each row should contain the name of the ALM field
(attribute) on the left side and name of the equivalent CI attribute on the right side in the
following manner:
<ALM field name>=<CI attribute>
For severities mapping, each row should contain the ALM severity on the left side and the
equivalent UCMDB severity (as defined in the DefectSeverity typedef in UCMDB) on the right
side, in the following manner:
<ALM severity>=<UCMDB severity>
7. Click OK when you are finished editing the new mapping properties file.
Note:
l

The name of the CI attribute must exist in the class type Defect.

l

For the severities file, if a severity in ALM has a space, a back slash must precede the
space as follows: Very\ High.

l

In the UCMDB Browser, there are only 5 severity levels (Low, Medium, High, Very High,
and Urgent), so all ALM severities must map to one of these 5 levels.

l

The type of all custom UCMDB attributes must be String.
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Create the DefectsFilter CI and Relate it to the Business Element
The Defects Filter CI that is related to a specific business element represents the ALM filter that is
used to retrieve the relevant defects for that business element.
Note: You can relate more than one DefectsFilter CI to a business element.
To create the DefectsFilter CI and relate it to the business element:
1. Create a filter in ALM (if one has not already been created).
2. Copy the filter's text.
3. In UCMDB, go to Modeling > IT Universe Manager.
4. In the Browse Views tab, click the New CI button.
5. From the CI type tree, select the DefectsFilter CI type.
6. Paste the filter text from the ALM filter into the FilterText attribute value.
Note: Currently there is a limitation of maximum 885 characters in the FilterText attribute
value.
7. In ProjectGroup attribute, enter the ALM project name.
8. Optional: Give the filter a custom name by setting the Name attribute value.
9. Click Save.
10. Relate the DefectsFilter CI to the business element using a containment relationship from the
Defects filter to the business element.

Enable the Defects Widget in UCMDB
Before connecting to the Browser, enable the Defects widget as follows:
1. Go to Administration > Infrastructure Settings Manager > UCMDB Browser settings.
2. Set the value of Enable the Defects Widget to True.

Configure Integration with Service Manager
1. In UCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:
n

Adapter: select the appropriate adapter for the version of Service Manager that you have
installed.
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n

Hostname/IP: enter the hostname or IP address of theService Manager server.

n

Credentials ID: select the credentials for the Service Manager server.

n

Data Flow Probe: select a data flow probe.

3. Select the Is Integration Activated check box.
4. Save the integration point.
5. Click the Federation tab of the integration point and verify that the relevant Service Manager
items are selected.
6. Create a data push job:
n

For integration points that use adapters earlier than the ServiceManagerAdapter9.x adapter,
create a data push job that includes the CI types and relation types that you need, and run
the job. For details, see the HP Universal CMDB Data Flow Management Guide.

n

For integration points that use the ServiceManagerAdapter9.x adapter, synchronize data
using the out-of-the-box data push job.

Configure a Direct Link to Service Manager for a
Selected Problem, Incident, or Change Request
For UCMDB 9.04 CUP 6 and later versions:
To configure a direct link to Service Manager in UCMDB for the selected Problem, Incident, or
Change Request:
1. In UCMDB, go to Administration > Infrastructure Settings Manager > UCMDB Browser
settings.
2. In the Name column, choose Service Manager application URL for problem CIs.
3. In the Value column, enter the Service Manager URL. Ensure that you enter the correct
Service Manager IP address or hostname and the correct port number. The URL must contain
the element {$PROBLEM_ID} for a Problem, {$INCIDENT_ID} for an incident, or {$RFC_ID}
for a change request. This element is replaced with the actual ID at runtime.
For example:
http://10.0.0.1:8080/webtier9.30/index.do?ctx=docEngine&amp;file=rootcause&amp;query=id%3D%22{$PROBLEM_
ID}%22
4. Click Save

.
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For UCMDB 9.04 CUP 5 and earlier versions:
To configure a direct link to Service Manager in the UCMDB Browser configuration file for the
selected Problem, Incident, or Change Request:
l

For a Problem: In the UCMDB Browser configuration file, enter the Service Manager URL in
the tag <problem_direct_link_url>. Ensure that you enter the correct Service Manager IP
address or hostname and the correct port number. The URL must contain the element
{$PROBLEM_ID}. This element is replaced with the actual Problem ID at runtime.
For example:
http://10.0.0.1:8080/webtier9.30/index.do?ctx=docEngine&amp;file=rootcause&amp;query=id%3D%22{$PROBLEM_
ID}%22

l

For an Incident: In the UCMDB Browser configuration file, enter the Service Manager URL in
the tag <incident_direct_link_url>. Ensure that you enter the correct Service Manager IP
address or hostname and the correct port number. The URL must contain the element
{$INCIDENT_ID}. This element is replaced with the actual Incident ID at runtime.
For example:
http://10.0.0.1:8080/webtier9.30/index.do?ctx=docEngine&amp;file=probsummary&amp;query=number%3D%22
{$INCIDENT_ID}%22

l

For a Change Request: In the UCMDB Browser configuration file, enter the Service Manager
URL in the tag <sm_url>. Ensure that you enter the correct Service Manager IP address or
hostname and the correct port number. The URL must contain the element {$RFC_ID}. This
element is replaced with the actual change request ID at runtime.
For example:
http://10.0.0.1:8080/webtier9.30/index.do?ctx=docEngine&amp;file=cm3r&amp;query=number%3D%22{$RFC_ID}%22

Direct Links
For some of the widgets displayed in the UCMDB Browser, once you select a CI and its data is
displayed in the Browser, it is possible to view additional data in the context of the selected CI and
) appears on the far right side of the widgets that provides,
the displayed widget. A link icon (
among other things, a direct link to an external application (for the Conversations Widget, the EC
icon appears). When you click this icon and select Open Link, you can launch an external
application in the context of the selected CI, as follows:
l

Properties Widget. When you click the link icon in the Properties widget and select Open
Link, the UCMDB server for the machine you selected in your initial search opens (you must log
in first), and displays all the CI properties for the CI you selected in the Browser.
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l

Environment Widget. When you click the link icon in the Environment widget and select Open
Link, the UCMDB server for the machine you selected in your initial search opens (you must log
in first), and displays a diagram of all CIs related to the CI you selected in the Browser.

l

Impact Simulation Widget. When you click the link icon in the Impact Simulation widget and
select Open Link, the UCMDB server for the machine you selected in your initial search opens
(you must log in first), and displays the impact analysis for the CI you selected in the Browser.

l

Policy Widget. When you click the link icon in the Policy widget and select Open Link, the
Configuration Manager installation for the machine you selected in your initial search opens (you
must log in first), and displays a view containing the defined policies for the CI you selected in
the Browser (if a view that is managed by Configuration Manager exists that contains that CI). If
the selected CI is present in more than one view, Configuration Manager displays a dialog box
where the user can select which view to open.

l

Change Request Widget. In the Change Request widget, the link icon appears only in the
widget details, and each Change Request listed has its own link icon. When you click the link
icon for a Change Request and select Open Link, Service Manager opens (you must log in
first), and displays a form containing more details on that Change Request.

l

Incidents Widget. In the Incidents widget, the link icon appears only in the widget details, and
each Incident listed has its own link icon. When you click the link icon for an Incident and
selecting Open Link, Service Manager opens (you must log in first), and displays the incident
details.
Note: The link icon appears only if the Incidents Widget is configured for a direct link that
contains the tag: {$INCIDENT_ID} in the direct link URL.

l

Conversations Widget: In the Conversations widget, the EC icon appears only in the widget
details, and each conversation listed has its own EC icon. When you click the icon for a
conversation and select Open Link, EC opens (you must log in first), and displays the
conversation details.
Note: The EC icon is active for conversations only if integration with EC has been
configured, as described in "Configure Integration with Enterprise Collaboration" on page
126.

When you click

, there is also an option to send a link to the CI in an email.

Configure Integration with SiteMinder
Note: Integration with SiteMinder can be performed only when the UCMDB Browser is
configured to one UCMDB Server, since there is no option to select a server from the server
list on login.

HP Universal CMDB Browser (3.1)

Page 141 of 147

Installation and Configuration Guide
Chapter 4: Integrate with Other Applications

1. Configure the UCMDB Browser to enable LW-SSO:
a. Follow the instructions in "Configure LW-SSO" on page 20.
b. Add following code to the UCMDB Browser ucmdb_browser_lwsso_config.xml
configuration file, just after the tag </in-ui-lwsso> and before the tag </validation>:
<in-ui-identity-management>
<identity-management>
<userNameHeaderName>sm_user</userNameHeaderName>
<cookieName>SMSESSION</cookieName>
</identity-management>
</in-ui-identity-management>

2. Configure Reverse Proxy server and CA SiteMinder Client Agent
Note: It is strongly recommended to install and configure the Reverse Proxy web server
before installing the CA SiteMinder Client Agent. For more details, see to the SiteMinder
documentation.
Configure reverse proxy either for the Apache web server or Microsoft IIS, according to the
following instructions:
n

Configure Apache Web Server as Reverse Proxy
i. Prerequisites:
o

Ensure that CA SiteMinder is installed on your user environment.

o

Ensure that the Apache Web Server is installed on the same machine as the CA
SiteMinder Client Agent.

ii. Set up Apache Web Server to enable reverse proxy and AJP connection with
the CA SiteMinder Client Agent.
Add the following lines to the Apache Web Server httpd.conf configuration file:
LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_ajp_module modules/mod_proxy_ajp.so
ProxyPass /ucmdb-browser/ ajp://ucmdb-browser-server:8009/ucmdb-br
owser/
ProxyPassReverse /ucmdb-browser/ ajp://ucmdb-browser-server:8009/u
cmdb-browser/
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where ucmdb-browser-server is the name of your UCMDB Browser server. For more
details, see the Apache Web Server documentation at:
http://httpd.apache.org/docs/2.2/mod/mod_proxy_ajp.html.
iii. Enable AJP connections on the Apache Tomcat server where the UCMDB
Browser runs.
Ensure that the following line exists and is uncommented in the Apache Tomcat
server.xml configuration file:
<Connector port="8009" protocol="AJP/1.3" redirectPort="8088" />
For more details, see the Apache Tomcat documentation at:
http://tomcat.apache.org/tomcat-7.0-doc/config/ajp.html.
n

Configure Microsoft IIS as Reverse Proxy
i. Prerequisites:
o

Ensure that CA SiteMinder is installed on your user environment.

o

Ensure that the Microsoft IIS Web Server is installed on the same machine as the
CA SiteMinder Client Agent.

ii. Copy ISAPI files
i. Copy all the files from the UCMDB server folder: <UCMDB_INSTALL_
DIR>\tools\iis_integration to the c:\ucmdb_iis folder on the IIS machine.
ii. On the IIS machine, in the workers.properties.minimal file, change the string
worker.localAjp.host=localhost to the UCMDB Browser server hostname.
iii. On the IIS machine, in the isapi_redirect.properties file, perform the following:
o

The log_file should point to a folder containing the integration logs. For
example, c:\ucmdb_iis\isapi.log.

o

The worker_file should contain the location of the
workers.properties.minimal file. For example, c:\ucmdb_
iis\workers.properties.minimal.

o

The worker_mount_file should contain the location of the
uriworkermap.properties file. For example c:\ucmdb_
iis\uriworkermap.properties.

o

Add the following lines to the uriworkermap.properties file:
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/ucmdb-browser=localAjp
/ucmdb-browser/*=localAjp

iii. Create and configure new ISAPI Filter
i. Open the IIS management console by executing inetmgr from the command line
and add a new virtual directory to your IIS web site. The alias of the virtual
directory must be jakarta. Its physical path should be c:\ucmdb_iis.
ii. Assign Execute access to the new virtual directory.
iii. Open the Default Web Site Properties dialog box and add isapi_redirect.dll from
the folder c:\ucmdb_iis as an ISAPI filter to your IIS web site.
iv. Open Web Service Extensions, select All Unknown ISAPI Elements from the
list, and click Allow.
v. Restart IIS and ensure that the new filter is marked with a green up arrow.
For more details, see the Microsoft IIS documentation at:
o

http://technet.microsoft.com/en-us/library/cc733109 (for IIS 7)

o

http://technet.microsoft.com/en-us/library/cc772487 (for IIS 6)

3. Configure SiteMinder LogoffUri
The UCMDB Browser logout page (logout.jsp) must be defined on CA SiteMinder to ensure
correct logout from the Browser. If you do not do this, you will need to open a new Browser
window to re-enter the UCMDB Browser application.
4. Verify successful integration of the UCMDB Browser with SiteMinder
Access the reverse proxy frontend URL. If all settings are correct, you are prompted to input
your user name and password in the CA SiteMinder authentication dialog. After successful
authentication, you are forwarded to the UCMDB Browser application without having to enter
your UCMDB user name and password.

Configure Integration with Configuration Manager
1. In UCMDB, go to Data Flow Management > Integration Studio.
2. Create a new integration point with the following settings:
n

Adapter: select the CM New Policy Adapter.

n

Configuration Manager Application URL: enter the hostname or IP address of the
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Configuration Manager server.
n

Credentials ID: select the credentials for the Configuration Manager server.

n

Data Flow Probe: select a data flow probe.

3. Select the Is Integration Activated check box.
4. Save the integration point.
5. Click the Federation tab of the integration point and verify that the Policy and PolicyResult
check boxes are selected.
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Problem: Performance for the UCMDB Browser is slow.
l

Possible Solution: Add the variable CATALINA_OPTS to the windows environment variables
with values:
-XX:PermSize=128M -XX:MaxPermSize=512M -Xms512M -Xmx4096M

Problem: The UCMDB Browser fails to open or gets stuck on loading when
trying to open it in Internet Explorer 8.
l

Possible Solution 1: If your IE8 is 64 bit, uninstall Google Chrome Frame from the client’s
machine (disabling is not enough), then clear Internet Explorer’s cache.

l

Possible Solution 2: If you are not using IE8 with the Chrome Frame plug-in, ensure that
compatibility mode is disabled as explained in "Disable Compatibility View for Internet
Explorer 8" on page 35.

Problem: Graphical mode in the UCMDB Browser embedded in
Configuration Manager may not function correctly.
The first time you open the UCMDB Browser module that is embedded in Configuration Manager,
the graphical mode in the Environment widget may not function.
l

Solution: First access the UCMDB Browser from within UCMDB, or open a standalone version
of the UCMDB Browser. This deploys a missing resource on your computer, and from then on
the graphical mode in the Environment widget will function correctly in the UCMDB Browser
module that is embedded in Configuration Manager.

Problem: The Tomcat log that contains requests to the UCMDB Browser
and their HTTPS codes becomes too large and is unreadable.
l

Solution: Comment out the following lines in the server.xml file, located in <UCMDB_
Browser_installation_directory>\webapps\release\conf:
<Valve className="org.apache.catalina.valves.AccessLogValve" directory="logs"
prefix="localhost_access_log." suffix=".txt"
pattern="%h %l %u %t &quot;%r&quot; %s %b" />
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:
Feedback on Installation and Configuration Guide (Universal CMDB Browser 3.1)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client,
and send your feedback to SW-Doc@hp.com.
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